OpenModelica User’s Guide
Release v1.14.1-2-g392c27e260

Open Source Modelica Consortium

Jan 13, 2020






1 Introduction

1.1 SystemOverview . . . . . . . .. ...
1.2 Interactive Session with Examples . . . . . . ... ... ... .. ...

1.3 Summary of Commands for the Interactive Session Handler

1.4 Running the compiler from command line . . . . . ... ... .....

2 OMEdit - OpenModelica Connection Editor

2.1  StartingOMEdit . . . . . ... ... ..
2.2 MainWindow & Browsers . . . . ... ... ... .. .. ... ...,
2.3 Perspectives . . . . . it e e e e e e e e e e e e e
24 FileMenu. . . ... ... .. .. e
25 EditMenu . .. ... ...
26 ViewMenu . . . . ...
2.7 SimulationMenu . . . . .. ... e
2.8 Debugger Menu . . . .. ... ... e
2.9 OMSimulatorMenu . . ... .. ... ... ... ... ... .....
210 ToolsMenu . . . . . . . . . . e e e
211 HelpMenu . . . .. ... e
2.12 ModelingaModel . . ... ... ... ... o
2.13 SimulatingaModel . ... ... ... ... . s
2.14 Plotting the Simulation Results . . . . .. .. ... ... ... ....
2.15 Re-simulatingaModel . . . . . . ... ... o000
2.16 3D Visualization . . . . .. . .. . . .. ...
2.17 Animation of Realtime FMUs . . . . . .. ... ... .. .......
2.18 [Interactive Simulation . . . . . . ... ... ... .. .. .. ..., .
2.19 How to Create User Defined Shapes —Icons . . . . . . ... ... ...
2.20 Global head section in documentation . . . . . . ... .. .. .....
221 OpHONS . . v v v v e e e e e e e e e e
2.22 __OpenModelica_commandLineOptions Annotation . . . . . ... ..
2.23 __OpenModelica_simulationFlags Annotation . . . .. ... ... ..
224 Debugger . . . . . .o e e e e e e e e e e
2.25 Editing Modelica Standard Library . . . . . .. ... ... .. ....
226 StateMachines . . . . . . . . . . ...
2.27 Using OMEditas Text Editor . . . . . ... ... ... ... .....

3 2D Plotting

3.1 Example . . . ...
3.2 Plot Command Interface . . . . .. ... ... . ... ... . .. ...

4 Solving Modelica Models

4.1 Integration Methods . . . . . .. .. ... ... . L.
4.2 DAE Mode Simulation . . . . . ... ... oL oo

5 Debugging

5.1  The Equation-based Debugger . . . . . ... .. ... .. .......

CONTENTS




10

11

12

13

14

15

16

17

18

5.2 The Algorithmic Debugger . . . . . . . . . . . L 75

Generating Graph Representations for Models 81
FMI and TLM-Based Simulation and Co-simulation of External Models 83
7.1  Functional Mock-up Interface -FMI . . . . . . . ... .. ... ... L . &3
7.2 Transmission Line Modeling (TLM) Based Co-Simulation . . . . . .. ... ... ... ..... 85
7.3  Composite Model Editing of External Models . . . . . . .. ... ... ... ... ..... 85
OMSimulator 101
OpenModelica Encryption 103
9.1 Encryptingthe Library . . . . . . . . . . . . e 103
9.2 Loading an Encrypted Library . . . . . . . . .. ... oL 103
0.3 NOLES . . o v v e e e 103
OMNotebook with DrModelica and DrControl 105
10.1 Interactive Notebooks with Literate Programming . . . . . . .. ... ... .. ... .. .... 105
10.2 DrModelica Tutoring System — an Application of OMNotebook . . . . . .. ... ... .. ... 106
10.3 DrControl Tutorial for Teaching Control Theory . . . . . . . . .. ... ... ... .. ... 112
10.4 OpenModelica Notebook Commands . . . . . . . . . . . o . v vttt et e 119
10.5 References . . . . . . . . o L e 127
Optimization with OpenModelica 129
11.1 Builtin Dynamic Optimization with OpenModelicaand IpOpt . . . . . . .. .. ... ... ... 129
11.2 Compiling the Modelicacode . . . . .. .. .. ... ... 129
11.3 AnExample . . . . . . . e 129
11.4 Different Options for the Optimizer IPOPT . . . . . . . ... ... ... ... .. ....... 132
11.5 Dynamic Optimization with OpenModelicaand CasADi . . . . . . ... ... ... ... .... 132
11.6 Parameter Sweep Optimization using OMOptim . . . . . . . . . . . ... vt 137
Parameter Sensitivities with OpenModelica 145
12.1 Background . . . . . . . .. e e e e 145
122 AnExample . . . . . . L e e e 145
PDEModelical 153
13.1 PDEModelical language elements . . . . . . . . . . . o v i it it e e e 153
13.2 Limitations . . . . . . . L o e e e e e e e e e e e e e e e 154
133 Viewingresults . . . . . . . . ... e 154
MDT - The OpenModelica Development Tooling Eclipse Plugin 155
14.1 Introduction . . . . . . . . . e e e e e 155
142 Installation . . . . . . . . 0 L e e e e e e e e e e 155
143 Getting Started . . . . . . . e e 156
MDT Debugger for Algorithmic Modelica 169
15.1 The Eclipse-based Debugger for Algorithmic Modelica. . . . . . ... .. ... ... ...... 169
Modelica Performance Analyzer 175
16.1 Profiling information for ProfilingTest . . . . . . . . . . .. . ... ... oo 176
16.2 Genenerated JSON forthe Example . . . . . . . . . ... . . . oo 178
16.3 Using the Profiler from OMEdit . . . . . .. ... ... . . . . . . 179
Simulation in Web Browser 181
Interoperability — C and Python 183
18.1 Calling External C functions . . . . . . . . . . . . 0 0 v it e e e e 183
18.2 Calling external Python Code from a Modelicamodel . . . . . ... ... ... ......... 185

18.3 Calling OpenModelica from PythonCode . . . . . . . . . . . ... ... ... ... ....... 186




19

20

21

OpenModelica Python Interface and PySimulator
19.1 OMPython — OpenModelica Python Interface
19.2  Enhanced OMPython Features . . . . . . . .
19.3 PySimulator

OMMatlab — OpenModelica Matlab Interface
20.1 Features of OMMatlab
20.2 Test Commands
20.3 WorkDirectory

20.4 BuildModel
20.5
20.6
20.7
20.8 Usage of setMethods
20.9 Advanced Simulation
20.10 Linearization
20.11 Usage of Linearization methods

OM Julia — OpenModelica Julia Scripting
21.1 Features of OMJulia
21.2 Test Commands
21.3 WorkDirectory

21.4 BuildModel
21.5 Standard get methods
21.6 Usage of getMethods
21.7 Standard set methods
21.8 Usageof setMethods . . . . . ... ... ..
21.9 Advanced Simulation
21.10 Linearization
21.11 Usage of Linearization methods
21.12 Sensitivity Analysis
21.13 Usage

22 Jupyter-OpenModelica

23

24

25

26

27

28

Scripting API

23.1 OpenModelica Scripting Commands
23.2 Simulation Parameter Sweep
233 Examples . . . ... ... ... L.

OpenModelica Compiler Flags
24.1 Options
242 Debugflags . . . ... ... ... ......
24.3 Flags for Optimization Modules

Small Overview of Simulation Flags
25.1 OpenModelica (C-runtime) Simulation Flags

Technical Details
26.1 The MATv4 Result File Format

DataReconciliation
27.1

27.3 DataReconciliation Support in OMEdit
27.4 DataReconcilation Results

Frequently Asked Questions (FAQ)
28.1 OpenModelica General
28.2 OMNotebook

Defining DataReconciliation Problem in OpenModelica
27.2 DataReconcilation Support with Scripting Interface

189
189
192
196

197
197
197
198
199
199
199
201
201
202
202
202

205
205
205
206
207
207
207
208
209
209
209
210
210
210

211

213
213
282
282

287
287
302
308

309
309

317
317

319
319
320
321
323

327
327
327




28.3 OMDeyv - OpenModelica Development Environment . . . . . . .. ... ... ... .......

29 Major OpenModelica Releases
29.1 Release Notes for OpenModelica2.0.0 . . . . . . . . . ... e
29.2 Release Notes for OpenModelica 1.16.0 . . . . . . . . . ... .
29.3 Release Notes for OpenModelica 1.15.0 . . . . . . . . . . . .. i
29.4 Release Notes for OpenModelica 1.14.0 . . . . . . . . ... . o o o
29.5 Release Notes for OpenModelica 1.13.0 . . . . . . . . ... .. . .
29.6 Release Notes for OpenModelica 1.12.0 . . . . . . . . . . ... o o it
29.7 Release Notes for OpenModelica 1.11.0 . . . . . . . . . ... o o o
29.8 Release Notes for OpenModelica 1.10.0 . . . . . . . . . .. . . i i
29.9 Release Notes for OpenModelica 1.9.4 . . . . . . .. . .. e
29.10 Release Notes for OpenModelica 1.9.3 . . . . . . . . ... . . oo
29.11 Release Notes for OpenModelica 1.9.2 . . . . . . . .. ... o o
29.12 Release Notes for OpenModelica 1.9.1 . . . . . . .. ... . e
29.13 Release Notes for OpenModelica 1.9.0 . . . . . . . . . . . . . it
29.14 Release Notes for OpenModelica 1.8.1 . . . . . . . . . . .. . . i
29.15 OpenModelica 1.8.0, November 2011 . . . . . . . . . .. .. .
29.16 OpenModelica 1.7.0, April 2011 . . . . . . . .. ... e
29.17 OpenModelica 1.6.0, November 2010 . . . . . . . . . . . .. o e
29.18 OpenModelica 1.5.0, July 2010 . . . . . . . . . o o o e
29.19 OpenModelica 1.4.5, January 2009 . . . . . . . . . . . o e e e
29.20 OpenModelica 1.4.4, Feb 2008 . . . . . . . . . . o 0 e e e e e
29.21 OpenModelica 1.4.3,June 2007 . . . . . . . . . . o i i e e e e e
29.22 OpenModelica 1.4.2, October 2006 . . . . . . . . . . . i it
29.23 OpenModelica 1.4.1,June 2006 . . . . . . . . . . . e e
29.24 OpenModelica 1.4.0, May 2006 . . . . . . . . . . i i i e e e e e e e
29.25 OpenModelica 1.3.1, November 2005 . . . . . . . . . . o 0 o i i it e e e e

30 Contributors to OpenModelica
30.1 OpenModelica Contributors 2015 . . . . . . . . . . 0 . o e e e e
30.2 OpenModelica Contributors 2014 . . . . . . . . . . . e e e e
30.3 OpenModelica Contributors 2013 . . . . . . . . . .. . e e
30.4 OpenModelica Contributors 2012 . . . . . . . . . . . . . e
30.5 OpenModelica Contributors 2011 . . . . . . . . . . ..o e
30.6 OpenModelica Contributors 2010 . . . . . . . . . . 0 . o e e e e
30.7 OpenModelica Contributors 2009 . . . . . . . . . . . . o e e e e e
30.8 OpenModelica Contributors 2008 . . . . . . . . . . . ... e
30.9 OpenModelica Contributors 2007 . . . . . . .. .. ... e
30.10 OpenModelica Contributors 2006 . . . . . . . . . . . . L e
30.11 OpenModelica Contributors 2005 . . . . . . . . . . . . . o e
30.12 OpenModelica Contributors 2004 . . . . . . . . . . 0 o e e e e e
30.13 OpenModelica Contributors 2003 . . . . . . . . .. . .. . e
30.14 OpenModelica Contributors 2002 . . . . . . . . . o . o i i e e e e e
30.15 OpenModelica Contributors 2001 . . . . . . . . . .. . e
30.16 OpenModelica Contributors 2000 . . . . . . . . . . . . . o e
30.17 OpenModelica Contributors 1999 . . . . . . . . . . . . . e
30.18 OpenModelica Contributors 1998 . . . . . . . . . . . . . e

Bibliography

329
329
329
329
330
331
332
333
335
336
337
338
339
341
344
345
346
347
348
349
349
350
351
351
352
353

355
355
357
358
360
362
363
365
366
367
368
368
369
369
369
370
370
370
370

371




OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

Generated on 2020-01-13 at 13:38
Open Source Modelica Consortium

Copyright © 1998-CurrentYear, Open Source Modelica Consortium (OSMC), c/o Linkdpings universitet, Depart-
ment of Computer and Information Science, SE-58183 Link&ping, Sweden

All rights reserved.

THIS PROGRAM IS PROVIDED UNDER THE TERMS OF GPL VERSION 3 LICENSE OR THIS OSMC
PUBLIC LICENSE (OSMC-PL). ANY USE, REPRODUCTION OR DISTRIBUTION OF THIS PROGRAM
CONSTITUTES RECIPIENT’S ACCEPTANCE OF THE OSMC PUBLIC LICENSE OR THE GPL VERSION
3, ACCORDING TO RECIPIENTS CHOICE.

The OpenModelica software and the OSMC (Open Source Modelica Consortium) Public License (OSMC-PL)
are obtained from OSMC, either from the above address, from the URLs: https://www.openmodelica.org or http:
/lwww.ida.liu.se/projects/OpenModelica, and in the OpenModelica distribution. GNU version 3 is obtained from:
http://www.gnu.org/copyleft/gpl.html.

This program is distributed WITHOUT ANY WARRANTY; without even the implied warranty of MER-
CHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE, EXCEPT AS EXPRESSLY SET FORTH
IN THE BY RECIPIENT SELECTED SUBSIDIARY LICENSE CONDITIONS OF OSMC-PL.

See the full OSMC Public License conditions for more details.

This document is part of OpenModelica: https://www.openmodelica.org
Contact: OpenModelica@ida.liu.se

Modelica® is a registered trademark of the Modelica Association, https://www.Modelica.org
Mathematica® is a registered trademark of Wolfram Research Inc, http://www.wolfram.com

This users guide provides documentation and examples on how to use the OpenModelica system, both for the
Modelica beginners and advanced users.

CONTENTS 1


https://www.openmodelica.org
http://www.ida.liu.se/projects/OpenModelica
http://www.ida.liu.se/projects/OpenModelica
http://www.gnu.org/copyleft/gpl.html
https://www.openmodelica.org
mailto:OpenModelica@ida.liu.se
https://www.Modelica.org
http://www.wolfram.com

OpenModelica User’s Guide, Release v1.14.1-2-9g392¢27e260

2 CONTENTS



CHAPTER
ONE

INTRODUCTION

The 0penM°de"cq system described in this document has both short-term and long-term goals:

The short-term goal is to develop an efficient interactive computational environment for the Modelica lan-
guage, as well as a rather complete implementation of the language. It turns out that with support of
appropriate tools and libraries, Modelica is very well suited as a computational language for development
and execution of both low level and high level numerical algorithms, e.g. for control system design, solving
nonlinear equation systems, or to develop optimization algorithms that are applied to complex applications.

The long-term goal is to have a complete reference implementation of the Modelica language, including
simulation of equation based models and additional facilities in the programming environment, as well
as convenient facilities for research and experimentation in language design or other research activities.
However, our goal is not to reach the level of performance and quality provided by current commercial
Modelica environments that can handle large models requiring advanced analysis and optimization by the
Modelica compiler.

The long-term research related goals and issues of the OpenModelica open source implementation of a Modelica
environment include but are not limited to the following:

Development of a complete formal specification of Modelica, including both static and dynamic semantics.
Such a specification can be used to assist current and future Modelica implementers by providing a semantic
reference, as a kind of reference implementation.

Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural
analysis, system identification, etc., as well as modeling problems that require extensions such as partial
differential equations, enlarged scope for discrete modeling and simulation, etc.

Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse,
configurability, architectural properties, etc.

Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by gen-
erating code for parallel hardware.

Improved debugging support for equation based languages such as Modelica, to make them even easier to
use.

Easy-to-use specialized high-level (graphical) user interfaces for certain application domains.
Visualization and animation techniques for interpretation and presentation of results.

Application usage and model library development by researchers in various application areas.

The OpenModelica environment provides a test bench for language design ideas that, if successful, can be submit-
ted to the Modelica Association for consideration regarding possible inclusion in the official Modelica standard.

The current version of the OpenModelica environment allows most of the expression, algorithm, and function
parts of Modelica to be executed interactively, as well as equation models and Modelica functions to be compiled
into efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and
a numerical DAE solver.



https://openmodelica.org

OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

1.1 System Overview

The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1.1.

MDT Eclipse Plugir

Editor/Browser

GraphicalModel
Editor/Browser

3
OMODfi Interactive t
ptim sessionhandler
Optimization —— Mo-gee)l(téglitor
Subsystem
OMNotebook _
DrModelica Execution Model_lca
Model Editor Compiler
Modelica
Debugger

Figure 1.1: The architecture of the OpenModelica environment. Arrows denote data and control flow. The inter-
active session handler receives commands and shows results from evaluating commands and expressions that are
translated and executed. Several subsystems provide different forms of browsing and textual editing of Modelica
code. The debugger currently provides debugging of an extended algorithmic subset of Modelica.

The following subsystems are currently integrated in the OpenModelica environment:

* An interactive session handler, that parses and interprets commands and Modelica expressions for evalua-
tion, simulation, plotting, etc. The session handler also contains simple history facilities, and completion of
file names and certain identifiers in commands.

A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing definitions
of classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from
libraries. The compiler also includes a Modelica interpreter for interactive usage and constant expression
evaluation. The subsystem also includes facilities for building simulation executables linked with selected
numerical ODE or DAE solvers.

An execution and run-time module. This module currently executes compiled binary code from translated
expressions and functions, as well as simulation code from equation based models, linked with numerical
solvers. In the near future event handling facilities will be included for the discrete and hybrid parts of the
Modelica language.

Eclipse plugin editor/browser. The Eclipse plugin called MDT (Modelica Development Tooling) provides
file and class hierarchy browsing and text editing capabilities, rather analogous to previously described
Emacs editor/browser. Some syntax highlighting facilities are also included. The Eclipse framework has
the advantage of making it easier to add future extensions such as refactoring and cross referencing support.

OMNotebook DrModelica model editor. This subsystem provides a lightweight notebook editor, compared
to the more advanced Mathematica notebooks available in MathModelica. This basic functionality still
allows essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters
and sections can be represented and edited, including basic formatting. Cells can contain ordinary text
or Modelica models and expressions, which can be evaluated and simulated. However, no mathematical
typesetting facilities are yet available in the cells of this notebook editor.

Graphical model editor/browser OMEdit. This is a graphical connection editor, for component based model
design by connecting instances of Modelica classes, and browsing Modelica model libraries for reading and
picking component models. The graphical model editor also includes a textual editor for editing model class
definitions, and a window for interactive Modelica command evaluation.

Chapter 1. Introduction
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* Optimization subsystem OMOptim. This is an optimization subsystem for OpenModelica, currently for
design optimization choosing an optimal set of design parameters for a model. The current version has a
graphical user interface, provides genetic optimization algorithms and Pareto front optimization, works in-
tegrated with the simulators and automatically accesses variables and design parameters from the Modelica
model.

* Dynamic Optimization subsystem. This is dynamic optimization using collocation methods, for Model-
ica models extended with optimization specifications with goal functions and additional constraints. This
subsystem is integrated with in the OpenModelica compiler.

* Modelica equation model debugger. The equation model debugger shows the location of an error in the
model equation source code. It keeps track of the symbolic transformations done by the compiler on the
way from equations to low-level generated C code, and also explains which transformations have been done.

* Modelica algorithmic code debugger. The algorithmic code Modelica debugger provides debugging for an
extended algorithmic subset of Modelica, excluding equation-based models and some other features, but in-
cluding some meta-programming and model transformation extensions to Modelica. This is a conventional
full-feature debugger, using Eclipse for displaying the source code during stepping, setting breakpoints, etc.
Various back-trace and inspection commands are available. The debugger also includes a data-view browser
for browsing hierarchical data such as tree- or list structures in extended Modelica.

1.2 Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment,
called OMShell — the OpenModelica Shell). Most of these examples are also available in the OMNotebook with
DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

>>> getInstallationDirectoryPath() + "/share/doc/omc/testmodels/"
"«OPENMODELICAHOME»/share/doc/omc/testmodels/"

The following commands were run using OpenModelica version:

>>> getVersion ()
"OMCompiler v1.14.1-v1.14.1.2+g392c27e260"

1.2.1 Starting the Interactive Session

The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica
Shell which responds with an interaction window:

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in
the variable x. The value of the expression is returned.

>>> x = 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}

1.2.2 Using the Interactive Mode

When running OMC in interactive mode (for instance using OMShell) one can make load classes and execute
commands. Here we give a few example sessions.

Example Session 1

To get help on using OMShell and OpenModelica, type "help()" and press enter.

1.2. Interactive Session with Examples 5
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>>> model A Integer t = 1.5; end A; //The type is Integer but 1.5 is of Real Type
{A}

>>> instantiateModel (A7)

nmn

"[<interactive>:1:9-1:23:writable] Error: Type mismatch in binding t = 1.5
—expected subtype of Integer, got type Real.

Error: Error occurred while flattening model A

[

Example Session 2

To get help on using OMShell and OpenModelica, type "help()" and press enter.

model C
Integer a;
Real b;
equation
der (a) = b;
der(b) = 12.0;
end C;

>>> instantiateModel (C)

nn

Error:

[<interactive>:5:3-5:13:writable] Error: Argument ’a’ to der has illegal type Integer, must be a subtype of
Real.

Error: Error occurred while flattening model C

1.2.3 Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly giving the
command:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—bubblesort.mo")
true

The function bubblesort is called below to sort the vector x in descending order. The sorted result is returned to-
gether with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared
type of the function result. The input Integer vector was automatically converted to a Real vector according to
the Modelica type coercion rules. The function is automatically compiled when called if this has not been done
before.

>>> bubblesort (x)
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}

Another call:

>>> bubblesort ({4,6,2,5,8})
{8.0,6.0,5.0,4.0,2.0}

6 Chapter 1. Introduction
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1.2.4 Trying the system and cd Commands

It is also possible to give operating system commands via the system utility function. A command is provided as
a string argument. The example below shows the system utility applied to the UNIX command cat, which here
outputs the contents of the file bubblesort.mo to the output stream when running omc from the command-line.

>>> gystem("cat '"+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/
—bubblesort.mo' > bubblesort.mo")
0

function bubblesort

input Real[:] x;

output Real[size(x,1)] y;
protected

Real t;
algorithm

Yy T X

for i in l:size(x,1l) loop

for j in 1l:size(x,1) loop
if y[i] > yI[J] then

t o= ylil;
y[i] = y[31;
yI[3l = t;
end if;
end for;
end for;

end bubblesort;

Note: The output emitted into stdout by system commands is put into log-files when running the CORBA-based
clients, not into the visible GUI windows. Thus the text emitted by the above cat command would not be returned,
which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

>>> readFile ("bubblesort.mo")
function bubblesort

input Real[:] x;

output Real[size(x,1)] vy;
protected

Real t;
algorithm

y 1= X

for i in 1l:size(x,1) loop

for j in 1l:size(x,1) loop
if y[i] > y[Jj] then

t o= ylil;
yl[il = y[3];
yI[3l = t;
end if;
end for;
end for;

end bubblesort;

The system command only returns a success code (0 = success).

>>> sgystem("dir")

0

>>> system("Non-existing command")
127

Another built-in command is cd, the change current directory command. The resulting current directory is returned
as a string.

1.2. Interactive Session with Examples 7
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>>> dir:=cd ()

"«DOCHOME»"

>>> cd("source")

"«DOCHOME»/source"

>>> cd(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/")
"/var/lib/jenkins/ws/OpenModelica_maintenance_vl.14/build/share/doc/omc/testmodels"
>>> cd(dir)

"«DOCHOME»"

1.2.5 Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also can be done through the File->Load
Modelica Library menu item:

>>> loadModel (Modelica)
true

We also load a file containing the decmotor model:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo
;}")

true

Warning:

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version
3.2.3. You might experience problems if these versions are incompatible.

It is simulated:

>>> gimulate (dcmotor, startTime=0.0, stopTime=10.0)
record SimulationResult

resultFile = "«DOCHOME»/dcmotor_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'dcmotor', options = '', |
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.475732238,
timeBackend 0.008567573,
timeSimCode = 0.002140669,
timeTemplates = 0.004834162,
timeCompile = 0.397681632,
timeSimulation = 0.016199792,
timeTotal = 0.905274242

end SimulationResult;

Warning:

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version
3.2.3. You might experience problems if these versions are incompatible.

‘We list the source code of the model:

8 Chapter 1. Introduction
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>>> list (dcmotor)
model dcmotor

import Modelica.Electrical.Analog.Basic;

Basic.Resistor resistorl (R 10);

Basic.Inductor inductorl(L = 0.2, 1i.fixed = true);

Basic.Ground groundl;

Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w.
—~fixed = true);

Basic.EMF emfl(k = 1.0);

Modelica.Blocks.Sources.Step stepl;

Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltagel;
equation

connect (stepl.y, signalVoltagel.v);

connect (signalVoltagel.p, resistorl.p);
connect (resistorl.n, inductorl.p);
(
(
(

connect (inductorl.n, emfl.p);
connect (emfl.flange, load.flange_a);
connect (signalVoltagel.n, groundl.p);
connect (groundl.p, emfl.n);
annotation (
uses (Modelica (version = "3.2.2")));
end dcmotor;

We test code instantiation of the model to flat code:

>>> instantiateModel (dcmotor)
class dcmotor

Real resistorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of
—the two pins (= p.v — n.v)";

Real resistorl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from_
—pin p to pin n";

Real resistorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_
—into the pin";

Real resistorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,
—into the pin";

parameter Boolean resistorl.useHeatPort = false "=true, if heatPort is enabled";

parameter Real resistorl.T(quantity = "ThermodynamicTemperature", unit = "K", |
—displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistorl.T_
—ref "Fixed device temperature if useHeatPort = false";

Real resistorl.LossPower (quantity = "Power", unit = "W") "Loss power leaving,
—component via heatPort";

Real resistorl.T_heatPort (quantity = "ThermodynamicTemperature", unit = "K", |
—displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) "Temperature_
—~of heatPort";

parameter Real resistorl.R(quantity = "Resistance", unit = "Ohm", start = 1.0) =
—10.0 "Resistance at temperature T_ref";

parameter Real resistorl.T_ref (quantity = "ThermodynamicTemperature", unit = "K",
— displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15
—"Reference temperature”;

parameter Real resistorl.alpha(quantity = "LinearTemperatureCoefficient", unit =
—"1/K") = 0.0 "Temperature coefficient of resistance (R_actual = Rx (1 + alphax (T_
—heatPort - T_ref))";

Real resistorl.R_actual (quantity = "Resistance", unit = "Ohm") "Actual_
—resistance = R+ (1 + alphax (T_heatPort - T_ref))";

Real inductorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of
—the two pins (= p.v — n.v)";

Real inductorl.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed =_

—true) "Current flowing from pin p to pin n";

(continues on next page)
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(continued from previous page)

Real inductorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_
—into the pin";

Real inductorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing
—into the pin";

parameter Real inductorl.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.
—2 "Inductance";

Real groundl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real groundl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into,
—the pin";

Real load.flange_a.phi (quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_a.tau(gquantity = "Torque", unit = "N.m") "Cut torque in the_
—flange";

Real load.flange_b.phi(quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the_
—flange";

parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0,
—start = 1.0) = 1.0 "Moment of inertia";

parameter enumeration (never, avoid, default, prefer, always) load.stateSelect =
—StateSelect.default "Priority to use phi and w as states";

Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed =
—true, stateSelect = StateSelect.default) "Absolute rotation angle of component";

Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true,
—stateSelect = StateSelect.default) "Absolute angular velocity of component (=
—der (phi))";

Real load.a(quantity = "AngularAcceleration", unit = "rad/s2") "Absolute angular,
—acceleration of component (= der(w))";

parameter Boolean emfl.useSupport = false "= true, if support flange enabled,
—otherwise implicitly grounded";

parameter Real emfl.k(quantity = "ElectricalTorqueConstant", unit = "N.m/A",
—~start = 1.0) = 1.0 "Transformation coefficient";

Real emfl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between_
—the two pins";

Real emfl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from,
—positive to negative pin";

Real emfl.phi (quantity = "Angle", unit = "rad", displayUnit = "deg") "Angle of |
—shaft flange with respect to support (= flange.phi - support.phi)";

Real emfl.w(quantity = "AngularVelocity", unit = "rad/s") "Angular velocity of
—flange relative to support";

Real emfl.tau(quantity = "Torque", unit = "N.m") "Torque of flange";

Real emfl.tauElectrical (quantity = "Torque", unit = "N.m") "Electrical torque";

Real emfl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real emfl.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange
=";

protected Real emfl.internalSupport.tau(quantity = "Torque", unit = "N.m") = -
—emfl.tau "External support torque (must be computed via torque balance in model_,
—where InternalSupport is used; = flange.tau)";

protected Real emfl.internalSupport.phi (quantity = "Angle", unit = "rad",_

displayUnit = "deg") "External support angle (= flange phi)";

(continues on next page)
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(continued from previous page)

protected Real emfl.internalSupport.flange.phi (quantity = "Angle", unit = "rad", |
—displayUnit = "deg") "Absolute rotation angle of flange";

protected Real emfl.internalSupport.flange.tau(quantity = "Torque", unit = "N.m
—") "Cut torque in the flange";

protected parameter Real emfl.fixed.phiO (quantity = "Angle", unit = "rad",_
—displayUnit = "deg") = 0.0 "Fixed offset angle of housing";

protected Real emfl.fixed.flange.phi (quantity = "Angle", unit = "rad", |
—displayUnit = "deg") "Absolute rotation angle of flange";

protected Real emfl.fixed.flange.tau(quantity = "Torque", unit = "N.m") "Cut_

—torque in the flange";

Real stepl.y "Connector of Real output signal";

parameter Real stepl.offset = 0.0 "Offset of output signal y";

parameter Real stepl.startTime (quantity = "Time", unit = "s") = 0.0 "Output y =,
—offset for time < startTime";

parameter Real stepl.height = 1.0 "Height of step";

Real signalVoltagel.p.v(quantity = "ElectricPotential"”, unit = "V") "Potential
—at the pin";

Real signalVoltagel.p.i(quantity = "ElectricCurrent", unit = "A") "Current,
—flowing into the pin";

Real signalVoltagel.n.v(quantity = "ElectricPotential", unit = "V") "Potential,
—at the pin";

Real signalVoltagel.n.i(quantity = "ElectricCurrent"”, unit = "A") "Current,_
—flowing into the pin";

Real signalVoltagel.v(unit = "V") "Voltage between pin p and n (= p.v — n.v) as,
—input signal";

Real signalVoltagel.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,
—from pin p to pin n";
equation

assert (1.0 + resistorl.alpha x (resistorl.T_heatPort - resistorl.T_ref) >= le-15,
— "Temperature outside scope of model!");

resistorl.R_actual = resistorl.R % (1.0 + resistorl.alpha * (resistorl.T_
—heatPort - resistorl.T_ref));

resistorl.v = resistorl.R_actual * resistorl.i;

resistorl.LossPower = resistorl.v = resistorl.i;

resistorl.v = resistorl.p.v - resistorl.n.v;

0.0 = resistorl.p.i + resistorl.n.i;

resistorl.i = resistorl.p.i;

resistorl.T_heatPort = resistorl.T;

inductorl.L * der (inductorl.i) = inductorl.v;

inductorl.v = inductorl.p.v - inductorl.n.v;

0.0 = inductorl.p.i + inductorl.n.i;

inductorl.i = inductorl.p.i;

groundl.p.v = 0.0;

load.phi = load.flange_a.phi;

load.phi = load.flange_b.phi;

load.w = der(load.phi);

load.a = der(load.w);

load.J % load.a = load.flange_a.tau + load.flange_b.tau;
emfl.internalSupport.flange.tau = emfl.internalSupport.tau;
emfl.internalSupport.flange.phi = emfl.internalSupport.phi;
emfl.fixed.flange.phi = emfl.fixed.phiO;

emfl.v = emfl.p.v - emfl.n.v;

0.0 = emfl.p.i + emfl.n.i;

emfl.i = emfl.p.1i;

emfl.phi = emfl.flange.phi - emfl.internalSupport.phi;
emfl.w = der (emfl.phi);

emfl.k » emfl.w = emfl.v;

emfl.tau = (-emfl.k) » emfl.i;

emfl.tauElectrical = -emfl.tau;

emfl.tau = emfl.flange.tau;

stepl.y = stepl.offset + (if time < stepl.startTime then 0.0 else stepl.height);

(continues on next page)
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(continued from previous page)

signalVoltagel.v = signalVoltagel.p.v - signalVoltagel.n.v;
0.0 = signalVoltagel.p.i + signalVoltagel.n.i;
signalVoltagel.i = signalVoltagel.p.i;
resistorl.p.i + signalVoltagel.p.i = 0.0;
resistorl.n.i + inductorl.p.i = 0.0;
inductorl.n.i + emfl.p.i = 0.0;
groundl.p.i + emfl.n.i + signalVoltagel.n.i = 0.0;
load.flange_a.tau + emfl.flange.tau = 0.0;
load.flange_b.tau = 0.0;
emfl.fixed.flange.tau + emfl.internalSupport.flange.tau = 0.0;
emfl.fixed.flange.phi = emfl.internalSupport.flange.phi;
signalVoltagel.v = stepl.y;
resistorl.p.v = signalVoltagel.p.v;
inductorl.p.v = resistorl.n.v;
emfl.p.v = inductorl.n.v;
emfl.flange.phi = load.flange_a.phi;
emfl.n.v = groundl.p.v;
emfl.n.v = signalVoltagel.n.v;

end dcmotor;

Warning:

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version
3.2.3. You might experience problems if these versions are incompatible.

We plot part of the simulated result:

T
load.w —
load.phi

15 1

0.5 -

Figure 1.2: Rotation and rotational velocity of the DC motor

1.2.6 The val() function

The val(variableName,time) scription function can be used to retrieve the interpolated value of a simulation result
variable at a certain point in the simulation time, see usage in the BouncingBall simulation below.
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1.2.7 BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica
keywords have been bold-faced by hand for better readability):

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")
true

>>> list (BouncingBall)
model BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g = 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v (fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);
Integer foo;

equation
impact = h <= 0.0;
foo = if impact then 1 else 2;

der (v) = if flying then -g else 0;

der (h) = v;

when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then -e » pre(v) else 0;
flying = v_new > 0;
reinit (v, v_new);

end when;

end BouncingBall;

Instead of just giving a simulate and plot command, we perform a runScript command on a .mos (Modelica script)
file sim_BouncingBall.mos that contains these commands:

>>> writeFile("sim_BouncingBall.mos", "

loadFile (getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/
—BouncingBall.mo\");

simulate (BouncingBall, stopTime=3.0);

/+ plot ({h, flying}); =*/
")
true
>>> runScript ("sim_BouncingBall.mos")
"true
record SimulationResult

resultFile = \"«DOCHOME»/BouncingBall_res.mat\",

simulationOptions = \"startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options =
—''", outputFormat = 'mat', variableFilter = '.%', cflags = '', simflags = ''\",
messages = \"LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

\"I
timeFrontend = 0.003325564,
timeBackend = 0.002663823,
timeSimCode 0.0007894320000000001,
timeTemplates = 0.003040649,
timeCompile = 0.373622931,
timeSimulation = 0.018288847,
timeTotal = 0.401816396

end SimulationResult;
n
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model Switch
Real v;
Real 1i;
Real il;
Real itot;
Boolean open;
equation
itot = 1 + 11;
if open then
v = 0;
else
i = 0;
end if;
1 - 11 = 0;
1 - v — 1= 0;
open = time >= 0.5;
end Switch;

>>> gimulate (Switch, startTime=0, stopTime=1)
record SimulationResult

resultFile = "«DOCHOME»/Switch_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Switch', options = '"', |,
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.003732029,

timeBackend = 0.008021524,
timeSimCode = 0.001590309,
timeTemplates = 0.004080721,

timeCompile = 0.363894608,
timeSimulation = 0.017090836,
timeTotal = 0.398516035

end SimulationResult;

Retrieve the value of itot at time=0 using the val(variableName, time) function:

>>> val (itot, 0)
1.0

Plot itot and open:

We note that the variable open switches from false (0) to true (1), causing itot to increase from 1.0 to 2.0.

1.2.8 Clear All Models

Now, first clear all loaded libraries and models:

>>> clear ()
true

List the loaded models — nothing left:

>>> list ()

nn

1.2.9 VanDerPol Model and Parametric Plot

We load another model, the VanDerPol model (or via the menu File->Load Model):
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Figure 1.3: Plot when the switch opens

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.

—mo")
true

It is simulated:

>>> simulate (VanDerPol, stopTime=80)
record SimulationResult

resultFile = "«DOCHOME»/VanDerPol_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'VanDerPol', options = '',
— outputFormat = 'mat', variableFilter = '.%', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

"
’

timeFrontend = 0.031724602,
timeBackend .001498905,
timeSimCode = 0.000434299,
timeTemplates = 0.002274755,
timeCompile = 0.349465463,
timeSimulation = 0.012815575,
timeTotal = 0.398275536

end SimulationResult;

Il
o o

It is plotted:

>>> plotParametric ("x","y")

Perform code instantiation to flat form of the VanDerPol model:

>>> instantiateModel (VanDerPol)
class VanDerPol "Van der Pol oscillator model"
Real x(start 1.0, fixed = true);
Real y(start 1.0, fixed = true);
parameter Real lambda = 0.3;
equation
der (x) = y;

(continues on next page)

1.2. Interactive Session with Examples

15




OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

Figure 1.4: VanDerPol plotParametric(x,y)

(continued from previous page)

der(y) = lambda * (1.0 — x ~ 2.0) % y — x%;
end VanDerPol;

1.2.10 Using Japanese or Chinese Characters

Japenese, Chinese, and other kinds of UniCode characters can be used within quoted (single quote) identifiers, see
for example the variable name to the right in the plot below:

File Edit Special

Plot by OpenModelica
1.0F ! ! 1'E= .

g.8r }

0.0

0.0 0.3 1.0 1.5 2.0 2.2

1.2.11 Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation at each line into OMShell requires
copy-paste as one operation from another document):
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>>> k 1= 0;

>>> for i in 1:1000 loop
k =k + 1i;

end for;

>>> k

500500

A nested loop summing reals and integers:

>>> g := 0.
>>> h := 5;
>>> for i in {23.0,77.12,88.23} loop
for j in 1:0.5:(i+1) loop
g =g + J;
g :=g + h / 2;
end for;
h :=h + g;
end for;

0;

By putting two (or more) variables or assignment statements separated by semicolon(s), ending with a variable,
one can observe more than one variable value:

>>> h; g
1997.45
1479.09

A for-loop with vector traversal and concatenation of string elements:

>>> i:="";
>>> 1lst := {"Here ", "are ","some ","strings."};
>>> g = "";
>>> for i in lst loop
s := s + 1ij
end for;
>>> g

"Here are some strings."

Normal while-loop with concatenation of 10 "abc " strings:

>>> g:="";
>>> i:=1;
>>> while i<=10 loop
s:="abc "+s;
i:=1i+1;
end while;
>>> 3
"abc abc abc abc abc abc abc abc abc abc "

A simple if-statement. By putting the variable last, after the semicolon, its value is returned after evaluation:

>>> if 5>2 then a := 77; end if; a
77

An if-then-else statement with elseif"

>>> if false then

a := 5;
elseif a > 50 then
b:= "test"; a:= 100;
else
a:=34;
end if;
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Take a look at the variables a and b:

>>> a;b
100
"test"

1.2.12 Variables, Functions, and Types of Variables

Assign a vector to a variable:

>>> a:=1:5
{1,2,3,4,5}

Type in a function:

function mySqr
input Real x;
output Real y;

algorithm
ViI=X*X;

end mySqr;

Call the function:

>>> b:i=mySqr (2)
4.0

Look at the value of variable a:

>>> a
{1,2,3,4,5}

Look at the type of a:

>>> typeOf (a)
"Integer[5]"

Retrieve the type of b:

>>> typeOf (b)
"Real "

What is the type of mySqr? Cannot currently be handled.

>>> typeOf (mySqgr)

List the available variables:

>>> listVariables ()
{b,a,s,1lst,i,h,qg,k,currentSimulationResult}

Clear again:

>>> clear ()
true

1.2.13 Getting Information about Error Cause

Call the function getErrorString() in order to get more information about the error cause after a simulation failure:
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>>> getErrorString()

1.2.14 Alternative Simulation Output Formats

There are several output format possibilities, with mat being the default. plt and mat are the only formats that
allow you to use the val() or plot() functions after a simulation. Compared to the speed of plt, mat is roughly 5
times for small files, and scales better for larger files due to being a binary format. The csv format is roughly twice
as fast as plt on data-heavy simulations. The plt format allocates all output data in RAM during simulation, which
means that simulations may fail due applications only being able to address 4GB of memory on 32-bit platforms.
Empty does no output at all and should be by far the fastest. The csv and plt formats are suitable when using an
external scripts or tools like gnuplot to generate plots or process data. The mat format can be post-processed in
MATLAB or Octave.

>>> simulate (...
>>> simulate (...

( , outputFormat="mat")
( 4
( ’
( 4

outputFormat="csv")
outputFormat="plt")
outputFormat="empty")

>>> gsimulate (...
>>> simulate (...

It is also possible to specify which variables should be present in the result-file. This is done by using POSIX
Extended Regular Expressions. The given expression must match the full variable name (* and $ symbols are
automatically added to the given regular expression).

// Default, match everything

’>>> simulate (... , variableFilter=".x+")

// match indices of variable myVar that only contain the numbers using combinations

/1 of the letters 1 through 3

’>>> simulate (... , variableFilter="myVar\\\[[1-3]7*\\\1")

/I match x ory or z

’>>> simulate (... , variableFilter="x|y|z")

1.2.15 Using External Functions

See Chapter Interoperability — C and Python for more information about calling functions in other programming
languages.

1.2.16 Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a new OpenModelica feature that auto-
matically partitions the system of equations and schedules the parts for execution on different cores using shared-
memory OpenMP based execution. The speedup obtained is dependent on the model structure, whether the system
of equations can be partitioned well. This version in the current OpenModelica release is an experimental ver-
sion without load balancing. The following command, not yet available from the OpenModelica GUI, will run a
parallel simulation on a model:

>>> omc —d=openmp model.mo
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1.2.17 Loading Specific Library Version

There exist many different versiosn of Modelica libraries which are not compatible. It is possible to keep mul-
tiple versions of the same library stored in the directory given by calling getModelicaPath(). By calling load-
Model(Modelica,{"3.2"}), OpenModelica will search for a directory called "Modelica 3.2" or a file called "Mod-
elica 3.2.mo". It is possible to give several library versions to search for, giving preference for a pre-release version
of a library if it is installed. If the searched version is "default", the priority is: no version name (Modelica), main
release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1) and unordered versions (Modelica Spe-
cial Release).

The loadModel command will also look at the uses annotation of the top-level class after it has been loaded. Given
the following package, Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST automatically.

package Modelica
annotation (uses (Complex (version="1.0"),
ModelicaServices (version="1.1")));

end Modelica;

>>> clear ()
true

Packages will also be loaded if a model has a uses-annotation:

model M
annotation (uses (Modelica (version="3.2.1")));
end M;

>>> instantiateModel (M)
class M
end M;

Note:
Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation.
Notification: Automatically loaded package Complex 3.2.1 due to uses annotation.

Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation.

Packages will also be loaded by looking at the first identifier in the path:

>>> instantiateModel (Modelica.Electrical.Analog.Basic.Ground)
class Modelica.Electrical.Analog.Basic.Ground "Ground node"

Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin
=";
equation
p.v = 0.0;
p.i = 0.0;

end Modelica.Electrical.Analog.Basic.Ground;

Note:
Notification: Automatically loaded package Complex 3.2.3 due to uses annotation.
Notification: Automatically loaded package ModelicaServices 3.2.3 due to uses annotation.

Notification: Automatically loaded package Modelica default due to uses annotation.
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1.2.18 Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application programming interface) is described
which returns information about models and/or allows manipulation of models. Calls to these functions can be
done interactively as below, but more typically by program clients to the OpenModelica Compiler (OMC) server.
Current examples of such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the OMEdit graphic
model editor, etc. This API is untyped for performance reasons, i.e., no type checking and minimal error checking
is done on the calls. The results of a call is returned as a text string in Modelica syntax form, which the client has
to parse. An example parser in C++ is available in the OMNotebook source code, whereas another example parser
in Java is available in the MDT Eclipse plugin.

Below we show a few calls on the previously simulated BouncingBall model. The full documentation on this API
is available in the system documentation. First we load and list the model again to show its structure:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo");
>>> list (BouncingBall)
model BouncingBall
parameter Real e
parameter Real g 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v (fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new (fixed
Integer foo;
equation
impact = h <= 0.0;
foo = if impact then 1 else 2;
der (v) = if flying then -g else 0;
der (h) = v;
when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then -e » pre(v) else 0;
flying = v_new > 0O;
reinit (v, v_new);
end when;
end BouncingBall;

0.7 "coefficient of restitution";

true);

Different kinds of calls with returned results:

>>> getClassRestriction (BouncingBall)

"model"

>>> getClassInformation (BouncingBall)

("model","", false, false, false, "/var/lib/jenkins/ws/OpenModelica_maintenance_vl1.14/
—build/share/doc/omc/testmodels/BouncingBall.mo", false,1,1,23,17, {}, false, false, "
", """, false,"")

>>> igFunction (BouncingBall)

false

>>> existClass (BouncingBall)

true

>>> getComponents (BouncingBall)

{{Real,e,"coefficient of restitution", "public", false, false, false, false,
—"parameter", "none", "unspecified",{}},{Real,g,"gravity acceleration", "public",
—false, false, false, false, "parameter", "none", "unspecified",{}}, {Real,h,
—"height of ball", "public", false, false, false, false, "unspecified", "none",
—"unspecified", {}}, {Real,v,"velocity of ball", "public", false, false, false,
—false, "unspecified", "none", "unspecified",{}},{Boolean, flying,"true, if ball_
—is flying", "public", false, false, false, false, "unspecified", "none",
—"unspecified", {}}, {Boolean, impact,"", "public", false, false, false, false,
—"unspecified", "none", "unspecified",{}},{Real,v_new,"", "public", false, false,
—~false, false, "unspecified", "none", "unspecified",{}}, {Integer,foo,"", "public",
— false, false, false, false, "unspecified", "none", "unspecified", {}}}

(continues on next page)
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(continued from previous page)

>>> getConnectionCount (BouncingBall)

0

>>> getInheritanceCount (BouncingBall)

0

>>> getComponentModifierValue (BouncingBall,e)
"o.7"

>>> getComponentModifierNames (BouncingBall, "e")
{}

>>> getClassRestriction (BouncingBall)

"model"

>>> getVersion() // Version of the currently running OMC
"OMCompiler v1.14.1-v1.14.1.2+g392c27e260"

1.2.19 Quit OpenModelica

Leave and quit OpenModelica:

>>> quit ()

1.2.20 Dump XML Representation

The command dumpXMLDAE dumps an XML representation of a model, according to several optional parame-
ters.

dumpXMLDAE(modelnamel[ ,asInSimulationCode=<Boolean>] [,filePrefix=<String>] [,storeln-
Temp=<Boolean>] [,addMathMLCode =<Boolean>])

This command dumps the mathematical representation of a model using an XML representation, with optional
parameters. In particular, asInSimulationCode defines where to stop in the translation process (before dumping the
model), the other options are relative to the file storage: filePrefix for specifying a different name and storeInTemp
to use the temporary directory. The optional parameter addMathMLCode gives the possibility to don’t print the
MathML code within the xml file, to make it more readable. Usage is trivial, just: addMathMLCode=true/false
(default value is false).

1.2.21 Dump Matlab Representation

The command export dumps an XML representation of a model, according to several optional parameters.
exportDAEtoMatlab(modelname);

This command dumps the mathematical representation of a model using a Matlab representation. Example:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")

true

>>> exportDAEtoMatlab (BouncingBall)

"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"

% Incidence Matrix

% number of rows: 6

IM={{3,6},{1,{"1f", 'true','==" {3},{},}},{{"if", 'true','==" {4},{},}}, {5}, {2,{"1f
—', 'edge(impact)' {3},{5},}},{4,2}};

VL = {'foo','v_new', "impact', 'flying','v', 'h'};

EgStr = {'impact = h <= 0.0;"',"'foo = if impact then 1 else 2;','der(v) = if flying,
—then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_
— 2 £ ] {3 =\ + L \ " \ 1 al al <l 1 1 1 1 [ =0 al
7 H—edge{impactr—thenr——e) pretv—et S e whe T ST litinues onniext page)
—and v <= 0.0, impact} then flying = v_new > 0.0; end when;'};
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(continued from previous page)

OldEgStr={'class BouncingBall',' parameter Real e = 0.7 "coefficient of

—restitution”;',' parameter Real g = 9.81 "gravity acceleration";',' Real,
—h(start = 1.0, fixed = true) "height of ball";',' Real v(fixed = true)
—"velocity of ball";',' Boolean flying(start = true, fixed = true) "true, if
—ball is flying";',' Boolean impact;',' Real v_new(fixed = true);',' Integer,
—~foo; ', 'equation', ' impact = h <= 0.0;"'," foo = if impact then 1 else 2;','
—der(v) = if flying then -g else 0.0;'," der (h) = v;"'," when {h <= 0.0 and v <=_
—0.0, impact} then',' v_new = if edge (impact) then (-e) x pre(v) else 0.0;','

— flying = v_new > 0.0;"'," reinit (v, v_new);"',"' end when; ', 'end BouncingBall;

Y

1.3 Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in the interactive session hander.

simulate(modelname) Translate a model named modelname and simulate it.

simulate(modelnamel startTime=<Real>][,stopTime=<Real>][,numberOflntervals
=<Integer>][,outputlnterval=<Real>][,method=<String>|
[,tolerance=<Real>][,fixedStepSize=<Real>]

[,outputFormat=<String>]) Translate and simulate a model, with optional start time, stop time, and optional
number of simulation intervals or steps for which the simulation results will be computed. More intervals will
give higher time resolution, but occupy more space and take longer to compute. The default number of intervals
is 500. It is possible to choose solving method, default is “dassl”, “euler” and “rungekutta” are also available.
Output format “mat” is default. “plt” and “mat” (MATLAB) are the only ones that work with the val() command,
“csv” (comma separated values) and “empty” (no output) are also available (see section Alternative Simulation
Output Formats).

plot(vars) Plot the variables given as a vector or a scalar, e.g. plot({x1,x2}) or plot(x1).

plotParametric(varl, var2) Plot var2 relative to varl from the most recently simulated model, e.g. plotParamet-
ric(X,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.

clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model, according to several optional param-
eters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname)Performs code instantiation of a model/class and return a string containing the flat
class definition.

list() Return a string containing all loaded class definitions.
list(modelname) Return a string containing the class definition of the named class.
listVariables() Return a vector of the names of the currently defined variables.

loadModel(classname) Load model or package of name classname from the path indicated by the environment
variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string argument str.
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readFile(str) Load file given as string str and return a string containing the file content.
runScript(str) Execute script file with file name given as string argument str.

system(str) Execute str as a system(shell) command in the operating system; return integer success value. Output
into stdout from a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of seconds (elapsed time) the evaluation took.
typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name modelname in the file given by the string argument
Str.

val(variable,timePoint) Return the (interpolated) value of the variable at time timePoint.
help() Print this helptext (returned as a string).

quit() Leave and quit the OpenModelica environment

1.4 Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows cmd.exe.

Example Session 1 — obtaining information about command line parameters

C:\dev> C:\OpenModelical.9.2 \bin\omc -h

OpenModelica Compiler 1.9.2

Copyright © 2015 Open Source Modelica Consortium (OSMC)
Distributed under OMSC-PL and GPL, see https://www.openmodelica.org/
Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]

Example Session 2 - create an TestModel.mo file and run omc on it

C:\dev> echo model TestModel parameter Real x = 1; end TestModel; > TestModel.mo
C:\dev> C:\OpenModelical.9.2 \bin\omc TestModel.mo
class TestModel
parameter Real x = 1.0;
end TestModel;
C:\dev>

Example Session 3 - create an script.mos file and run omc on it

Create a file script.mos using your editor containing these commands:
/1 start script.mos
loadModel(Modelica); getErrorString();
simulate(Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum); getErrorString();
/ end script.mos
C:\dev> notepad script.mos
C:\dev> C:\OpenModelical.9.2 \bin\omc script.mos
true
record SimulationResult
resultFile = "C:/dev/Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum_res.mat",
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simulationOptions = "startTime = 0.0, stopTime = 5.0, numberOfIntervals = 500, tolerance = 1e-006,
method = "dassl’, fileNamePrefix = "Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum’,

LRI

options =, outputFormat = *mat’, variableFilter = *.*’, cflags =, simflags =",
messages ="",

timeFrontend = 1.245787339209033,

timeBackend = 20.51007138993843,

timeSimCode = 0.1510248469321959,

timeTemplates = 0.5052317333954395,

timeCompile = 5.128213942691722,

timeSimulation = 0.4049189573103951,

timeTotal = 27.9458487395605

end SimulationResult;

"nn

In order to obtain more information from the compiler one can use the command line options -
showErrorMessages -d=failtrace when running the compiler:

C:\dev> C:\OpenModelical.9.2 \bin\omc —showErrorMessages -d=failtrace script.mos
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CHAPTER
TWO

OMEDIT — OPENMODELICA CONNECTION EDITOR

OMEdit — OpenModelica Connection Editor is the new Graphical User Interface for graphical model editing in
OpenModelica. It is implemented in C++ using the Qt graphical user interface library and supports the Modelica
Standard Library that is included in the latest OpenModelica installation. This chapter gives a brief introduction
to OMEdit and also demonstrates how to create a DCMotor model using the editor.

OMEdit provides several user friendly features for creating, browsing, editing, and simulating models:
* Modeling — Easy model creation for Modelica models.
* Pre-defined models — Browsing the Modelica Standard library to access the provided models.
 User defined models — Users can create their own models for immediate usage and later reuse.

* Component interfaces — Smart connection editing for drawing and editing connections between model in-
terfaces.

* Simulation — Subsystem for running simulations and specifying simulation parameters start and stop time,
etc.

* Plotting — Interface to plot variables from simulated models.

2.1 Starting OMEdit

A splash screen similar to the one shown in Figure 2.1 will appear indicating that it is starting OMEdit. The
executable is found in different places depending on the platform (see below).

2.1.1 Microsoft Windows
OMEdit can be launched wusing the executable placed in OpenModelicalnstallationDirec-

tory/bin/OMEdit/OMEdit.exe. Alternately, choose OpenModelica > OpenModelica Connection Editor from the
start menu in Windows.

2.1.2 Linux

Start OMEdit by either selecting the corresponding menu application item or typing “OMEdit” at the shell or
command prompt.

2.1.3 Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.
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OMEdit
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Figure 2.1: OMEdit Splash Screen.

2.2 MainWindow & Browsers

The MainWindow contains several dockable browsers,
e Libraries Browser
* Documentation Browser
* Variables Browser
* Messages Browser
Figure 2.2 shows the MainWindow and browsers.

The default location of the browsers are shown in Figure 2.2. All browsers except for Message Browser can
be docked into left or right column. The Messages Browser can be docked into top or bottom areas. If you
want OMEdit to remember the new docked position of the browsers then you must enable Preserve User’s GUI
Customizations option, see section General.

2.2.1 Filter Classes

To filter a class click Edit > Filter Classes or press keyboard shortcut Ctrl+Shift+F. The loaded Modelica classes
can be filtered by typing any part of the class name.

2.2.2 Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser. Shows the list of loaded Modelica
classes. Each item of the Libraries Browser has right click menu for easy manipulation and usage of the class. The
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Figure 2.2: OMEdit MainWindow and Browsers.
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classes are shown in a tree structure with name and icon. The protected classes are not shown by default. If you
want to see the protected classes then you must enable the Show Protected Classes option, see section General.

ot OMEdit - OpenModelica Connection Editor - ':'
File Edit View Simulation FMI  Export TJools Help

FeB8 R Heee \oHOTH E-H- 9 ¢

Libraries Browser

| chua
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0 View Documentation
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‘&  Export FMU
&  Export XML Open Model/Library File(s)
B  Export Figaro

t Welcome gﬁ Modeling ﬂ Plotting

Figure 2.3: Libraries Browser.

2.2.3 Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the navigation buttons for moving forward and
backward. It also contains a WYSIWYG editor which allows writing class documentation in HTML format. To see
documentation of any class, right click the Modelica class in Libraries Browser and choose View Documentation.

2.2.4 Variables Browser

The class variables are structured in the form of the tree and are displayed in the Variables Browser. Each variable
has a checkbox. Ticking the checkbox will plot the variable values. There is a find box on the top for filtering the
variable in the tree. The filtering can be done using Regular Expression, Wildcard and Fixed String. The complete
Variables Browser can be collapsed and expanded using the Collapse All and Expand All buttons.

The browser allows manipulation of changeable parameters for Re-simulating a Model. It also displays the unit
and description of the variable.

The browser also contains the slider and animation buttons. These controls are used for variable graphics and
schematic animation of models i.e., DynamicSelect annotation. They are also used for debugging of state ma-
chines. Open the Diagram Window for animation. It is only possible to animate one model at a time. This is
achieved by marking the result file active in the Variables Browser. The animation only read the values from the
active result file. It is possible to simulate several models. In that case, the user will see a list of result files in
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Figure 2.4: Documentation Browser.
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the Variables Browser. The user can switch between different result files by right clicking on the result file and
selecting Set Active in the context menu.

Variables Browser 8 X
|Filter variables o
[] Case Sensitive Regular Expression -

Expand All Collapse all
Simulation Time Unit g -

“ ’ II Time:|0.0 Speed:| 1w
o

Variables Value Display Unit  Description
=] Modelica.E...huaCircuit
=
C 10.0 F Capacitance
[ 1derfv) 0.014557 kma...-1.g der(Voltage drop of..pins (= pv - nwv))
L] 0.14557 A Current flowing from pin p to pin n
n

Voltage drop of the.. pins (= pv - nw)

HEBEBDE

=R s I S ]

[=] = =1 [R=]
[= 8

Figure 2.5: Variables Browser.

2.2.5 Messages Browser

Shows the list of errors. Following kinds of error can occur,
¢ Syntax
e Grammar
¢ Translation
* Symbolic
¢ Simulation
e Scripting

See section Messages for Messages Browser options.

2.3 Perspectives

The perspective tabs are loacted at the bottom right of the MainWindow:

¢ Welcome Perspective
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* Modeling Perspective
* Plotting Perspective

* Debugging Perspective

2.3.1 Welcome Perspective
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ED‘ March 9, 2016: OpenModelica 1.9.4 released
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Clear Recent Files For more details visit our website www.openmodelica.org
Create Mew Modelica Class Open Model/Library File(s)

t Welcome oﬁ Modeling ﬂ Plotting '» Debugging

Figure 2.6: OMEdit Welcome Perspective.

The Welcome Perspective shows the list of recent files and the list of latest news from https://www.openmodelica.
org/. See Figure 2.6. The orientation of recent files and latest news can be horizontal or vertical. User is allowed
to show/hide the latest news. See section General.

2.3.2 Modeling Perspective

The Modeling Perpective provides the interface where user can create and design their models. See Figure 2.7.

The Modeling Perspective interface can be viewed in two different modes, the tabbed view and subwindow view,
see section General.

2.3.3 Plotting Perspective

The Plotting Perspective shows the simulation results of the models. Plotting Perspective will automatically
become active when the simulation of the model is finished successfully. It will also become active when user
opens any of the OpenModelica’s supported result file. Similar to Modeling Perspective this perspective can also
be viewed in two different modes, the tabbed view and subwindow view, see section General.
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Figure 2.7: OMEdit Modeling Perspective.
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2.3.4 Debugging Perspective

The application automatically switches to Debugging Perpective when user simulates the class with algorithmic
debugger. The prespective shows the list of stack frames, breakpoints and variables.
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Figure 2.9: OMEdit Debugging Perspective.

2.4 File Menu

e New Modelica Class - Creates a new Modelica class.
* Open Model/Library File(s) - Opens the Modelica file or a library.

* Open/Convert Modelica File(s) With Encoding - Opens the Modelica file or a library with a specific encod-
ing. It is also possible to convert to UTF-8.

Load Library - Loads a Modelica library. Allows the user to select the library path assuming that the path
contains a package.mo file.

Load Encrypted Library - Loads an encrypted library. see OpenModelica Encryption
* Open Result File(s) - Opens a result file.

Open Transformations File - Opens a transformational debugger file.

New Composite Model - Creates a new composite model.

Open Composite Model(s) - Loads an existing composite model.

Load External Model(s) - Loads the external models that can be used within composite model.
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Open Directory - Loads the files of a directory recursively. The files are loaded as text files.

Save - Saves the class.

Save As - Save as the class.

Save Total - Saves the class and all the classes it uses in a single file. The class and its dependencies can
only be loaded later by using the loadFile() API function in a script. Allows third parties to reproduce an

issue with a class without worrying about library dependencies.

Import

FMU - Imports the FMU.

FMU Model Description - Imports the FMU model description.

From OMNotbook - Imports the Modelica models from OMNotebook.

Ngspice netlist - Imports the ngspice netlist to Modelica code.

"Export"

To Clipboard - Exports the current model to clipboard.

Image - Exports the current model to image.

FMU - Exports the current model to FMU.

Read-only Package - Exports a zipped Modelica library with file extension .mol
Encrypted Package - Exports an encrypted package. see OpenModelica Encryption
XML - Exports the current model to a xml file.

Figaro - Exports the current model to Figaro.

To OMNotebook - Exports the current model to a OMNotebook file.

System Libraries - Contains a list of system libraries.

Recent Files - Contains a list of recent files.

Clear Recent Files - Clears the list of recent files.

Print - Prints the current model.

Quit - Quit the OpenModelica Connection Editor.

Edit Menu

Undo - Undoes the last change.
Redo - Redoes the last undone change.

Filter Classes - Filters the classes in Libraries Browser. see Filter Classes

View Menu

Toolbars - Toggle visibility of toolbars.

Windows - Toggle visibility of windows.

Close Window - Closes the current model window.

Close All Windows - Closes all the model windows.

Close All Windows But This - Closes all the model windows except the current.

Cascade Windows - Arranges all the child windows in a cascade pattern.

Tile Windows Horizontally - Arranges all child windows in a horizontally tiled pattern.

Tile Windows Vertically - Arranges all child windows in a vertically tiled pattern.

2.5. Edit Menu
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Toggle Tab/Sub-window View - Switches between tab and subwindow view.
* Grid Lines - Toggle grid lines of the current model.

* Reset Zoom - Resets the zoom of the current model.

e Zoom In - Zoom in the current model.

e Zoom Out - Zoom out the current model.

2.7 Simulation Menu

* Instantiate Model - Instantiates the current model.

* Check Model - Checks the current model.

e Check All Models - Checks all the models of a library.
* Simulate - Simulates the current model.

* Simulate with Transformational Debugger - Simulates the current model and opens the transformational
debugger.

* Simulate with Algorithmic Debugger - Simulates the current model and opens the algorithmic debugger.
* Simulate with Animation - Simulates the current model and open the animation.

* Simulation Setup - Opens the simulation setup window.

2.8 Debugger Menu

* Debug Configurations - Opens the debug configurations window.

* Attach to Running Process - Attaches the algorithmic debugger to a running process.

2.9 OMSimulator Menu

* New OMSimulator Model - Creates a new OMSimulator model.

* Open OMSimulator Model(s) - Opens the OMSimulator model(s).
* Add System - Adds the system to a model.

* Add/Edit Icon - Add/Edit the system/submodel icon.

e Delete Icon - Deletes the system/submodel icon.

* Add Connector - Adds a connector to a system/submodel.

Add Bus - Adds a bus to a system/submodel.
Add TLM Bus - Adds a TLM bus to a system/submodel.
Add SubModel - Adds a submodel to a system.

e Instantiate Model - Instantiates the model.
e Simulate - Simulates the model.

* Archived Simulations - Opens the archived simulations window.
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2.10 Tools Menu

* OpenModelica Compiler CLI - Opens the OpenModelica Compiler command line interface window.

* OpenModelica Command Prompt - Opens the OpenModelica Command Prompt (Only available on Win-
dows).

* Open Working Directory - Opens the current working directory.
* Open Terminal - Runs the terminal command set in General.

* Options - Opens the options window.

2.11 Help Menu

* OpenModelica Users Guide - Opens the OpenModelica Users Guide.

* OpenModelica Users Guide (PDF) - Opens the OpenModelica Users Guide (PDF).

* OpenModelica System Documentation - Opens the OpenModelica System Documentation.

* OpenModelica Scripting Documentation - Opens the OpenModelica Scripting Documentation.

* Modelica Documentation - Opens the Modelica Documentation.

* OMSimulator Users Guide - Opens the OMSimulator Users Guide.

* OpenModelica TLM Simulator Documentation - Opens the OpenModelica TLM Simulator Documentation.

About OMEdit - Shows the information about OpenModelica Connection Editor.

2.12 Modeling a Model

2.12.1 Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward. Choose any of the following methods,
* Select File > New Modelica Class from the menu.
* Click on New Modelica Class toolbar button.
* Click on the Create New Modelica Class button available at the left bottom of Welcome Perspective.

¢ Press Ctrl+N.

2.12.2 Opening a Modelica File

Choose any of the following methods to open a Modelica file,
* Select File > Open Model/Library File(s) from the menu.
¢ Click on Open Model/Library File(s) toolbar button.
* Click on the Open Model/Library File(s) button available at the right bottom of Welcome Perspective.
* Press Ctrl+O.
(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)

2.12.3 Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu. It is also possible to convert files to
UTF-8.
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2.12.4 Model Widget

For each Modelica class one Model Widget is created. It has a statusbar and a view area. The statusbar contains
buttons for navigation between the views and labels for information. The view area is used to display the icon,
diagram and text layers of Modelica class. See Figure 2.10.

ot DCMotor® B8
I-l-IE o Writable | Model | Diagram View | C:fUsersfadeas31/Desktop/DCmator.mo Line: 1, Col: 0
-
resistor 1 inductorl
sapl
o3
: 23
i
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startTime=startTime
groundl
!
£ >

Figure 2.10: Model Widget showing the Diagram View.

2.12.5 Adding Component Models

Drag the models from the Libraries Browser and drop them on either Diagram or Icon View of Model Widget.

2.12.6 Making Connections

In order to connect one component model to another the user first needs to enable the connect mode ('<:) from
the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor. To start
the connection press left button and move while keeping the button pressed. Now release the left button. Move
towards the end connector and click when cursor changes to cross cursor.
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2.13 Simulating a Model

The simulation options for each model are stored inside the OMEdit data structure. They have the following
sequence,

* Each model has its own simulation options.
« If the model is opened for the first time then the simulation options are set to default.

* experiment and ___OpenModelica_simulationFlags annotations are applied if the model con-
tains them.

 After that all the changes done via Simulation Setup window are preserved for the whole session. If you
want to use the same settings in the future sessions then you should store them inside experiment and
_ _OpenModelica_simulationFlags.

The OMEdit Simulation Setup can be launched by,
¢ Selecting Simulation > Simulation Setup from the menu. (requires a model to be active in ModelWidget)
* Clicking on the Simulation Setup toolbar button. (requires a model to be active in ModelWidget)

* Right clicking the model from the Libraries Browser and choosing Simulation Setup.

2.13.1 General Tab

¢ Simulation Interval

e Start Time — the simulation start time.

* Stop Time — the simulation stop time.

e Number of Intervals — the simulation number of intervals.
e Interval — the length of one interval (i.e., stepsize)

* [Interactive Simulation

* Simulate with steps (makes the interactive simulation synchronous; plots nicer curves at the expense of
performance)

 Simulation server port
* Integration
* Method — the simulation solver. See section Integration Methods for solver details.
e Tolerance — the simulation tolerance.
* Jacobian - the jacobain method to use.
* DASSL/IDA Options
* Root Finding - Activates the internal root finding procedure of dassl.
* Restart After Event - Activates the restart of dassl after an event is performed.
e Initial Step Size
* Maximum Step Size
* Maximum Integration Order
* C/C++ Compiler Flags (Optional) — the optional C/C++ compiler flags.
* Number of Processors — the number of processors used to build the simulation.
* Build Only — only builds the class.
* Launch Transformational Debugger — launches the transformational debugger.
* Launch Algorithmic Debugger — launches the algorithmic debugger.

e Launch Animation — launches the 3d animation window.
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2.13.2 Output Tab

* Output Format — the simulation result file output format.

* Single Precision - Output results in single precision (only for mat output format).
* File Name Prefix (Optional) — the name is used as a prefix for the output files.

* Result File (Optional) - the simulation result file name.

* Variable Filter (Optional)

* Protected Variables — adds the protected variables in result file.

» Equidistant Time Grid — output the internal steps given by dassl instead of interpolating results into an
equidistant time grid as given by stepSize or numberOfIntervals

e Store Variables at Events — adds the variables at time events.

* Show Generated File — displays the generated files in a dialog box.

2.13.3 Simulation Flags Tab

* Model Setup File (Optional) — specifies a new setup XML file to the generated simulation code.

e Initialization Method (Optional) — specifies the initialization method.

» Equation System Initialization File (Optional) — specifies an external file for the initialization of the model.
* Equation System Initialization Time (Optional) — specifies a time for the initialization of the model.

* Clock (Optional) — the type of clock to use.

e Linear Solver (Optional) — specifies the linear solver method.

* Non Linear Solver (Optional) — specifies the nonlinear solver.

* Linearization Time (Optional) — specifies a time where the linearization of the model should be performed.

* Qutput Variables (Optional) — outputs the variables a, b and c at the end of the simulation to the standard
output.

* Profiling — creates a profiling HTML file.

* CPU Time — dumps the cpu-time into the result file.

* Enable All Warnings — outputs all warnings.

* Logging (Optional)

e stdout - standard output stream. This stream is always active, can be disabled with -lv=-stdout
* assert - This stream is always active, can be disabled with -lv=-assert

e LOG_DASSL - additional information about dassl solver.

* LOG_DASSL_STATES - outputs the states at every dassl call.

* LOG_DEBUG - additional debug information.

e LOG_DSS - outputs information about dynamic state selection.

e LOG_DSS_JAC - outputs jacobian of the dynamic state selection.

* LOG_DT - additional information about dynamic tearing.

e LOG_DT_CONS - additional information about dynamic tearing (local and global constraints).
* LOG_EVENTS - additional information during event iteration.

* LOG_EVENTS_V - verbose logging of event system.

e LOG_INIT - additional information during initialization.

e LOG_IPOPT - information from Ipopt.

e LOG_IPOPT_FULL - more information from Ipopt.
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e LOG_IPOPT_JAC - check jacobian matrix with Ipopt.

e LOG_IPOPT_HESSE - check hessian matrix with Ipopt.

e LOG_IPOPT_ERROR - print max error in the optimization.

e LOG_JAC - outputs the jacobian matrix used by dassl.

* LOG_LS - logging for linear systems.

e LOG_LS_V - verbose logging of linear systems.

e LOG_NLS - logging for nonlinear systems.

e LOG_NLS_V - verbose logging of nonlinear systems.

* LOG_NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.
e LOG_NLS_JAC - outputs the jacobian of nonlinear systems.

e LOG_NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.

e LOG_NLS_RES - outputs every evaluation of the residual function.

e LOG_NLS_EXTRAPOLATE - outputs debug information about extrapolate process.
e LOG_RES_INIT - outputs residuals of the initialization.

* LOG_RT - additional information regarding real-time processes.

e LOG_SIMULATION - additional information about simulation process.

e LOG_SOLVER - additional information about solver process.

e LOG_SOLVER_V - verbose information about the integration process.

¢ LOG_SOLVER_CONTEXT - context information during the solver process.

e LOG _SOTI - final solution of the initialization.

e LOG _STATS - additional statistics about timer/events/solver.

e LOG_STATS _V - additional statistics for LOG_STATS.

e LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUCCESS.
e LOG_UTIL.

* LOG_ZEROCROSSINGS - additional information about the zerocrossings.

Additional Simulation Flags (Optional) — specify any other simulation flag.

2.13.4 Archived Simulations Tab

Shows the list of simulations already finished or running. Double clicking on any of them opens the simulation
output window.

2.14 Plotting the Simulation Results

Successful simulation of model produces the result file which contains the instance variables that are candidate for
plotting. Variables Browser will show the list of such instance variables. Each variable has a checkbox, checking
it will plot the variable. See Figure 2.8.

2.14.1 Types of Plotting

The plotting type depends on the active Plot Window. By default the plotting type is Time Plot.
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Time Plot

Plots the variable over the simulation time. You can have multiple Time Plot windows by clicking on New Plot

‘Window toolbar button (|Z).

Plot Parametric

Draws a two-dimensional parametric diagram, between variables x and y, with y as a function of x. You can have

multiple Plot Parametric windows by clicking on the New Plot Parametric toolbar button (@).

Array Plot

Plots an array variable so that the array elements’ indexes are on the x-axis and corresponding elements’ values
are on the y-axis. The time is controlled by the slider above the variable tree. When an array is present in the
model, it has a principal array node in the variable tree. To plot this array as an Array Plot, match the principal
node. The principal node may be expanded into particular array elements. To plot a single element in the Time
Plot, match the element. A new Array Plot window is opened using the New Array Plot Window toolbar button

Loy,

Array Parametric Plot
Plots the first array elements’ values on the x-axis versus the second array elements’ values on the y-axis. The
time is controlled by the slider above the variable tree. To create a new Array Parametric Plot, press the New

Array Parametric Plot Window toolbar button ( ik ), then match the principle array node in the variable tree view
to be plotted on the x-axis and match the principle array node to be plotted on the y-axis.

Diagram Window

Shows the active ModelWidget as a read only diagram. You can only have one Diagram Window. To show it click

on Diagram Window toolbar button (Gﬁ).

2.15 Re-simulating a Model

The Variables Browser allows manipulation of changeable parameters for re-simulation. After changing the pa-

rameter values user can click on the re-simulate toolbar button (9), or right click the model in Variables Browser
and choose re-simulate from the menu.

2.16 3D Visualization

Since OpenModelica 1.11 , OMEdit has built-in 3D visualization, which replaces third-party libraries (such as
Modelica3D) for 3D visualization.

2.16.1 Running a Visualization

The 3d visualization is based on OpenSceneGraph. In order to run the visualization simply right click the class in
Libraries Browser an choose “Simulate with Animation” as shown in Figure 2.11.

One can also run the visualization via Simulation > Simulate with Animation from the menu.

When simulating a model in animation mode, the flag +d=visxml is set. Hence, the compiler will generate a
scene description file _visual.xml which stores all information on the multibody shapes. This scene description
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Figure 2.11: OMEdit Simulate with Animation.

references all variables which are needed for the animation of the multibody system. When simulating with
+d=visxml, the compiler will always generate results for these variables.

2.16.2 Viewing a Visualization

After the successful simulation of the model, the visualization window will show up automatically as shown in
Figure 2.12.

The animation starts with pushing the play button. The animation is played until stopTime or until the pause
button is pushed. By pushing the previous button, the animation jumps to the initial point of time. Points of time
can be selected by moving the time slider or by inserting a simulation time in the Time-box. The speed factor of
animation in relation to realtime can be set in the Speed-dialog. Other animations can be openend by using the
open file button and selecting a result file with a corresping scene description file.

The 3D camera view can be manipulated as follows:

Operation Key Mouse Action
Move Closer/Further none Wheel

Move Closer/Further Right Mouse Hold Up/Down
Move Up/Down/Left/Right | Middle Mouse Hold Move Mouse
Move Up/Down/Left/Right | Left and Right Mouse Hold | Move Mouse
Rotate Left Mouse Hold Move Mouse
Shape context menu Right Mouse + Shift

Predefined views (Isometric, Side, Front, Top) can be selected and the scene can be tilted by 90° either clock or
anticlockwise with the rotation buttons.
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Figure 2.12: OMEdit 3D Visualization.

2.16.3 Additional Visualization Features

The shapes that are displayed in the viewer can be selected with shift + right click. If a shape is selected, a context
menu pops up that offers additional visualization features

1 shape ' |€  Change Transparency
Reset Transparency and Texture [ Make Shape Invisible

&% Change Color

.. Apply Check Texture
&4 Apply Customn Texture

Remove Texure

The following features can be selected:
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Menu Description

Change Transparency | The shape becomes either transparent or intransparent.

Make Shape Invisible | The shape becomes invisible.

Change Color A color dialog pops up and the color of the shape can be set.

Apply Check Texture A checked texture is applied to the shape.

Apply Custom Texture | A file selection dialog pops up and an image file can be selected as a texture.
Remove Texture Removes the current texture of the shape.

2.17 Animation of Realtime FMUs

Instead of a result file, OMEdit can load Functional Mock-up Units to retrieve the data for the animation of
multibody systems. Just like opening a mat-file from the animation-plotting view, one can open an FMU-file.
Necessarily, the FMU has to be generated with the +d=visxml flag activated, so that a scene description file is
generated in the same directory as the FMU. Currently, only FMU 1.0 and FMU 2.0 model exchange are supported.
When choosing an FMU, the simulation settings window pops up to choose solver and step size. Afterwards, the
model initializes and can be simulated by pressing the play button.

2.17.1 Interactive Realtime Animation of FMUs
FMUs can be simulated with realtime user interaction. A possible solution is to equip the model with an inter-

action model from the Modelica_DeviceDrivers library (https://github.com/modelica/Modelica_DeviceDrivers).
The realtime synchronization is done by OMEdit so no additional time synchronization model is necessary.

2.18 Interactive Simulation

Warning: Interactive simulation is an experimental feature.

Interactive simulation is enabled by selecting interactive simulation in the General tab of the simulation setup.

There are two main modes of execution: asynchronous and synchronous (simulate with steps). The difference is
that in synchronous (step mode), OMEdit sends a command to the simulation for each step that the simulation
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should take. The asynchronous mode simply tells the simulation to run and samples variables values in real-time;
if the simulation runs very fast, fewer values will be sampled.

When running in asynchronous mode, it is possible to simulate the model in real-time (with a scaling factor just
like simulation flag -7, but with the ability to change the scaling factor during the interactive simulation). In the
synchronous mode, the speed of the simulation does not directly correspond to real-time.

2.19 How to Create User Defined Shapes — Icons

Users can create shapes of their own by using the shape creation tools available in OMEdit.

¢ Line Tool — Draws a line. A line is created with a minimum of two points. In order to create a line, the user
first selects the line tool from the toolbar and then click on the Icon/Diagram View; this will start creating a
line. If a user clicks again on the Icon/Diagram View a new line point is created. In order to finish the line
creation, user has to double click on the Icon/Diagram View.

* Polygon Tool — Draws a polygon. A polygon is created in a similar fashion as a line is created. The only
difference between a line and a polygon is that, if a polygon contains two points it will look like a line and
if a polygon contains more than two points it will become a closed polygon shape.

¢ Rectangle Tool — Draws a rectangle. The rectangle only contains two points where first point indicates the
starting point and the second point indicates the ending the point. In order to create rectangle, the user
has to select the rectangle tool from the toolbar and then click on the Icon/Diagram View, this click will
become the first point of rectangle. In order to finish the rectangle creation, the user has to click again on the
Icon/Diagram View where he/she wants to finish the rectangle. The second click will become the second
point of rectangle.

e Ellipse Tool — Draws an ellipse. The ellipse is created in a similar way as a rectangle is created.
* Text Tool — Draws a text label.
* Bitmap Tool — Draws a bitmap container.

The shape tools are located in the toolbar. See Figure 2.13.

( Rectangle Tool ) ( Text Tool >

N\

( Line Tool ) A—WOHOEN —»( Bitmap Tool)

/N

(¢ Polygon Tool ) ( Ellipse Tool )

Figure 2.13: User defined shapes.

The user can select any of the shape tools and start drawing on the Icon/Diagram View. The shapes created on the
Diagram View of Model Widget are part of the diagram and the shapes created on the Icon View will become the
icon representation of the model.

For example, if a user creates a model with name testModel and add a rectangle using the rectangle tool and a
polygon using the polygon tool, in the Icon View of the model. The model’s Modelica Text will appear as follows:
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model testModel

annotation (Icon (graphics = {Rectangle(rotation = 0, lineColor = {0,0,255},
—~fillColor = {0,0,255}, pattern = LinePattern.Solid, fillPattern = FillPattern.
—None, lineThickness = 0.25, extent = {{ -64.5,88},{63, —-22.5}}),Polygon (points =
—{{ -47.5, -29.5},{52.5, -29.5},{4.5, -86},{ -47.5, -29.5}}, rotation = 0,
—~lineColor = {0,0,255}, fillColor = {0,0,255}, pattern = LinePattern.Solid,
—~fillPattern = FillPattern.None, lineThickness = 0.25)1}));
end testModel;

In the above code snippet of testModel, the rectangle and a polygon are added to the icon annotation of the model.
Similarly, any user defined shape drawn on a Diagram View of the model will be added to the diagram annotation
of the model.

2.20 Global head section in documentation

If you want to use same styles or same JavaScript for the classes contained inside a package then you can de-
fine __OpenModelica_infoHeader annotation inside the Documentation annotation of a package. For
example,

package P
model M
annotation (Documentation (info="<html>
<a href=\"javascript:HelloWorld()\">Click here</a>
</html>"));
end M;
annotation (Documentation (__OpenModelica_infoHeader="
<script type=\"text/javascript\">
function HelloWorld() {
alert (\"Hello World!'\");
t
</script>"));
end P;

In the above example model M does not need to define the javascript function HelloWorld. It is only defined
once at the package level using the _ _OpenModelica_infoHeader and then all classes contained in the
package can use it.

In addition styles and JavaScript can be added from file locations using Modelica URIs. Example:

package P
model M
annotation (Documentation (info="<html>
<a href=\"javascript:HelloWorld()\">Click here</a>
</html>"));
end M;
annotation (Documentation (___OpenModelica_infoHeader="
<script type=\"text/javascript\">
src=\"modelica://P/Resources/hello. js\">
}
</script>"));
end P;

Where the file Resources/hello. js then contains:

function HelloWorld() {
alert ("Hello World!™);
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2.2

1 Options

OME(dit allows users to save several options which will be remembered across different sessions of OMEdit. The
Options Dialog can be used for reading and writing the options.

2.21.1 General

General

Language — Sets the application language.

Working Directory — Sets the application working directory. All files are generated in this directory.
Toolbar Icon Size — Sets the size for toolbar icons.

Preserve User’s GUI Customizations — If true then OMEdit will remember its windows and toolbars posi-
tions and sizes.

Terminal Command — Sets the terminal command. When user clicks on Tools > Open Terminal then this
command is executed.

Terminal Command Arguments — Sets the terminal command arguments.
Hide Variables Browser — Hides the variable browser when switching away from plotting perspective.

Activate Access Annotations — Activates the access annotations for the non-encrypted libraries. Access
annotations are always active for encrypted libraries.

Libraries Browser

Library Icon Size — Sets the size for library icons.

Show Protected Classes — If enabled then Libraries Browser will also list the protected classes.
Modeling View Mode

Tabbed View/SubWindow View — Sets the view mode for modeling.

Default View

Icon View/DiagramView/Modelica Text View/Documentation View — If no preferredView annotation is de-
fined then this setting is used to show the respective view when user double clicks on the class in the
Libraries Browser.

Enable Auto Save

Auto Save interval — Sets the auto save interval value. The minimum possible interval value is 60 seconds.
Enable Auto Save for single classes — Enables the auto save for one class saved in one file.

Enable Auto Save for one file packages — Enables the auto save for packages saved in one file.

Welcome Page

Horizontal View/Vertical View — Sets the view mode for welcome page.

Show Latest News — if true then displays the latest news.

2.21.2 Libraries

System Libraries — The list of system libraries that should be loaded every time OMEdit starts.

Force loading of Modelica Standard Library — If true then Modelica and ModelicaReference will always
load even if user has removed them from the list of system libraries.

Load OpenModelica library on startup — If true then OpenModelica package will be loaded when OMEdit
is started.

User Libraries — The list of user libraries/files that should be loaded every time OMEdit starts.
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2.21.3 Text Editor

* Format
* Line Ending - Sets the file line ending.
* Byte Order Mark (BOM) - Sets the file BOM.
* Tabs and Indentation
 Tab Policy — Sets the tab policy to either spaces or tabs only.
* Tab Size — Sets the tab size.
e Indent Size — Sets the indent size.
¢ Syntax Highlight and Text Wrapping
* Enable Syntax Highlighting — Enable/Disable the syntax highlighting.

* Enable Code Folding - Enable/Disable the code folding. When code folding is enabled multi-
line annotations are collapsed into a compact icon (a rectangle containing "...)"). A marker
containing a "+" sign becomes available at the left-side of the involved line, allowing the code
to be expanded/re-collapsed at will.

* Match Parentheses within Comments and Quotes — Enable/Disable the matching of parentheses
within comments and quotes.

» Enable Line Wrapping — Enable/Disable the line wrapping.
* Autocomplete
* Enable Autocomplete — Enable/Disable the autocomplete.
» Font
 Font Family — Shows the names list of available fonts. Sets the font for the editor.

e Font Size — Sets the font size for the editor.

2.21.4 Modelica Editor

e Preserve Text Indentation — If true then uses diffModelicaFileListings API call otherwise uses the OMC
pretty-printing.

* Colors
* Jtems — List of categories used of syntax highlighting the code.
* Item Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.21.5 MetaModelica Editor

* Colors
* Jtems — List of categories used of syntax highlighting the code.
* Item Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.21.6 CompositeModel Editor

* Colors
* Jtems — List of categories used of syntax highlighting the code.

e Item Color — Sets the color for the selected item.
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* Preview — Shows the demo of the syntax highlighting.

2.21.7 C/C++ Editor

* Colors
* Jtems — List of categories used of syntax highlighting the code.
e [tem Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.21.8 Graphical Views

* Extent

* Left — Defines the left extent point for the view.

* Bottom — Defines the bottom extent point for the view.

* Right — Defines the right extent point for the view.

* Top — Defines the top extent point for the view.

e Grid

* Horizontal — Defines the horizontal size of the view grid.

¢ Vertical — Defines the vertical size of the view grid.

e Component

* Scale factor — Defines the initial scale factor for the component dragged on the view.

* Preserve aspect ratio — If true then the component’s aspect ratio is preserved while scaling.

2.21.9 Simulation

¢ Simulation
¢ Translation Flags
* Matching Algorithm — sets the matching algorithm for simulation.
* Index Reduction Method — sets the index reduction method for simulation.

* Show additional information from the initialization process - prints the information from the
initialization process

e Evaluate all parameters (faster simulation, cannot change them at runtime) - makes the simu-
lation more efficient but you have to recompile the model if you want to change the parameter
instead of re-simulate.

* Enable analytical jacobian for non-linear strong components - enables analytical jacobian for
non-linear strong components without user-defined function calls.

* Enable pedantic debug-mode, to get much more feedback

e Enable parallelization of independent systems of equations (Experimental)

* Enable experimental new instantiation phase

* Additional Translation Flags — sets the translation flags see Options

e Target Language — sets the target language in which the code is generated.

» Target Build — sets the target build that is used to compile the generated code.
* C Compiler — sets the C compiler for compiling the generated code.

o CXX Compiler — sets the CXX compiler for compiling the generated code.
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e Ignore __OpenModelica_commandLineOptions annotation — if true then ignores the __Open-
Modelica_commandLineOptions annotation while running the simulation.

» Ignore __OpenModelica_simulationFlags annotation — if true then ignores the __OpenModel-
ica_simulationFlags annotation while running the simulation.

* Save class before simulation — if true then always saves the class before running the simulation.

* Switch to plotting perspective after simulation — if true then GUI always switches to plotting
perspective after the simulation.

e Close completed simulation output windows before simulation — if true then the completed sim-
ulation output windows are closed before starting a new simulation.

* Delete intermediate compilation files — if true then the files generated during the compilation
are deleted automatically.

* Delete entire simulation directory of the model when OMEdit is closed — if true then the entire
simulation directory is deleted on quit.

e Qutput
* Structured — Shows the simulation output in the form of tree structure.

o Formatted Text — Shows the simulation output in the form of formatted text.

2.21.10 Messages

General

Output Size - Specifies the maximum number of rows the Messages Browser may have. If there are more
rows then the rows are removed from the beginning.

Reset messages number before simulation — Resets the messages counter before starting the simulation.
Font and Colors

Font Family — Sets the font for the messages.

Font Size — Sets the font size for the messages.

Notification Color — Sets the text color for notification messages.

Warning Color — Sets the text color for warning messages.

Error Color — Sets the text color for error messages.

2.21.11 Notifications

Notifications
Always quit without prompt — If true then OMEdit will quit without prompting the user.

Show item dropped on itself message — If true then a message will pop-up when a class is dragged and
dropped on itself.

Show model is defined as partial and component will be added as replaceable message — If true then a
message will pop-up when a partial class is added to another class.

Show component is declared as inner message — If true then a message will pop-up when an inner component
is added to another class.

Show save model for bitmap insertion message — If true then a message will pop-up when user tries to insert
a bitmap from a local directory to an unsaved class.

Always ask for the dragged component name — If true then a message will pop-up when user drag & drop
the component on the graphical view.

Always ask for what to do with the text editor error — If true then a message will always pop-up when there
is an error in the text editor.
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2.21.12 Line Style

* Line Style

e Color — Sets the line color.

* Pattern — Sets the line pattern.

 Thickness — Sets the line thickness.

 Start Arrow — Sets the line start arrow.

e End Arrow — Sets the line end arrow.

* Arrow Size — Sets the start and end arrow size.

e Smooth — If true then the line is drawn as a Bezier curve.

2.21.13 Fill Style

Fill Style
e Color — Sets the fill color.

e Pattern — Sets the fill pattern.

2.21.14 Plotting

* General
* Auto Scale — sets whether to auto scale the plots or not.
¢ Plotting View Mode
 Tabbed View/SubWindow View — Sets the view mode for plotting.
e Curve Style
* Pattern — Sets the curve pattern.
 Thickness — Sets the curve thickness.
Variable filter

e Filter Interval - Delay in filtering the variables. Set the value to 0 if you don’t want any delay.

2.21.15 Figaro

* Figaro
e Figaro Library — the Figaro library file path.
 Tree generation options — the Figaro tree generation options file path.

* Figaro Processor — the Figaro processor location.

2.21.16 Debugger

* Algorithmic Debugger

* GDB Path — the gnu debugger path

e GDB Command Timeout — timeout for gdb commands.

* GDB Output Limit — limits the GDB output to N characters.
¢ Display C frames — if true then shows the C stack frames.

* Display unknown frames — if true then shows the unknown stack frames. Unknown stack frames means
frames whose file path is unknown.
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* Clear old output on a new run — if true then clears the output window on new run.

Clear old log on new run — if true then clears the log window on new run.
 Transformational Debugger

* Always show Transformational Debugger after compilation — if true then always open the Transformational
Debugger window after model compilation.

* Generate operations in the info xml — if true then adds the operations information in the info xml file.

2.21.17 FMI

* Export
e Version
e 1.0 — Sets the FMI export version to 1.0
e 2.0 — Sets the FMI export version to 2.0
* Type
* Model Exchange — Sets the FMI export type to Model Exchange.
e Co-Simulation — Sets the FMI export type to Co-Simulation.

Model Exchange and Co-Simulation — Sets the FMI export type to Model Exchange and Co-
Simulation.

e FMU Name — Sets a prefix for generated FMU file.
¢ Platforms - list of platforms to generate FMU binaries.
e Import

* Delete FMU directory and generated model when OMEdit is closed - If true then the temporary FMU
directory that is created for importing the FMU will be deleted.

2.21.18 OMTLMSimulator

* General
* Path - path to OMTLMSimulator bin directory.
* Manager Process - path to OMTLMSimulator managar process.

* Monitor Process - path to OMTLMSimulator monitor process.

2.21.19 OMSimulator

* General
* Working Directory - working directory for OMSimulator files.
* Logging Level - OMSimulator logging level.

2.22 _ OpenModelica_commandLineOptions Annotation

OpenModelica specific annotation to define the command line options needed to simulate the model. For example
if you always want to simulate the model with a specific matching algorithm and index reduction method instead
of the default ones then you can write the following code,
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model Test

annotation (___OpenModelica_commandLineOptions = "--matchingAlgorithm=BFSB —-
—indexReductionMethod=dynamicStateSelection");
end Test;

The annotation is a space separated list of options where each option is either just a command line flag or a flag
with a value.

In OMEdit open the Simulation Setup and set the Translation Flags then in the bottom check Save translation
flags inside model i.e., __OpenModelica_commandLineOptions annotation and click on OK.

It you want to ignore this annotation then use setCommandLineOptions("—
ignoreCommandLineOptionsAnnotation=true"). In OMEdit Tools > Options > Simulation check Ignore
__OpenMaodelica_commandLineOptions annotation.

2.23 _ OpenModelica_simulationFlags Annotation

OpenModelica specific annotation to define the simulation options needed to simulate the model. For example if
you always want to simulate the model with a specific solver instead of the default DASSL and would also like to
see the cpu time then you can write the following code,

model Test
annotation (___OpenModelica_simulationFlags (s = "heun", cpu = "()"));
end Test;

The annotation is a comma separated list of options where each option is a simulation flag with a value. For flags
that doesn’t have any value use () (See the above code example).

In OMEdit open the Simulation Setup and set the Simulation Flags then in the bottom check Save simulation flags
inside model i.e., __OpenModelica_simulationFlags annotation and click on OK.

If you want to ignore this annotation then use setCommandLineOptions("-
ignoreSimulationFlagsAnnotation=true"). In OMEdit Tools > Options > Simulation check Ignore __OpenMod-
elica_simulationFlags annotation.

2.24 Debugger

For debugging capability, see Debugging.

2.25 Editing Modelica Standard Library

By default OMEdit loads the Modelica Standard Library (MSL) as a system library. System libraries are read-
only. If you want to edit MSL you need to load it as user library instead of system library. We don’t recommend
editing MSL but if you really need to and understand the consequences then follow these steps,

e Go to Tools > Options > Libraries.

* Remove Modelica & ModelicaReference from list of system libraries.

e Uncheck force loading of Modelica Standard Library.

Add SOPENMODELICAHOME/lib/omlibrary/Modelica X.X/package.mo under user libraries.
* Restart OMEdit.
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2.26 State Machines

2.26.1 Creating a New Modelica State Class

Follow the same steps as defined in Creating a New Modelica Class. Additionally make sure you check the State
checkbox.

o't OMEdit - Create New Modelica Class ? pd
Mame: Statel

Spedialization: Model A
Extends (optional): Browse...
Insert in class (optional): Browse...

[ ] Partial

[ ] Encapsulated
State

Ok Cancel

Figure 2.14: Creating a new Modelica state.

2.26.2 Making Transitions

3
In order to make a transition from one state to another the user first needs to enable the transition mode (—) from
the toolbar.

Move the mouse over the state. The mouse cursor will change from arrow cursor to cross cursor. To start the
transition press left button and move while keeping the button pressed. Now release the left button. Move towards
the end state and click when cursor changes to cross cursor.

A Create Transition dialog box will appear which allows you to set the transition attributes. Cancelling the dialog
will cancel the transition.

Double click the transition or right click and choose Edit Transition to modify the transition attributes.

2.26.3 State Machine Simulation

Support for Modelica state machines was added in the Modelica Language Specification v3.3. A subtle problem
can occur if Modelica v3.2 libraries are loaded, e.g., the Modelica Standard Library v3.2.2, because in this case
OMC automatically switches into Modelica v3.2 compatibility mode. Trying to simulate a state machine in
Modelica v3.2 compatibility mode results in an error. It is possible to use the OMC flag —std=latest in order to
ensure (at least) Modelica v3.3 support. In OMEdit this can be achieved by setting that flag in the Tools > Options
> Simulation dialog.
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OMEdit - Options

El General Simulation
& Libraries
E Text Editor Matching Algorithm: PFPlusExt >

Index Reduction Method: | dynamicStateSelection ~

CompositeModel Editor Target Language: C e

C/C++ Editor

Target Compiler: gec ~
B+ editor
ﬂ-"i Graphical Views OMC Flags: —std=latest | KA
Simulation : . . .
|:| Ignore __OpenModelica_commandLineQptions annotation
‘Eq Messages
7 I [ 1gnore __0OpenModelica_simulationFlags annotation
ﬂ Motifications W hd
* The changes will take effect after restart. OK Cancel

Figure 2.15: Ensure (at least) Modelica v3.3 support.

2.27 Using OMEdit as Text Editor

OMEdit can be be used as a Text editor. Currently support for editing MetaModelica,Modelica and C/C++ are
available with syntax highlighting and autocompletion of keywords and types. Additionaly the Modelica and
MetaModelica files are provided with autocompletion of code-snippets along with keywords and types. The users
can load the directory from file menu File > Open Directory. which opens the Directory structure in the Libraries-
browser.

After the directory is opened in the Libraries-browser, the users can expand the directory structure and click the
file which opens in the texteditor.

2.27.1 Advanced Search

Support to search in OMEdit texteditor is available. The search browser can be enabled by selecting View >
Windows > Search browser or through shortcut keys (ctrl+h).

The users can start the search by loading the directory they want to search and fill in the text to be searched for
and file pattern if needed and click the search button.

After the search is completed the results are presented to the users in a separate window, The search results contains
the following

1) The name of the files where the searched word is matched
2) The line number and text of the matched word.

The users can click the line number or the matched text and it will automatically open the file in the texteditor and
move the cursor to matched line number of the text.

The users can perform multiple searches and go back to old search results using search histroy option.
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ai OMEdit - OpenModelica Connection Editor

File Edit WView Simulation Debug OMSimulator Git Tools Help

} New Modelica Class Ctrl+N
& Open Model/Library File(s) Ctrl+0
Open/Convert Modelica File(s) With Encoding . . . .
e, OMEdit - OpenModelica Connection Editor
Load Encrypted Library
Open Result File(s) Ctrl+Shift+O
Open Transformations File :ent F|Ies Latest NeWS
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Figure 2.16: open-directory
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Figure 2.17: openfile in texteditor
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o OMEdt - OpenModelica Connection Editor - O X
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Figure 2.18: Enable omedit search browser
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Figure 2.19: Start search in search browser
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Figure 2.20: Search Results
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g& OMEdit - OpenModelica Connection Editor

File Edit View Simulation

] X

FMI  Export Debug OMSimulator Git Tools Help

rE@Eoeee \oHOTHE <= E- 99E > - &- 7~ ¥~

Libraries Browser X A BackendDump.mo (] o%  Bsackendbump.interface.mo [X]
Filter Classes T | Writable |C:fDPENMDDEL'IEAG]'I',poenModelicafDMCompiler,fCompiler,fbaot,,’buildjliackendﬂump.interface.rno ‘ = ‘
Libraries - input String heading: ~
ﬂ OpenModelica end dumpBackendDAE;
Bﬂ Modeli...erence . .
FI) Modeii..rvices furllctlon dumpBackendDP;EToModel}ca
@ Complex input BackendDAE.BackendDAE inBackendDAE;
1P% Model input String suffix;
oaelica end dumpBackendDAEToModelica;
El OMCompiler
3rdParty function SisiHeERERR=S
common input BackendDAE.EgSystem inEqSystem;
[=] © compiler input String heading;
[=] © Backend end dumpEgSystem:
o4& Adj..mo v
d& Bac..mo Search Browser 8 x
Bac...mo
L} N — - -
ﬁ& Bac...mo L% G G History: |Project-OMCompiler: dumpEqSystem |
ﬁ& Bac...mo Searched 557 of 1160 Pr‘cqect-:)l'dComp\er' dumpBackendDAET oModelica 14 FOUND
ﬂ.& Bac...mo Froject-OMCompiler: dumpEqSystem
d& Bac...mo
6& Bac...mo EEI C:/OPENMODELICAGIT/OpenModelica/OMCompiler/Compiler/boot/build/BackendDump.interface.mo ~
Bac...mo EE| C./OPENMODELICAGIT/OpenModelica/OMCompiler/Compiler/BackEnd/SynchronousFeatures.mo
d& Bac...mo Ezl C:/OPENMODELICAGIT/OpenModelica/OMCompiler/Compiler/BackEnd/Resolveloops.ma
ﬁ& Bac...mo |:-| C:/OPENMODELICAGIT/OpenModelica/OMCompiler/Compiler/BackEnd/OnRelaxation.mo ©
ﬁ& Bac..mo v | Messages Browser Search Browser

& Plotting & Debugging

Ln: 158, Col: 23 tWe\come a& Modeling

Figure 2.21: Search History

2.27. Using OMEdit as Text Editor
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CHAPTER
THREE

2D PLOTTING

This chapter covers the 2D plotting available in OpenModelica via OMNotebook, OMShell and command line
script. The plotting is based on OMPIlot application.

3.1 Example

class HelloWorld

Real x(start = 1, fixed = true);
parameter Real a = 1;

equation
der (x) = — a * x;

end HelloWorld;

To create a simple time plot the above model HelloWorld is simulated. To reduce the amount of simulation data in
this example the number of intervals is limited with the argument numberOflIntervals=5. The simulation is started
with the command below.

>>> simulate (HelloWorld, outputFormat="csv", startTime=0, stopTime=4, |
—numberOfIntervals=5)
record SimulationResult

resultFile = "«DOCHOME»/HelloWorld_res.csv",

simulationOptions = "startTime = 0.0, stopTime = 4.0, numberOfIntervals = 5, |,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'HelloWorld', options = '',
— outputFormat = 'csv', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.004646534,
timeBackend = 0.009754054,
timeSimCode = 0.000556566,
timeTemplates = 0.002683094,
timeCompile = 0.358094135,
timeSimulation = 0.011783864,
timeTotal = 0.387644838

end SimulationResult;

When the simulation is finished the file HelloWorld_res.csv contains the simulation data:

Listing 3.1: HelloWorld_res.csv

"time", "X", "der(x) n

0,1,-1
0.8,0.4493289092712475,-0.4493289092712475
1.6,0.2018973974273906,-0.2018973974273906
2.4,0.09071896372718975,-0.09071896372718975
3.2,0.04076293845066793,-0.04076293845066793

(continues on next page)
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(continued from previous page)

4,0.01831609502171534,-0.01831609502171534
4,0.01831609502171534,-0.01831609502171534

Diagrams are now created with the new OMPlot program by using the following plot command:

0.8

0.6

04
03
0.2

0.1

0 1 1 1 1 1
0 0.5 1 1.5 2 2.5

Figure 3.1: Simple 2D plot of the HelloWorld example.

By re-simulating and saving results at many more points, for example using the default 500 intervals, a much
smoother plot can be obtained. Note that the default solver method dassl has more internal points than the output
points in the initial plot. The results are identical, except the detailed plot has a smoother curve.

>>> (O==system("./HelloWorld -override stepSize=0.008")
true

>>> res:=strtok (readFile ("HelloWorld res.csv"), "\n");
>>> res[end]
"4,0.01831609502171534,-0.01831609502171534"

0.8

0.6

0.4

03

0.1

Figure 3.2: Simple 2D plot of the HelloWorld example with a larger number of output points.
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3.2 Plot Command Interface

Plot command have a number of optional arguments to further customize the the resulting diagram.

>>> list (OpenModelica.Scripting.plot, interfaceOnly=true)
"function plot
input VariableNames vars \"The variables you want to plot\";
input Boolean externalWindow = false \"Opens the plot in a new plot window\";
input String fileName = \"<default>\" \"The filename containing the variables.
—<default> will read the last simulation result\";
input String title = \"\" \"This text will be used as the diagram title.\";

input String grid = \"detailed\" \"Sets the grid for the plot i.e simple,
—detailed, none.\";

input Boolean logX = false \"Determines whether or not the horizontal axis is_
—logarithmically scaled.\";
input Boolean logY = false \"Determines whether or not the vertical axis is_

—logarithmically scaled.\";

input String xLabel = \"time\" \"This text will be used as the horizontal label_
—in the diagram.\";

input String yLabel = \"\" \"This text will be used as the vertical label in the_
—~diagram.\";

input Real xRange[2]

{0.0, 0.0} \"Determines the horizontal interval that is_
—visible in the diagram. {0,0} will select a suitable range.\";

input Real yRange[2] = {0.0, 0.0} \"Determines the vertical interval that is,,
—visible in the diagram. {0,0} will select a suitable range.\";

input Real curveWidth = 1.0 \"Sets the width of the curve.\";

input Integer curveStyle = 1 \"Sets the style of the curve. SolidLine=1,
—DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.\";

input String legendPosition = \"top\" \"Sets the POSITION of the legend i.e left,
— right, top, bottom, none.\";

input String footer = \"\" \"This text will be used as the diagram footer.\";

input Boolean autoScale = true \"Use auto scale while plotting.\";

input Boolean forceOMPlot = false \"if true launches OMPlot and doesn't call
—callback function even if it is defined.\";

output Boolean success \"Returns true on success\";
end plot;"

3.2. Plot Command Interface 69
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CHAPTER
FOUR

SOLVING MODELICA MODELS

4.1 Integration Methods

By default OpenModelica transforms a Modelica model into an ODE representation to perform a simulation by
using numerical integration methods. This section contains additional information about the different integration
methods in OpenModelica. They can be selected by the method parameter of the simulate command or the -s

simflag.
The different methods are also called solver and can be distinguished by their characteristic:
* explicit vs. implicit
* order
* step size control
* multi step

A good introduction on this topic may be found in [CK06] and a more mathematical approach can be found in
[HNorsettW93].

4.1.1 DASSL

DASSL is the default solver in OpenModelica, because of a severals reasons. It is an implicit, higher order,
multi-step solver with a step-size control and with these properties it is quite stable for a wide range of models.
Furthermore it has a mature source code, which was originally developed in the eighties an initial description may
be found in [Pet82].

This solver is based on backward differentiation formula (BDF), which is a family of implicit methods for numer-
ical integration. The used implementation is called DASPK?2.0 (see”) and it is translated automatically to C by f2c
(see?).

The following simulation flags can be used to adjust the behavior of the solver for specific simulation problems:
Jjacobian, noRootFinding, noRestart, initialStepSize, maxStepSize, maxIntegrationOrder, noEquidistantTimeGrid.

4.1.2 IDA

The IDA solver is part of a software family called sundials: SUite of Nonlinear and DIfferential/ALgebraic equa-
tion Solvers [HBG+05]. The implementation is based on DASPK with an extended linear solver interface, which
includes an interface to the high performance sparse linear solver KLU [DN10].

The simulation flags of DASSL are also valid for the IDA solver and furthermore it has the following IDA specific
flags: idaLsS, idaMaxNonLinlters, idaMaxConvFails, idaNonLinConvCoef, idaMaxErrorTestFails.

2 DASPK Webpage
3 Cdaskr source
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4.1.3 Basic Explicit Solvers

The basic explicit solvers are performing with a fixed step-size and differ only in the integration order. The
step-size is based on the numberOflntervals, the startTime and stopTime parameters in the simulate command:
stopTime — startTime

tepSize ~
siepstze numberOflntervals
e culer - order 1
¢ heun - order 2

* rungekutta - order 4

4.1.4 Basic Implicit Solvers

The basic implicit solvers are all based on the non-linear solver KINSOL from the SUNDIALS suite. The un-
derlining linear solver can be modified with the simflag -impRKLS. The step-size is determined as for the basic
explicit solvers.

* impeuler - order 1
e trapezoid - order 2

» imprungekutta - Based on Radau IIA and Lobatto IIIA defined by its Butcher tableau where the order can
be adjusted by -impRKorder.

4.1.5 Experimental Solvers

The following solvers are marked as experimental, mostly because they are till now not tested very well.
* rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step-size control, order 4-5
¢ irksco - Own developed Runge-Kutta solver - implicit, step-size control, order 1-2
* symSolver - Symbolic inline solver (requires —symSolver) - fixed step-size, order 1

* symSolverSsc - Symbolic implicit inline Euler with step-size control (requires —symSolver) - step-size con-
trol, order 1-2

e gss - A QSS solver

4.2 DAE Mode Simulation

Beside the default ODE simulation, OpenModelica is able to simulate models in DAE mode. The DAE mode is
enabled by the flag —~daeMode. In general the whole equation system of a model is passed to the DAE integrator,
including all algebraic loops. This reduces the amount of work that needs to be done in the post optimization
phase of the OpenModelica backend. Thus models with large algebraic loops might compile faster in DAE mode.

Once a model is compiled in DAE mode the simulation can be only performed with SUNDIALS/IDA integrator
and with enabled -daeMode simulation flag. Both are enabled automatically by default, when a simulation run is
started.

4.2.1 References
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CHAPTER
FIVE

DEBUGGING

There are two main ways to debug Modelica code, the transformations browser, which shows the transformations
OpenModelica performs on the equations. There is also a debugger for debugging of algorithm sections and
functions.

5.1 The Equation-based Debugger

This section gives a short description how to get started using the equation-based debugger in OMEdit.

5.1.1 Enable Tracing Symbolic Transformations

This enables tracing symbolic transformations of equations. It is optional but strongly recommended in order to
fully use the debugger. The compilation time overhead from having this tracing on is less than 1%, however, in
addition to that, some time is needed for the system to write the xml file containing the transformation tracing
information.

Enable -d=infoXmlOperations in Tools->Options->Simulation (see section Simulation) OR alternatively click on
the checkbox Generate operations in the info xml in Tools->Options->Debugger (see section Debugger) which
performs the same thing.

This adds all the transformations performed by OpenModelica on the equations and variables stored in the
model_info.xml file. This is necessary for the debugger to be able to show the whole path from the source
equation(s) to the position of the bug.

5.1.2 Load a Model to Debug

Load an interesting model. We will use the package Debugging.mo since it contains suitable, broken models to
demonstrate common errors.

5.1.3 Simulate and Start the Debugger

Select and simulate the model as usual. For example, if using the Debugging package, select the model Debug-
ging.Chattering.ChatteringEvents1. If there is an error, you will get a clickable link that starts the debugger. If the
user interface is unresponsive or the running simulation uses too much processing power, click cancel simulation
first.

5.1.4 Use the Transformation Debugger for Browsing

Use the transformation debugger. It opens on the equation where the error was found. You can browse through
the dependencies (variables that are defined by the equation, or the equation is dependent on), and similar for
variables. The equations and variables form a bipartite graph that you can walk.
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Running Simulation of Debugging.C hattering.C hatteringEvents1.
Please wait for a while.

IRNRNRNNNNNNNNNNRNEE

Cancel Simulation

™ OMEdit - Debugging.Chattering.ChatteringEvents1 Simulation Output - 0O &

Output Compilation ]

Jtop/OpenModel ica /OMEd] ¢ /Debugging . Chattering . ChatteringEventsl -

port=50212 -logFormat=xml -w -1wv=LOG_ STATS
stdout | info | Chattering detected arcund time

0.500000005..0.500000995001 (100 state events in a row with a total time
delta less than the step size 0.002). This can be a performance
bottleneck. Use -1v LOG EVENTS for more information. The zZero-crossing

was: 2 > 0.0 D;e%g more

Figure 5.1: Simulating the model.
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If the -d=infoXmlOperations was used or you clicked the “generate operations” button, the operations performed
on the equations and variables can be viewed. In the example package, there are not a lot of operations because
the models are small.

Try some larger models, e.g. in the MultiBody library or some other library, to see more operations with several
transformation steps between different versions of the relevant equation(s). If you do not trigger any errors in a
model, you can still open the debugger, using File->Open Transformations File (model_info.json).

OMEdit - Transformational Debugger

& | /tmp/OpenModelica_marsj/OMEdit/Debugging.Chattering.ChatteringEvents1_infoxml

Variables | [source Browser |
Variables Browser | [Defined In Equations | [used In Equations | /nome/marsj/trunk/testsuite/openmodelica,

Find Variables |linc* Type  Equation Inc * Type  Equation 1 within ; =
] Casesensitive | Regular Expression |:2 initial  (assignmen...0 else 1.0 |:3 initial  (assignment)y=2.0%z 2 package Debugging "Test

A A cases for debugging of
Expand All Collapse All 5 regular (assignmen...0 else 1.0 6 regular (assignment)y=2.0%z declarative models”

Variables v Comment Line Location

package Chattering "Models
X 7 /hom...q. with chattering behaviour®
v 8 /hom...g. 5 model ChatteringEventsl
6 "Exhibits chattering
= SEEMom=—q; after t = 0.5, with
[Variable Operations | generated events”
: 7 Real x(start=1,
Operations fixed=true):
8 Real y;

g Real z;
16 equation
11 z = if x > @ then -1
else 1;

12 y = 2%z;

13 der(x) = y;
( ) r 14 annotation
Equations | (Documentation(info="<html>
| 15 <p=After t = 0.5, chattering

takes place, due to the

Inc * Type  Equation Variable = | Variable v discontinuity in the right
initial  (assignment) x=1.0 z Ly hand side of the first

-, ’ equation.</p>
initial  (assignment....0 else 1.0 16 <p>Chattering can be

initial  (assignment) y=2.0*z detected because lots of
initial  (assignment) der(x) =y tightly spaced events are

: generated. The feedback to
=g s om=n Sl =R the user should allow to

regular (assignment) y=2.0*z identify the equation from
regular (assignment) der(x) =y = = which the zero crossing
[Equation Operations | function that generates the
Operations events originates.</p>

solved: z=if x > 0.0 then-1.0 else 1.0 17 </html>"),

experiment(StopTime=1});
original: z = if x > 0 then -1 else 1; => flattened: z = if x > 0.0 then -1.0 else 1.0; 18 end ChatteringEventsi;

Equations Browser |[Defines | [Depends

1
2
3
4
5
6
7

28 medel ChatteringEvents2

21 "Exhibits chattering
after t = 0.422, with
nenerated events” -

Figure 5.2: Transfomations Browser.

5.2 The Algorithmic Debugger

This section gives a short description how to get started using the algorithmic debugger in OMEdit. See section
Simulation for further details of debugger options.

5.2.1 Adding Breakpoints

There are two ways to add the breakpoints,

¢ Click directly on the line number in Text View, a red circle is created indicating a breakpoint as shown in
Figure 5.3.

* Open the Algorithmic Debugger window and add a breakpoint using the right click menu of Breakpoints
Browser window.
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di OMEdit - OpenModelica Connection Editor - [SimulationModel]

] S |

Efile Edit  View Simulation FMI Export Tools Help

e H

Libraries Browser

#00 BQAaQ WemeBN( EQ9»se5| B-'9 X »

BEIE

Libraries

. Complex
7% Madelica
i ]
: MuodelicaServices
[E OpenModelica
t@ SimulationModel

getValueMultipliedBy Two

ModelicaReference

g x |ll'l d@ﬂ |Wriheable |Mode1 ‘ Text View ‘ C:fUsersfadeas31/.. imulationModel.mo ‘ Line: 1, Col: 0 | E‘

1

(I O Y P ]

model SimulationModel
Eeal x(start = 1);
Eeal y(start = 1);
algorithm
x = getValuseMultiplisedByTIwo (X) !
¥ 1= X}

end SimulationModel:

X:-96.28

i 100.83

Figure 5.3: Adding breakpoint in Text View.
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5.2.2 Start the Algorithmic Debugger

You should add breakpoints before starting the debugger because sometimes the simulation finishes quickly and
you won’t get any chance to add the breakpoints.

There are four ways to start the debugger,
* Open the Simulation Setup and click on Launch Algorithmic Debugger before pressing Simulate.
* Right click the model in Libraries Browser and select Simulate with Algorithmic Debugger.
* Open the Algorithmic Debugger window and from menu select Debug-> Debug Configurations.

* Open the Algorithmic Debugger window and from menu select Debug-> Artach to Running Process.

5.2.3 Debug Configurations
If you already have a simulation executable with debugging symbols outside of OMEdit then you can use the
Debug->Debug Configurations option to load it.

The debugger also supports MetaModelica data structures so one can debug omc executable. Select omc exe-
cutable as program and write the name of the mos script file in Arguments.

- )
@& OMEdit - Debug Cenfigurations ﬂ
bk,

& New_configurationl Mame: |New_-:nnﬁguratinn1 |

Program: || || Browse...
Working Directory: | | | Browse...

GOE Path: |C:,.’DMDEV,.’touIS,.’mingw,.'hin,.’gdb.E}(E || Browse...
Arguments:

[ Apply ][ Reset ]

Save ] [Saue &Debug] [ Cancel ]

Figure 5.4: Debug Configurations.
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5.2.4 Attach to Running Process

If you already have a running simulation executable with debugging symbols outside of OMEdit then you can
use the Debug->Attach to Running Process option to attach the debugger with it. Figure 5.5 shows the Attach
to Running Process dialog. The dialog shows the list of processes running on the machine. The user selects the
program that he/she wish to debug. OMEdit debugger attaches to the process.

| @& OMEdit - Attach to Running Process ﬁ1
Attach to Process ID: |
| Filter Processes |
Process ID MNarne . *
9760 AAM Updates Notifier.exe |—|
| | 2164 AESTS64.exe
2288 AppleMobileDevicebervice.exe
3896 ETStackServerexe
1612 ETTray.exe
7696 BluetoothHeadsetProxy.exe
7972 CCC.exe
J580 C55.55erviceManager.exe
bb28 CamRecorder.exe
4960 CcmExec.exe
588 CmRcService.exe
628 Conversionservice.exe
1744 rorreidor o
oK, Refresh ] [ Cancel

Figure 5.5: Attach to Running Process.

5.2.5 Using the Algorithmic Debugger Window

Figure 5.6 shows the Algorithmic Debugger window. The window contains the following browsers,

* Stack Frames Browser — shows the list of frames. It contains the program context buttons like resume,
interrupt, exit, step over, step in, step return. It also contains a threads drop down which allows switching
between different threads.

* BreakPoints Browser — shows the list of breakpoints. Allows adding/editing/removing breakpoints.

* Locals Browser — Shows the list of local variables with values. Select the variable and the value will be
shown in the bottom right window. This is just for convenience because some variables might have long
values.

* Debugger CLI — shows the commands sent to gdb and their responses. This is for advanced users who want
to have more control of the debugger. It allows sending commands to gdb.

* Output Browser — shows the output of the debugged executable.
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&% OMEdit - OpenModelica Connection Editor - [getValueMultipliedByTwo]

- O *
B File Edit View Simulation Debug OMSimulator Git Tools Help - & x

[ (o N — - 9 "

Bd 1=1" Heee \PHOTE <= E-99H 9% - &-
Libraries Browser & X Stack Frames Browser & X | BreakPoints Browser & X Locals Browser & X
A4 [ ] |'b§ = = |Theads: 1 - |Stn__.d1 Line File Name Type Value

L] C:/Users/ade...liedByTwo.mo inValue Real 0
L ) ) ) o
Libraries Function lne  |Fe outValue  Real 4.94065...5
SimulationModel E> getValueMultipliedByTwe 5 C/Use.. Two
i i ion 2 90 < fls v
getValueM..liedByTwo . SimulationM...aFunction 2 90 C: U_er...l‘v'1)c:
|I'I o& E o |Wr1'tzble |chhon |Text\ﬁew |get\|’abe|'“utbiecByTwo C:Nsersfa...ecﬂyTwo.mc| h|
1 function getValusMultipliedByTwo
2 input Real inValue;
3 output EReal outValue;
algorithm
® s outValue := inValue * 2;
& end getValusMultipliedByTwo;
£ >
0
Messages Browser & X OutputBrowser 5 X
All Motifications Warnings Errors
Debugger CLI Qutput Browser
Ln: 5, Col: 0 t Welcome oﬁ Modeling B Flotting ‘ Debugging

Figure 5.6: Algorithmic Debugger.
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CHAPTER
SIX

GENERATING GRAPH REPRESENTATIONS FOR MODELS

The system of equations after symbolic transformation is represented by a graph. OpenModelica can generate
graph representations which can be displayed in the graph tool yed (http://www.yworks.com/products/yed). The
graph generation is activated with the debug flag

+d=graphml

Two different graphml- files are generated in the working directory. TaskGraph_model.graphml, showing the
strongly-connected components of the model and BipartiteGraph_CompleteDAE_model.graphml showing all
variables and equations. When loading the graphs with yEd, all nodes are in one place. Please use the various
layout algorithms to get a better overview.

¥ TaskGraph_Modelica.Electrical.Spice3 Examples.Coupledinductors.graphml - yEd - o X

File Edit View Layout Tools Grouping Windows Help
BEER2+REX 0N Q8 QR IR e i~ @ P .y

¥ BiartiteGrap. . tors.araphml = x | ) TaskGraph_Mod...tors.graphml * x 4 b E §
| E:E_jij o |

- l@me
L bl

[ Meighborhood | B Folder Contents | 1] Predecessors | [ Successors

ﬂ" = General
Search Desaiption ] « Number of Nodes 18
= | Grapn Number of Edges 14

[= Data
CriticalPath

i # CLi=(L2internal) -R3. FOR CLi
i # C2i = (L3.internal) -R5.i FOR C2.i
# LLv =sineVoltage.v -RLvFOR LLv
# L2.v = Clvinternal -R2.y FOR L2.v
L # L3.v = C2vinternal -R4.y FOR L3.v
- # RLv =RLR *Llintenal FORR1v
- # R2v =R2.R *L2intenal FORR2.v
- # R3.=Clvinternal /R3.R FORR3.i
- # R4y =R4R *L3internal FOR R4v
- # RS.i=C2vinternal /R5.R FOR RS
- # Torn linear System

Figure 6.1: A task-graph representation of a model in yEd
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J BipartiteGraph_CompleteDAE_Modelica Electrical Spice3.Examples.Coupledinductors.graphml - yEd
[File| Edit View Layout Tools Grouping Windows Help

BOED »RRE O~ QQ QR HTEerLEHm @ P

& Cverven Wil | Y wartiterap. tors graphml *_ x| “re
I Shape Hodes @ A
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- & Fi "Properties View aRx
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Search Description ~ Text 2
X 3%6.0
=] | Graph ~ ¥ 556.0
©# CLi=(L2iinternal) -R3.i Vidth 3”'
- # CLEVARIABLE(nit = "A") "Current flowing from pin p to pin n” type: Rez Height 0.0
- # Clvinternal:STATE(1){unit = V" protected = true ) type: Real Al iulur 0 #fossse
# C2i = (d3.internal) -R5.i Filcoors [ 5—
# CLiVARIABLE(unit = "A") "Current flowing from pin p to pin n™ type: Rez e Calo W =000000
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Figure 6.2: A biparite graph representation of a model in yEd

82 Chapter 6. Generating Graph Representations for Models




CHAPTER
SEVEN

FMI AND TLM-BASED SIMULATION AND CO-SIMULATION OF
EXTERNAL MODELS

7.1 Functional Mock-up Interface - FMI

The new standard for model exchange and co-simulation with Functional Mockup Interface (FMI) allows export of
pre-compiled models, i.e., C-code or binary code, from a tool for import in another tool, and vice versa. The FMI
standard is Modelica independent. Import and export works both between different Modelica tools, or between
certain non-Modelica tools. OpenModelica supports FMI 1.0 & 2.0,

* Model Exchange

* Co-Simulation (under development)

7.1.1 FMI Export

To export the FMU use the OpenModelica command translateModelFMU(ModelName) from command line in-
terface, OMShell, OMNotebook or MDT. The export FMU command is also integrated with OMEdit. Select FMI
> Export FMU the FMU package is generated in the current directory of omc. You can use the cd() command to
see the current location. You can set which version of FMI to export through OMEdit settings, see section FMI.

To export the bouncing ball example to an FMU, use the following commands:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")

true

>>> translateModelFMU (BouncingBall)

"«DOCHOME»/BouncingBall. fmu"

>>> system("unzip -1 BouncingBall.fmu | egrep -v 'sources|files' | tail -n+3 |_
—grep —-o '[A-Za-z._0-9/]1x$' > BB.log")
0

After the command execution is complete you will see that a file BouncingBall.fmu has been created. Its contents
varies depending on the current platform. On the machine generating this documentation, the contents in Listing
7.1 are generated (along with the C source code).

Listing 7.1: BouncingBall FMU contents

binaries/

binaries/linux64/
binaries/linux64/BouncingBall.so
binaries/linux64/BouncingBall_FMU.1libs
modelDescription.xml

A log file for FMU creation is also generated named ModelName_FMU.log. If there are some errors while creating
FMU they will be shown in the command line window and logged in this log file as well.

By default an FMU that can be used for both Model Exchange and Co-Simulation is generated. We only support
FMI 2.0 for Co-Simulation FMUs.
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Currently the Co-Simulation FMU supports only the forward Euler solver with root finding which does an
Euler step of communicationStepSize in fmi2DoStep. Events are checked for before and after the call to
fmi2GetDerivatives.

7.1.2 FMI Import

To import the FMU package use the OpenModelica command importFMU,

>>> list (OpenModelica.Scripting.importFMU, interfaceOnly=true)
function importFMU

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3;loglevel_info=4;loglevel_verbose=5; loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned
—otherwise only the file name.";

input Boolean debuglLogging = false "When true the FMU's debug output is printed.
=";

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output,
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMU;

The command could be used from command line interface, OMShell, OMNotebook or MDT. The importFMU
command is also integrated with OMEdit. Select FMI > Import FMU the FMU package is extracted in the
directory specified by workdir, since the workdir parameter is optional so if its not specified then the current
directory of omc is used. You can use the cd() command to see the current location.

The implementation supports FMI for Model Exchange 1.0 & 2.0 and FMI for Co-Simulation 1.0 stand-alone.
The support for FMI Co-Simulation is still under development.

The FMI Import is currently a prototype. The prototype has been tested in OpenModelica with several examples.
It has also been tested with example FMUs from FMUSDK and Dymola. A more fullfleged version for FMI
Import will be released in the near future.

When importing the model into OMEdit, roughly the following commands will be executed:

>>> imported_fmu _mo_file:=importFMU ("BouncingBall.fmu")
"BouncingBall_me_FMU.mo"

>>> loadFile (imported_fmu_mo_file)

true

The imported FMU can then be simulated like any normal model:

>>> gimulate (BouncingBall_me_FMU, stopTime=3.0)
record SimulationResult

resultFile = "«DOCHOME»/BouncingBall_me_FMU_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'BouncingBall_me_FMU',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
—= ”"l

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.02349253,
timeBackend = 0.006676523999999961,
timeSimCode .009255978,
timeTemplates = 0.005449428,

Il
[oNe}

(continues on next page)
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(continued from previous page)

timeCompile = 0.424561355,
timeSimulation = 0.032080918,
timeTotal = 0.50162332

end SimulationResult;

Figure 7.1: Height of the bouncing ball, simulated through an FMU.

7.2 Transmission Line Modeling (TLM) Based Co-Simulation

This chapter gives a short description how to get started using the TLM-Based co-simulation accessible via
OMEdit.

The TLM Based co-simulation provides the following general functionalities:
¢ Import and add External non-Modelica models such as Matlab/SimuLink, Adams, and BEAST models

 Import and add External Modelica models e.g. from tools such as Dymola or Wolfram SystemModeler,
etc.

 Specify startup methods and interfaces of the external model
* Build the composite models by connecting the external models
* Set the co-simulation parameters in the composite model

¢ Simulate the composite models using TLM based co-simulation

7.3 Composite Model Editing of External Models

The graphical composite model editor is an extension and specialization of the OpenModelica connection editor
OMEdit. A composite model is composed of several external sub-models including the interconnections between
these sub-models. External models are models which need not be in Modelica, they can be FMUs, or models
accessed by proxies for co-simulation and connected by TLM-connections. The standard way to store a composite
model is in an XML format. The XML schema standard is accessible from timModelDescription.xsd. Currently
composite models can only be used for TLM based co-simulation of external models.
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7.3.1 Loading a Composite Model for Co-Simulation

To load the composite model, select File > Open Composite Model(s) from the menu and select composite-
model.xml.

OMEdit loads the composite model and show it in the Libraries Browser. Double-clicking the composite model
in the Libraries Browser will display the composite model as shown below in Figure 7.2.

ot OMEdit - OpenModelica Cennection Editor - [deublePendulum] — O *,

d‘i Eile Edit View Simulation FM|  Export Debug Git Tools Help - &8 X
BB Fece \ONO B[00 ]n-
Libraries Browser = |°& E |Wri13ble ‘Diagram View ‘C:ISIG:mMPIu...ePendqum.m| ‘ 3D Viewer Browser g X

|FilterCIasses | \ 4 ~ @Isometric - (:.”f\ f:.”:\.

Libraries

L)
doublePendulum

e

W
< >
t Welcome gzi Modeling ﬁ Plotting [ Debugging

Figure 7.2: Composite Model with 3D View.

7.3.2 Co-Simulating the Composite Model

There are two ways to start co-simulation:

¢ Click TLM Co-Simulation setup button ('0}) from the toolbar (requires a composite model to be active
in ModelWidget)

* Right click the composite model in the Libraries Browser and choose TLM Co-Simulation setup from
the popup menu (see Figure 7.3)
The TLM Co-Simulation setup appears as shown below in Figure 7.4.
Click Simulate from the Co-simulation setup to confirm the co-simulation. Figure 7.5 will appears in which you

will be able to see the progress information of the running co-simulation.

The editor also provides the means of reading the log files generated by the simulation manager and monitor.
When the simulation ends, click Open Manager Log File or Open Monitor Log File from the co-simulation
progress bar to check the log files.
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ot OMEdit - OpenModelica Cennection Editor - [deublePendulum] — O *,
gﬁ Eile Edit View Simulation FM|  Export Debug Git Tools Help - &8 X
( L0 LA L =+ G . r==1
Ba =1 Heee \PHO 59 >9 0"
Libraries Browser g X |n% B |‘.I'.|'riizble ‘Diagram View ‘C:!SIG:,IH_MPIU...EPendqum.m| 5 ‘ 3D Viewer Browser g X
Filter Classes \ 4 [ B s oy
| | ~ é;lsnmetnc | ]
Libraries
</> doublePen
{4- Fetch Interface Data
< TLM Co-Simulation Setup
# Unload Del
|
Eukl e il
i
W
£ >
Opens the TLM co-simulation setup t Welcome gﬁ Modeling ﬂ Plotting ‘» Debugging

Figure 7.3: Co-simulating and Fetching Interface Data of a composite model from the Popup Menu .
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ot OMEdit - TLM Co-Simulation Setup - doublePendulum ? >

TLM Co-Simulation Setup - doublePendul

TLM Flugin Path: |C:,."5HF,."TLMPIugin,|'bin | Browse...
TLM Manager
Manager Process: |C:/SKF/TLMPlugin/bin/tmmanager.exe Browse...
Server Port: 11111
Monitor Port: 12111

[ ] Debug Mode

TLM Monitor

Monitor Process: | C:/SKF/TLMPlugin/bin/ftmmaonitor. exe Browse...

Mumber Of Steps: |

Time Step Size:

[ ] Debug Mode

Show TLM Co-Simulation Output Window

Simulate Cancel

Figure 7.4: TLM Co-simulation Setup.
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o't OMEdit - doublePendulum TLM Co-Simulation — O >

Running co-simulation using the doublePendulum composite model. Please wait for a while.

I TN

Manager Output Stop Manager | Open Manager Log File

tlm.config ~
timeEnd = 3

MaxTimeStep "<"= 0.0001000000

Writing caselIl doublePendulumZ and server name 130.Z3&.15%0.168:11111 to £file
tlm.config

Writing doublePendulumZ .mos

Writing doublePenduluml .mos

Starting COpenModelica

C: /OpenModelicabuild/ /bin/omc.exe doublePendulumZ  mos

Starting COpenModelica

C: /OpenModelicasbuild/  /bin/omc.exe doublePenduluml .mos

W

Monitor Output Stop Manitor | | Open Maonitor Log File

C:/8FF/TLMPlugin/bin/tlmmonitor.exe 130.236.15%0.168:12111 C:/5EKF/TILMPlugin/HMetaModels/
CmoCmeDoublePendul umy/doublePendulum. xml

Figure 7.5: TLM Co-Simulation Progress.
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7.3.3 Plotting the Simulation Results

When the co-simulation of the composite model is completed successful, simulation results are collected and
visualized in the OMEdit plotting perspective as shown in Figure 7.6 and Figure 7.7. The Variables Browser
display variables that can be plotted. Each variable has a checkbox, checking it will plot the variable.

&t OMEdit - OpenModelica Connection Editor - [Plot: 1] - O >

IZEiIe Edit View Simulation FMI  Export Debug Git Tools Help - 8 X

JeHB 98 Xlon S

Libraries Browser g x Auto Scale | FitinView | Save | Print | Grid | Detsiled Grid Mo Grid > Variables Browser 8 X

|Filter Claszes | L4 |Fi|ter Variables

Lbraries doublePendulum 1.tm.A{1, 1) [-] doublePendulum 1.tm.A{1,2) [] | -

doublePendulum 17 Variables Ve ™
- -
] = doublePendulum?
] = tlm
0.5 o [EERNS!
] b ap.2) -]
1 [HEWENS!
1 Oaenl
1 Oae2 -]
0 Oae3i-]
T Oaen-l
T Oaz.a -]
Oaza -]
[CIF_tiel.. 13 [N]
-0.5 CIF tie[...2) [N]
[IF tiel..3) [N]
1M _tie... [Nm]
I M_tie... [Nm]

I M_tie... [Nm]
0 0.5 1 1.|5 :lz 2.|5 3I L10meg..d/s]

time [s] n ["10mea..d/sl N w7

'
N
_l

t Welcome di Modeling Plotting w Debugging

Figure 7.6: TLM Co-Simulation Results Plotting.

7.3.4 Preparing External Models

First step in co-simulation Modeling is to prepare the different external simulation models with TLM inter-
faces. Each external model belongs to a specific simulation tool, such as MATLAB/Simulink*, BEAST,
MSC/ADAMS, Dymola and Wolfram SystemModeler.

When the external models have all been prepared, the next step is to load external models in OMEdit by selecting
the File > Load External Model(s) from the menu.

OMEdit loads the external model and show it in the Libraries Browser as shown below in Figure 7.8.

7.3.5 Creating a New Composite Model

We will use the "Double pendulum" composite model which is a multibody system that consists of three sub-
models: Two OpenModelica Shaft sub-models (Shaftl and Shaft2) and one SKF/BEAST bearing sub-model
that together build a double pendulum. The SKF/BEAST bearing sub-model is a simplified model with only
three balls to speed up the simulation. Shaftl is connected with a spherical joint to the world coordinate system.
The end of Shaftl is connected via a TLM interface to the outer ring of the BEAST bearing model. The inner ring
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ot OMEdit - OpenModelica Connection Editor - [deublePendulum.csv] — O *,
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Figure 7.7: TLM Co-Simulation Visualization.
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Figure 7.8: External Models in OMEdit.
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of the bearing model is connected via another TLM interface to Shaft2. Together they build the double pendulum
with two shafts, one spherical OpenModelica joint, and one BEAST bearing.

To create a new composite model select File > New Composite Model from the menu.

Your new composite model will appear in the in the Libraries Browser once created. To facilitate the process of
textual composite modeling and to provide users with a starting point, the Text View (see Figure 7.9) includes the
composite model XML elements and the default simulation parameters.

ot OMEdit - OpenModelica Connection Editor - [CompositeModel1*] — O *,
E Eile Edit Miew Simulation FM|  Export Debug Tools Help - &8 X
- : » 5
75';'@ @O\@\G‘ ‘o 3 - 3 :',» 9‘,» |><» tl’}h”
Libraries Browser g X ‘di B ‘Wrimble |Te1<t\f|ew ‘ |Lir1e: 1, Cal: 0 ‘ |
|FilterCIasses | N .
1 <?xml wersion='1l.0'" encoding='UTF-8'"?>
Libraries <!--— The root node is the composite-model -->
N ) <Model Hame="CompoziteModell":>
ply| CompositeModell <1-- List of connected sub-models -->
<5ubModels/ >
<!-- List of TLM connections --X»
«Connections/>
<!-- Parameters for the simumlation --X
<SimulationParams StartTime="0" ScopTime="1"/>
</Madel>

¥:-101.11 ¥: 105.69 @ welcome  of Modeling 59 Plotting @ Debugging

Figure 7.9: New composite model text view.

7.3.6 Adding Submodels

It is possible to build the double pendulum by drag-and-drop of each simulation model component (sub-model)
from the Libraries Browser to the Diagram View. To place a component in the Diagram View of the double
pendulum model, drag each external sub-model of the double pendulum (i.e. Shaft1, Shaft2, and BEAST bearing
sub-model) from the Libraries Browser to the Diagram View.

7.3.7 Fetching Submodels Interface Data

To retrieve list of TLM interface data for sub-models, do any of the following methods:

¢ Click Fetch Interface Data button (<<') from the toolbar (requires a composite model to be active in
ModelWidget)

 Right click the composite model in the Library Browser and choose Fetch Interface Data from the popup
menu (see Figure 7.3).
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.
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Figure 7.10: Adding sub-models to the double pendulum composite model.
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To retrieve list of TLM interface data for a specific sub-model,

¢ Right click the sub-model inside the composite model and choose Fetch Interface Data from the popup
menu.

Figure 7.11 will appear in which you will be able to see the progress information of fetching the interface data.

&% OMEdit - Fetch Interface Data - MetaModell L2 [

Fetching interface data for MetaModell. ..

| - . Cancel Fetch Again

Output

C:WTIMPluginiMetaModels\ testshaftll>goto DONE

C:3ZTIMPluginiyMetaModels\ testyshaftZl>goto DONE

C:%wTIMPluginyMetaModels\ testhshaftZl>echo Done StartTLMOpenModelica
Done StartTIMOpenModelica

C:%wTIMPluginiyMetaModels\testhshaftll>echo Done StartTLMOpenModelica
Done StartTIMOpenModelica

1

Figure 7.11: Fetching Interface Data Progress.

Once the TLM interface data of the sub-models are retrieved, the interface points will appear in the diagram view
as shown below in Figure 7.12.

7.3.8 Connecting Submodels

When the sub-models and interface points have all been placed in the Diagram View, similar to Figure 7.12, the

next step is to connect the sub-models. Sub-models are connected using the Connection Line Button ('<:) from
the toolbar.

To connect two sub-models, select the Connection Line Button and place the mouse cursor over an interface and
click the left mouse button, then drag the cursor to the other sub-model interface, and click the left mouse button
again. A connection dialog box as shown below in Figure 7.13 will appear in which you will be able to specify
the connection attributes.

Continue to connect all sub-models until the composite model Diagram View looks like the one in Figure 7.14
below.

7.3.9 Changing Parameter Values of Submodels

To change a parameter value of a sub-model, do any of the following methods:
* Double-click on the sub-model you want to change its parameter
¢ Right click on the sub-model and choose Attributes from the popup menu

The parameter dialog of that sub-model appears as shown below in Figure 7.15 in which you will be able to specify
the sub-models attributes.
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Figure 7.12: Fetching Interface Data.
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Figure 7.13: Sub-models Connection Dialog.
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Figure 7.14: Connecting sub-models of the Double Pendulum Composite Model.
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o% OMEdit - SubModel Attributes -

Name: shaftl

Model File: shaftl.mo

Simulation Tool OpenModelica -
Start Command: startTLMOpenModelica

|| Exact Step Flag

Ok ] | Cancel

Figure 7.15: Changing Parameter Values of Sub-models Dialog.

7.3.10 Changing Parameter Values of Connections

To change a parameter value of a connection, do any of the following methods:
* Double-click on the connection you want to change its parameter
* Right click on the connection and choose Attributes from the popup menu.

The parameter dialog of that connection appears (see Figure 7.13) in which you will be able to specify the con-
nections attributes.

7.3.11 Changing Co-Simulation Parameters
To change the co-simulation parameters, do any of the following methods:
| |
e Click Simulation Parameters button (to t) from the toolbar (requires a composite model to be active in

ModelWidget)

* Right click an empty location in the Diagram View of the composite model and choose Simulation Param-
eters from the popup menu (see Figure 7.16)

The co-simulation parameter dialog of the composite model appears as shown below in Figure 7.17 in which you
will be able to specify the simulation parameters.
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Figure 7.16: Changing Co-Simulation Parameters from the Popup Menu.

-
o't OMEdit - Simulation Parameters - pendulum u

Simulation Parameters - pendulum

Start Time: | 0.0 |

It StopTime: |1.0

I [ Save ] | Cancel

Figure 7.17: Changing Co-Simulation Parameters Dialog.

7.3. Composite Model Editing of External Models 99



OpenModelica User’s Guide, Release v1.14.1-2-9g392¢27e260

100 Chapter 7. FMI and TLM-Based Simulation and Co-simulation of External Models



CHAPTER
EIGHT

OMSIMULATOR

OMSimulator has its own documentation.
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CHAPTER
NINE

OPENMODELICA ENCRYPTION

The encryption module allows the library developers to encrypt their libraries for different platforms. Note that
you need a special version of OpenModelica with encryption support. Contact us if you want one.

9.1 Encrypting the Library

In order to encrypt the Modelica package call buildEncryptedPackage(TopLevelPackageName) from mos script or
from OMEdit right click the package in Libraries Browser and select Export Encrypted Package or select Export
> Export Encrypted Package from the menu.

All the Modelica files are encrypted and the whole library is zipped into a single file i.e., PackageName.mol. Note
that you can only encrypt Modelica packages saved in a folder structure. The complete folder structure remains
as it is. No encryption is done on the resource files.

9.2 Loading an Encrypted Library

To load the encrypted package call loadEncryptedPackage(EncryptedPackage.mol) from the mos script or from
OMEdit File > Load Encrypted Package.

9.3 Notes

* There is no license management and obfuscation of the generated code and files. However just a basic
encryption and decryption is supported along with full support for protection access annotation as defined
in Modelica specification 18.9. This means that anyone who has an OpenModelica version with encryption
support can encrypt or decrypt files.

* OpenModelica encryption is based on SEMLA (Safe/Superiour/Super Encryption of Modelica Libraries
and Artifacts) module from Modelon AB.
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CHAPTER
TEN

OMNOTEBOOK WITH DRMODELICA AND DRCONTROL

This chapter covers the OpenModelica electronic notebook subsystem, called OMNotebook, together with the
DrModelica tutoring system for teaching Modelica, and DrControl for teaching control together with Modelica.
Both are using such notebooks.

10.1 Interactive Notebooks with Literate Programming

Interactive Electronic Notebooks are active documents that may contain technical computations and text, as well as
graphics. Hence, these documents are suitable to be used for teaching and experimentation, simulation scripting,
model documentation and storage, etc.

10.1.1 Mathematica Notebooks

Literate Programming [Knu84] is a form of programming where programs are integrated with documentation in
the same document. Mathematica notebooks [Wol96] is one of the first WYSIWYG (What-You-See-Is-What-
You-Get) systems that support Literate Programming. Such notebooks are used, e.g., in the MathModelica mod-
eling and simulation environment, see e.g. Figure 10.1 below and Chapter 19 in [Fri04].

10.1.2 OMNotebook

The OMNotebook software [Axe05][Fernstrom(06] is a new open source free software that gives an interactive
WYSIWYG realization of Literate Programming, a form of programming where programs are integrated with
documentation in the same document.

The OMNotebook facility is actually an interactive WY SIW YG realization of Literate Programming, a form of
programming where programs are integrated with documentation in the same document. OMNotebook is a simple
open-source software tool for an electronic notebook supporting Modelica.

A more advanced electronic notebook tool, also supporting mathematical typesetting and many other facilities, is
provided by Mathematica notebooks in the MathModelica environment, see Figure 10.1.

Process
- using Mathe

Figure 10.1: Examples of Mathematica notebooks in the MathModelica modeling and simulation environment.
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Traditional documents, e.g. books and reports, essentially always have a hierarchical structure. They are divided
into sections, subsections, paragraphs, etc. Both the document itself and its sections usually have headings as
labels for easier navigation. This kind of structure is also reflected in electronic notebooks. Every notebook
corresponds to one document (one file) and contains a tree structure of cells. A cell can have different kinds of
contents, and can even contain other cells. The notebook hierarchy of cells thus reflects the hierarchy of sections
and subsections in a traditional document such as a book.

10.2 DrModelica Tutoring System — an Application of OMNotebook

Understanding programs is hard, especially code written by someone else. For educational purposes it is essential
to be able to show the source code and to give an explanation of it at the same time.

Moreover, it is important to show the result of the source code’s execution. In modeling and simulation it is
also important to have the source code, the documentation about the source code, the execution results of the
simulation model, and the documentation of the simulation results in the same document. The reason is that the
problem solving process in computational simulation is an iterative process that often requires a modification of
the original mathematical model and its software implementation after the interpretation and validation of the
computed results corresponding to an initial model.

Most of the environments associated with equation-based modeling languages focus more on providing efficient
numerical algorithms rather than giving attention to the aspects that should facilitate the learning and teaching of
the language. There is a need for an environment facilitating the learning and understanding of Modelica. These
are the reasons for developing the DrModelica teaching material for Modelica and for teaching modeling and
simulation.

An earlier version of DrModelica was developed using the MathModelica (now Wolfram SystemModeler) envi-
ronment. The rest of this chapter is concerned with the OMNotebook version of DrModelica and on the OMNote-
book tool itself.

DrModelica has a hierarchical structure represented as notebooks. The front-page notebook is similar to a table
of contents that holds all other notebooks together by providing links to them. This particular notebook is the first
page the user will see (Figure 10.2).

In each chapter of DrModelica the user is presented a short summary of the corresponding chapter of the Modelica
book [Fri04]. The summary introduces some keywords, being hyperlinks that will lead the user to other notebooks
describing the keywords in detail.

Now, let us consider that the link “HelloWorld” in DrModelica Section is clicked by the user. The new HelloWorld
notebook (see Figure 10.3), to which the user is being linked, is not only a textual description but also contains one
or more examples explaining the specific keyword. In this class, HelloWorld, a differential equation is specified.

No information in a notebook is fixed, which implies that the user can add, change, or remove anything in a
notebook. Alternatively, the user can create an entirely new notebook in order to write his/her own programs or
copy examples from other notebooks. This new notebook can be linked from existing notebooks.

When a class has been successfully evaluated the user can simulate and plot the result, as previously depicted in
Figure 10.3 for the simple HelloWorld example model.

After reading a chapter in DrModelica the user can immediately practice the newly acquired information by
doing the exercises that concern the specific chapter. Exercises have been written in order to elucidate language
constructs step by step based on the pedagogical assumption that a student learns better “using the strategy of
learning by doing”. The exercises consist of either theoretical questions or practical programming assignments.
All exercises provide answers in order to give the user immediate feedback.

Figure 10.4 shows part of Chapter 9 of the DrModelica teaching material. Here the user can read about language
constructs, like algorithm sections, when-statements, and reinit equations, and then practice these constructs by
solving the exercises corresponding to the recently studied section.

Exercise 1 from Chapter 9 is shown in Figure 10.5. In this exercise the user has the opportunity to practice different
language constructs and then compare the solution to the answer for the exercise. Notice that the answer is not
visible until the Answer section is expanded. The answer is shown in Figure 10.6.
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E OMNotebook: DrModelica.onb®

File Edit Cel Format Insert  ‘Window  Help

Version 2006-04-11 |

DriModelic gmodetica Edition

Copyright: (o) Linképimng Universty, PELAR, 20032-2006, "Wiley-IEEE Press, Modelca &ssociation.
Contact: Openblodelica@ida lu.se; Opentdodelica Project web site:
www ida i sefprojects/Openbdodelica

Book web page: www mathcore com/driodelica; Book author: Peter Fritzson(@ida . se

Dillodelica Authors: (2003 wersion) Susanna Monemat, Eva-Lena Lengouist Sandeling Peter Fritzzon, Peter Bunus
Dillodelica Authors: (2005 and later updates): Peter Fritzson

This DrMedelica notebook has been developed to facilitate learning the Maodelica language as well as
praviding an introduction to abjeci-ariented madsling and sivudation. It is based on and is
supplemantary material to the Modelica book: Feter Fritzeon: "Frinciples of Object-Orientad
Modeling and Simulation with Modelica® {2004), 940 pages, Wiley-IEEE Fress, ISEN 0-471-471631.
Al af the examples and exercises in DrModelica and the page refersnces are from that book. Most aof
the text in DrModelica is alsa based on that boalk.

Detailed Copiright and Acknowledgment Information
Getting Started Using OMNotebook
OpenModelica commands

Berkeley license OpenModelica

1 A Quick Tour of Modelica
1.1 Getting Started - First Basic Examples

There 15 a long tradiion that the first sample program m any computer language 15 a trivial program
printing the string "Hello World" (p. 19 in Peter Fritzson's boolt). Since Modelica 15 an equation based
language, printing a string does not make much sence. Instead, our Helle World Modelica program solves
a trrval diferential equation. The second example shows how you can write a model that solvesz a

LDifferential Algebraic Equation System (p. 19). In the Van der Peol (p. 22) example declaration as well as

wutiahzation and prefix usage are shown i a shghtly more comphcated way.
1.2 Classes and Instances

In Modelica objects are created mmplicitly just by Declanng Instances of Classes (p. 26). Almost anything
m Modelica 15 a class, but there are some keywords for specific use of the clasz concept, called -

Ready

Figure 10.2: The front-page notebook of the OMNotebook version of the DrModelica tutoring system.
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First Basic Class

1 HelloWorld

The program contains a declaration of a class called He11oWor1d with two fields and one equation. The first field
is the variable x which is initizlized to a start value 2 at the time when the simulation starts. The second field is the
wvariable a, which is a constant that is initialized to 2 at the beginning of the simulation. Such a constant is prefixed by
the keyword parameter in order to indicate that it is constant during simmlation but is a model parameter that can be
changed between simulations.

The Modelica program solves a trivial differential equation: x' = - a * x. The varable x is a state variable
that can change value over time. The x ' is the time derivative of x.

class HelloWorld

Real x(start = 1, fixed=true);
parameter Real a = 1;
equation
der(x) = - a * x;
end HelloWorld;
{Hellowaorld}

2 Simulation of HelloWorld

simulate( HelloWorld, startTime=0, stopTime=3 )

record SimulationResult
resultFile = "HelloWorld_res.mat”,
messages =

end SimulationResult;

Plot the results.

plot( x )
[done]

Pan  AutoScale | FitinView Save  Print  Grid | DetaledGrid | MoGrid [ JLog¥ [ JLog¥ Setup

Plot by OpenModelica
1
0.8
0.6
0.4
0.2 \
. T
0 1 —_——_—_—-—_——————_
0 0.5 1 1.5 2 2.3 3 3.5 4
time
Ready

Figure 10.3: The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica.
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Gl oMNotebook: drmodelica.onb -0 x|
File Edit el Format  Insert  window  Help
Algorithms and Functions
Algorithins
In Modelica, algorithmic statements can only occur within Algontlun Sections (p. 285),
starting with the keyword algorithm. Smple Assicniment Statements (p. 287) is the
most common kind of statements in algorithm sections. There iz a gpecial form of
assignment statement that is only used when the right hand side containg a call to a
Function with Multiple Results (p. 287).
The for-Statement (alzo called for-loop) i a convenient way of expressing iteration (p.
288). When vsing the for-loop for iteration we must be able to express the range of
values over which the iteration variable should iterate in a closed form as an iteration
expression. For cazes where this iz not feasible there iz alzo a While-loop iteration
construct in Modelica (p. 290). For conditional expressions the if-Statement (p. 292) i
used. When-Statements (p. 293) are used to express acfions at event (nstanis and are
clozely related to when-equations. The Eemit (p. 296) statement can be uzed in
when-statements to define new values for contimous-time state variabies of a model at
an event.
The Agzert (p. 298) statement provides a convenient means for epecifying checks on
model validity within a model.
The most common uzage of Terminate (p. 298) iz to give more appropriate stopping
criteria for termmating a simulation than a fixed point in tiume.
Exercises J
Exercise 1
Exercise 2
Exercise 3
Exercise 4
Exercise S
Functions
The body of a Modelica function is a kind of algonthm section that containg procedural
algoritlunic code to be executed when the function iz Called (p. 300). Since a function is
a resfricted and enhanced kincd of clags. it iz nosgible to inherit an exigting fimction El
Ready 5

Figure 10.4: DrModelica Chapter on Algorithms and Functions in the main page of the OMNotebook version of
DrModelica.
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(Ll oMNotebook: Exercisel.nb i ]
File Edit  Cell Format  Insert  Window  Help

Exercise 1

Using Algorithm Sections

Wiite a finction, Sum, which calculates the sum of munbers, i an array of arbitrary size.

Write a finction, Ave rage, which calculates the average of numbers, in an array of arbitrary size. Average
should use make a function call to Sum.

| ]

Write a class, LargestAverages, that has two arrays and calculates the average of each of them. Then it
cotnpares the averages and sets a vanable to true if the frst array 15 larger than the second and otherwise false.

| ]

Answer ]

Ready 7

Figure 10.5: Exercise 1 in Chapter 9 of DrModelica.
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] OMNotebook: Exercisel.nb® -0 x|

File Edit el Format Insert ‘Window Help

| R

Answer

Sum

function Sum
input Real[:] =x=;
output Beal sum;
algorithm
for 1 in l:size(x,l]) loop
sum := sum + x[1];
end for;

end Sum;

Average

function Average

input Real[:] x;

output Beal average;
protected

Feal sum;

algorithm

average := Sumix) / size(x, 1);
end Average;

LargestAverage

class LargestAverage
parameter Integer[:] &1 = {1, 2, 3, 4, 53};
parameter Integer[:] AZ = {7, B, 9};
Real awverageil, averageli;
Boolean AlLargest({start = false);

algorithm

averageil := Average(il);

averagehZ = Average(AZ);

if awverageil > averagedZ then
AlLargest := true;

else
AlTargest := fal=e;

end if;

end Largestiverage;

Simulation of LargestAverage

simulate( Largestaverage ); ]

When we lool at the values m the wanables we see that A2 has the largest average (8 ) and therefore the
vatiable &1L argest 15 false (= 0).

Ready

v L

Figure 10.6: The answer section to Exercise 1 in Chapter 9 of DrModelica.
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10.3 DrControl Tutorial for Teaching Control Theory

DrControl is an interactive OMNotebook document aimed at teaching control theory. It is included in the Open-
Modelica distribution and appears under the directory:

>>> getInstallationDirectoryPath() + "/share/omnotebook/drcontrol"
"«OPENMODELICAHOME»/share/omnotebook/drcontrol"

The front-page of DrControl resembles a linked table of content that can be used as a navigation center. The
content list contains topics like:

* Getting started

* The control problem in ordinary life
 Feedback loop

* Mathematical modeling

¢ Transfer function

* Stability

¢ Example of controlling a DC-motor
* Feedforward compensation

* State-space form

* State observation

* Closed loop control system.

* Reconstructed system

* Linear quadratic optimization

¢ Linearization

Each entry in this list leads to a new notebook page where either the theory is explained with Modelica examples
or an exercise with a solution is provided to illustrate the background theory. Below we show a few sections of
DrControl.

10.3.1 Feedback Loop

One of the basic concepts of control theory is using feedback loops either for neutralizing the disturbances from
the surroundings or a desire for a smoother output.

In Figure 10.7, control of a simple car model is illustrated where the car velocity on a road is controlled, first with
an open loop control, and then compared to a closed loop system with a feedback loop. The car has a mass m,
velocity y, and aerodynamic coefficient o. The  is the road slope, which in this case can be regarded as noise.

Lets look at the Modelica model for the open loop controlled car:

my =u— ay —mg * sin(0)

model noFeedback
import SI = Modelica.SIunits;

SI.Velocity vy; // output signal without noise,_
—~theta = 0 —> v(t) = 0

SI.Velocity yNoise; // output signal with noise, L
—~theta <> 0 —> v(t) <> 0

parameter SI.Mass m = 1500;

parameter Real alpha = 200;

parameter SI.Angle theta = 5%3.141592/180;
parameter SI.Acceleration g = 9.82;
SI.Force u;

(continues on next page)
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File Edit Cell Format Insert Window Help

Feedback

One important method in designing control system is a feedback loop. It can be used to eliminate the
influence of noise or to decrease the output error.

| ¥

Regulator

1 Example

Assume that we want to control the speed of a car on the road. The car has a mass m, velocity y, and
aerodynamic coefficient a. The 8 is the road slope, which in this case can be regarded as noise.

my =u—ay —mgsin(d)
If we want a reference speed of 20 m/s for a car with m=1500 kg, a=250 Ns/m, 6=0 rad, how high should

the amplification factor be in the regulator?
Try with u = 250*r.

\.'itJ=mgsini9}l=U

rit)=20m/s

1.1 Open Loop

loadModel (Modelica)
true

model noFeedback
import 5I = Modelica.SIunits;

SI.Velocity y; // output signal without
noise, theta = 8 -> v(t) = 8
ST Velnritw wNnics- LY nntnut einnal with nnice

SN

Figure 10.7: Feedback loop.
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(continued from previous page)

SI.Velocity r=20;

equation
mxder (y) =u-alphaxy; // signal without noise
m+der (yNoise)=u-alphaxyNoise-mxg+sin (theta); // with noise
u = 250*r;

end noFeedback;

By applying a road slope angle different from zero the car velocity is influenced which can be regarded as noise in
this model. The output signal in Figure 10.8 is stable but an overshoot can be observed compared to the reference
signal. Naturally the overshoot is not desired and the student will in the next exercise learn how to get rid of this
undesired behavior of the system.

>>> loadModel (Modelica)

true

>>> simulate (noFeedback, stopTime=100)
record SimulationResult

resultFile = "«DOCHOME»/noFeedback_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 100.0, numberOfIntervals =,
—~500, tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'noFeedback', options,
—= "', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.295944072,
timeBackend = 0.003918966,
timeSimCode = 0.00160276,
timeTemplates = 0.002234645,
timeCompile = 0.372538607,
timeSimulation = 0.012034469,
timeTotal = 0.6883984439999999
end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").

The closed car model with a proportional regulator is shown below:

u=Kx*(r—uy)
model withFeedback
import SI = Modelica.SIunits;
SI.Velocity y; // output signal with feedback,,
—~1ink and without noise, theta = 0 -> v(t) = 0
SI.Velocity yNoise; // output signal with feedback,
—~1ink and noise, theta <> 0 -> v(t) <> 0

parameter SI.Mass m = 1500;
parameter Real alpha = 250;
parameter SI.Angle theta = 5x3.141592/180;
parameter SI.Acceleration g = 9.82;
SI.Force u;
SI.Force uNoise;
SI.Velocity r=20;
equation
m+der (y)=u-alphax*y;

(continues on next page)
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60 80 100

Figure 10.8: Open loop control example.

(continued from previous page)

mxder (yNoise)=uNoise-alphaxyNoise-mxgxsin (theta);
u = 5000+ (r-y);
uNoise = 5000« (r-yNoise);

end withFeedback;

By using the information about the current level of the output signal and re-tune the regulator the output quantity
can be controlled towards the reference signal smoothly and without an overshoot, as shown in Figure 10.9.

In the above simple example the flat modeling approach was adopted since it was the fastest one to quickly obtain
a working model. However, one could use the object oriented approach and encapsulate the car and regulator
models in separate classes with the Modelica connector mechanism in between.

>>> loadModel (Modelica)

true

>>> simulate (withFeedback, stopTime=10)
record SimulationResult

resultFile = "«DOCHOME»/withFeedback_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'withFeedback', options =
—'"'", outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.151260077,
timeBackend = 0.002531001,
timeSimCode = 0.000814878,
timeTemplates = 0.002181407,
timeCompile = 0.362451165,
timeSimulation = 0.013199448,
timeTotal = 0.532520764

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
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d=initialization").

yNoise -

Figure 10.9: Closed loop control example.

10.3.2 Mathematical Modeling with Characteristic Equations

In most systems the relation between the inputs and outputs can be described by a linear differential equation.
Tearing apart the solution of the differential equation into homogenous and particular parts is an important tech-
nique taught to the students in engineering courses, also illustrated in Figure 10.10.

n
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—_— —_— ... wy=bp——+...+bp_1— + b,
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Now let us examine a second order system:

J+ay+ay=1

model NegRoots

Real y;

Real der_y;

parameter Real al = 3;

parameter Real a2 = 2;
equation

der_y = der(y);
der (der_y) + alxder_y + a2xy = 1;
end NegRoots;

Choosing different values for a; and a, leads to different behavior as shown in Figure 10.11 and Figure 10.12.

In the first example the values of a; and a, are chosen in such way that the characteristic equation has negative
real roots and thereby a stable output response, see Figure 10.11.

>>> simulate (NegRoots, stopTime=10)
record SimulationResult

resultFile = "«DOCHOME»/NegRoots_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'NegRoots', options = '', |,
—outputFormat = 'mat', variableFilter = '.x', cflags = "', simflags = ''"

(continues on next page)

116 Chapter 10. OMNotebook with DrModelica and DrControl




OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

File Edit Cell Format Insert Window Help

= . . L . = :J-I v (0]

Mathematical Modeling

In most systems the relation between the inputs and outputs can be approximated by a linear differential
equation.

n n—1 d

d m d
g V() + a1 y(8) + et any(e) = bo o u(e) + . F bm_igu(ﬂwmu&}

where the coefficients a; and b; are constants. The above differential equation has a homogeneous and a
particular solution:

Y=Yt

The homogeneous solution where u is set to zero has the form: }
v = Crelat + o+ O elnt

where }

AMta, At ta, A +a,=0

1 Example
Consider the following model. } 1
a2 at |
720 +ar g y(e) +ay(e) =1
Examine the behavior of the system for different values on a, and a, }

1.1 Characteristic Equation with Negative Real Roots, A=-1,-2

model negRoots

Real y;

Real der_y;

parameter Real al = 3;
parameter Real a2 = 2;

equation

der_y = der(y);

der(der_y) + al*der_y + a2*y = 1;
end negRoots;

{negRoots}
simulate(neaRoots.stopTime=101 1 =

Figure 10.10: Mathematical modeling with characteristic equation.
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(continued from previous page)

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.2716158439999999,
timeBackend = 0.001477301,
timeSimCode = 0.000447936,
timeTemplates = 0.001714376,
timeCompile = 0.355375918,
timeSimulation = 0.013084753,
timeTotal = 0.643818295

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").

0.5
0.45
0.4
0.35
0.3
0.25
0.2
0.15
0.1

0.05

Figure 10.11: Characteristic equation with real negative roots.

The importance of the sign of the roots in the characteristic equation is illustrated in Figure 10.11 and Figure
10.12, e.g., a stable system with negative real roots and an unstable system with positive imaginary roots resulting
in oscillations.

model ImgPosRoots

Real y;

Real der_y;

parameter Real al = -2;

parameter Real a2 = 10;
equation

der_y = der(y);
der (der_y) + alxder_y + a2+y = 1;
end ImgPosRoots;

>>> simulate (ImgPosRoots, stopTime=10)
record SimulationResult

(continues on next page)
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(continued from previous page)

resultFile = "«DOCHOME»/ImgPosRoots_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'ImgPosRoots', options = '
—', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

"
’

timeFrontend = 0.271428171,
timeBackend = 0.001484366,
timeSimCode = 0.000409191,
timeTemplates = 0.001487769,
timeCompile = 0.356890336,
timeSimulation = 0.012858543,
timeTotal = 0.644654725

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").

1500 T T T T

1000 - -

500 | 1

-500 -

-1000 - .

_1500 1 1 1 1
0 2 4 6 8 10

Figure 10.12: Characteristic equation with imaginary roots with positive real part.

The theory and application of Kalman filters is also explained in the interactive course material.

In reality noise is present in almost every physical system under study and therefore the concept of noise is also
introduced in the course material, which is purely Modelica based.

10.4 OpenModelica Notebook Commands

OMNotebook currently supports the commands and concepts that are described in this section.
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File Edit Cell Format Insert Window Help

N | =B ' [ I ||« | @
1 Example J B
Consider a tank system with the following transfer function } ]
1 -
__A
G(s) = n T
sTT
What is the weight function? Can you plot the step response of the tank? }
1.1 Tank Transfer Function

loadModel (Modelica.Blocks) ]

model Tank
Modelica.Blocks.Continuous.TransferFunction G(b={1/A},
a={1,1/T},y_start(fixed=true)=1/A);
Modelica.Blocks.Continuous.TransferFunction GStep(b={1/A}, a={1,1/T});
parameter Real T = 15;
parameter Real A = 5;
Real u = if (time > @ or time<@®) then @ else Modelica.Constants.inf;
Real uStep = if (time > @ or time<@) then 1 else 8;
equation
G.u = if time > © then 0 else 1e10;
GStep.u = uStep;
end Tank;

{Tank}
simulate(Tank, startTime=-1e-10, number0fIntervals=500, stopTime=10); ]

plot({G.y,GStep.y})
true

Plot by OpenModelica

1.4
1.2
1 @Gy
0.8
0.6
0.4 @ GStep.y

0.2

0 2 4 6 8 10 Z
Ready Ln 8, Col1l

Figure 10.13: Step and pulse (weight function) response.
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File Edit Cell Format Inset Window Help
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1 Kalman Filter

Often we don't have access to the internal states of a system and can only measure the outputs of the system and
have to reconstruct the state of the system based on these measurements. This is normally done with an observer.
The idea with an observer is that we feedback the difference of the measured output with the estimated output. If
the estiamtion is correct then the difference should be zero.

Another difficulty is that the measured quantities often contain disturbance, i.e. noise.

{f:Ai+Bu+e
J=Ct+v

Here are e denoting a disturbance in the input signal and v is a measurement error. The quality of the estimate can
be evalated by the difference

K(y(t) — cx(t) — Du(t))
By using this quantity as feedback we obtain the observer
£ = AZ() + Bu(t) + K(3(t) — €2 () — Du(t))

Now form the error as

=i
I
=
|
L)

The differential error is

e L e L -

Ready Ready

Figure 10.14: Theory background about Kalman filter.

File Edit Cell Format Inset Window Help
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model KalmanFeedback

parameter Real A[:,size(A, 1)] = {{0,1},{1,0}} ;

parameter Real B([size(A, 1),:]1 = {{0},{1}};

parameter Real C[:,size(a, 1)] = {{1,0}};

parameter Real([2,1] K = [2.4;3.4];

parameter Real[l,2] L = [2.4,3.4];

parameter Real([:,:] ABL = A-B%L;

parameter Real[:,:] BL = B*L;

parameter Real([:,:] Z = zeros(size (ABL,2),size (ARC,1));

parameter Real[:,:] ARC = A-K*C;

parameter Real[:,:] Anew [0,1,0,0 ; -1.4, -3.4, 2.4,3.4; 0,0,-2.4,1;0,0,-2.4,0];
1
1

parameter Real[:,:] Bnew [07;1;0;0];

parameter Real[:,:] Fnew = [1;0;0;0];

stateSpaceNoise Kalman (stateSpace.A=Anew,stateSpace.B=Bnew, stateSpace.C=[1,0,0,0],
stateSpace.F = Fnew);

stateﬁpacaﬂ'oise noKalman;
end KalmanFeedback;

simulate (KalmanFeedback, stopTime=3)
[ plot ({Kalman.stateSpace.y([1l],noKalman.stateSpace.y([1]})

true
Plot by OpenModelica

15
@ Kalman, stateSpace. y[1]

@ nokalman.stateSpace.y[1]

w

Ready n12,Col39 |

Figure 10.15: Comparison of a noisy system with feedback link in DrControl.
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10.4.1 Cells

Everything inside an OMNotebook document is made out of cells. A cell basically contains a chunk of data. That
data can be text, images, or other cells. OMNotebook has four types of cells: headercell, textcell, inputcell, and
groupcell. Cells are ordered in a tree structure, where one cell can be a parent to one or more additional cells. A
tree view is available close to the right border in the notebook window to display the relation between the cells.

¢ Textcell — This cell type is used to display ordinary text and images. Each textcell has a style that spec-
ifies how text is displayed. The cell’s style can be changed in the menu Format->Styles, example of
different styles are: Text, Title, and Subtitle. The Textcell type also has support for following links to
other notebook documents.

e Inputcell — This cell type has support for syntax highlighting and evaluation. It is intended to be used
for writing program code, e.g. Modelica code. Evaluation is done by pressing the key combina-
tion Shift+Return or Shift+Enter. All the text in the cell is sent to OMC (OpenModelica Com-
piler/interpreter), where the text is evaluated and the result is displayed below the inputcell. By
double-clicking on the cell marker in the tree view, the inputcell can be collapsed causing the result to
be hidden.

* Latexcell — This cell type has support for evaluation of latex scripts. It is intended to be mainly used for
writing mathematical equations and formulas for advanced documentation in OMNotebook. Each La-
texcell supports a maximum of one page document output.To evaluate this cell, latex must be installed
in your system.The users can copy and paste the latex scripts and start the evaluation.Evaluation is
done by pressing the key combination Shift+Return or Shift+Enter or the green color eval button
present in the toolbar. The script in the cell is sent to latex compiler, where it is evaluated and the
output is displayed hiding the latex source. By double-clicking on the cell marker in the tree view,the
latex source is displayed for further modification.

* Groupcell — This cell type is used to group together other cell. A groupcell can be opened or closed.
When a groupcell is opened all the cells inside the groupcell are visible, but when the groupcell is
closed only the first cell inside the groupcell is visible. The state of the groupcell is changed by the
user double-clicking on the cell marker in the tree view. When the groupcell is closed the marker is
changed and the marker has an arrow at the bottom.

10.4.2 Cursors

An OMNotebook document contains cells which in turn contain text. Thus, two kinds of cursors are needed for
positioning, text cursor and cell cursor:

e Textcursor — A cursor between characters in a cell, appearing as a small vertical line. Position the cur-
sor by clicking on the text or using the arrow buttons.

¢ Cellcursor — This cursor shows which cell currently has the input focus. It consists of two parts. The
main cellcursor is basically just a thin black horizontal line below the cell with input focus. The
cellcursor is positioned by clicking on a cell, clicking between cells, or using the menu item Cell-
>Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination Ctrl+Up
or Ctrl+Down. The dynamic cellcursor is a short blinking horizontal line. To make this visible, you
must click once more on the main cellcursor (the long horizontal line). NOTE: In order to paste cells
at the cellcursor, the dynamic cellcursor must be made active by clicking on the main cellcursor (the
horizontal line).

10.4.3 Selection of Text or Cells

To perform operations on text or cells we often need to select a range of characters or cells.

* Select characters — There are several ways of selecting characters, e.g.  double-clicking on a word,
clicking and dragging the mouse, or click followed by a shift-click at an adjacent positioin selects
the text between the previous click and the position of the most recent shift-click.
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¢ Select cells — Cells can be selected by clicking on them. Holding down Ctrl and clicking on the cell
markers in the tree view allows several cells to be selected, one at a time. Several cells can be se-
lected at once in the tree view by holding down the Shift key. Holding down Shift selects all cells
between last selected cell and the cell clicked on. This only works if both cells belong to the same
groupcell.

10.4.4 File Menu

The following file related operations are available in the file menu:

* Create a new notebook — A new notebook can be created using the menu File->New or the key combi-
nation Ctrl+N. A new document window will then open, with a new document inside.

* Open a notebook — To open a notebook use File->Open in the menu or the key combination Ctrl+O.
Only files of the type .onb or .nb can be opened. If a file does not follow the OMNotebook format or the
FullForm Mathematica Notebook format, a message box is displayed telling the user what is wrong.
Mathematica Notebooks must be converted to fullform before they can be opened in OMNotebook.

* Save a notebook — To save a notebook use the menu item File->Save or File->Save As. If the notebook
has not been saved before the save as dialog is shown and a filename can be selected. OMNotebook
can only save in xml format and the saved file is not compatible with Mathematica. Key combination
for save is Ctrl+S and for save as Ctrl+Shift+S. The saved file by default obtains the file extension
.onb.

* Print — Printing a document to a printer is done by pressing the key combination Ctrl+P or using the
menu item File->Print. A normal print dialog is displayed where the usually properties can be changed.

e Import old document — Old documents, saved with the old version of OMNotebook where a different
file format was used, can be opened using the menu item File->Import->0Old OMNotebook file. Old
documents have the extension .xml.

» Export text — The text inside a document can be exported to a text document. The text is exported to
this document without almost any structure saved. The only structure that is saved is the cell structure.
Each paragraph in the text document will contain text from one cell. To use the export function, use
menu item File->Export->Pure Text.

* Close a notebook window — A notebook window can be closed using the menu item File->Close or the
key combination Ctrl+F4. Any unsaved changes in the document are lost when the notebook win-
dow is closed.

* Quitting OMNotebook — To quit OMNotebook, use menu item File->Quit or the key combination
Crtl+Q. This closes all notebook windows; users will have the option of closing OMC also. OMC
will not automatically shutdown because other programs may still use it. Evaluating the command
quit() has the same result as exiting OMNotebook.

10.4.5 Edit Menu

 Editing cell text — Cells have a set of of basic editing functions. The key combination for these are:
Undo (Ctrl+Z), Redo (Ctrl+Y), Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions can
also be accessed from the edit menu; Undo (Edit->Undo), Redo (Edit->Redo), Cut (Edit->Cut), Copy
(Edit->Copy) and Paste (Edit->Paste). Selection of text is done in the usual way by double-clicking,
triple-clicking (select a paragraph), dragging the mouse, or using (Ctrl+A) to select all text within the
cell.

* Cut cell — Cells can be cut from a document with the menu item Edit->Cut or the key combination
Ctrl+X. The cut function will always cut cells if cells have been selected in the tree view, otherwise
the cut function cuts text.

* Copy cell — Cells can be copied from a document with the menu item Edit->Copy or the key combina-
tion Ctrl+C. The copy function will always copy cells if cells have been selected in the tree view,
otherwise the copy function copy text.
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¢ Paste cell — To paste copied or cut cells the cell cursor must be selected in the location where the cells
should be pasted. This is done by clicking on the cell cursor. Pasteing cells is done from the menu
Edit->Paste or the key combination Ctrl+V. If the cell cursor is selected the paste function will always
paste cells. OMNotebook share the same application-wide clipboard. Therefore cells that have been
copied from one document can be pasted into another document. Only pointers to the copied or cut
cells are added to the clipboard, thus the cell that should be pasted must still exist. Consequently a cell
can not be pasted from a document that has been closed.

* Find - Find text string in the current notebook, with the options match full word, match cell, search
within closed cells. Short command Ctrl+F.

* Replace — Find and replace text string in the current notebook, with the options match full word,
match cell, search+replace within closed cells. Short command Ctrl+H.

¢ View expression — Text in a cell is stored internally as a subset of HTML code and the menu item Edit-
>View Expression let the user switch between viewing the text or the internal HTML representation.
Changes made to the HTML code will affect how the text is displayed.

10.4.6 Cell Menu

* Add textcell — A new textcell is added with the menu item Cell->Add Cell (previous cell style) or the
key combination Alt+Enter. The new textcell gets the same style as the previous selected cell had.

» Add inputcell — A new inputcell is added with the menu item Cell->Add Inputcell or the key combina-
tion Ctrl+Shift+1.

* Add latexcell — A new latexcell is added with the menu item Cell->Add Latexcell or the key combina-
tion Ctrl+Shift+E.

* Add groupcell — A new groupcell is inserted with the menu item Cell->Groupcell or the key combina-
tion Ctrl+Shift+G. The selected cell will then become the first cell inside the groupcell.

e Ungroup groupcell — A groupcell can be ungrouped by selecting it in the tree view and using the menu
item Cell->Ungroup Groupcell or by using the key combination Ctrl+Shift+U. Only one groupcell at
a time can be ungrouped.

Split cell — Spliting a cell is done with the menu item Cell->Split cell or the key combination
Ctrl+Shift+P. The cell is splited at the position of the text cursor.

Delete cell — The menu item Cell->Delete Cell will delete all cells that have been selected in the tree
view. If no cell is selected this action will delete the cell that have been selected by the cellcursor.
This action can also be called with the key combination Ctrl+Shift+D or the key Del (only works
when cells have been selected in the tree view).

¢ Cellcursor — This cell type is a special type that shows which cell that currently has the focus. The cell
is basically just a thin black line. The cellcursor is moved by clicking on a cell or using the menu
item Cell->Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination
Ctrl+Up or Ctrl+Down.

10.4.7 Format Menu

¢ Textcell — This cell type is used to display ordinary text and images. Each textcell has a style that spec-
ifies how text is displayed. The cells style can be changed in the menu Format->Styles, examples of
different styles are: Text, Title, and Subtitle. The Textcell type also have support for following links
to other notebook documents.

¢ Text manipulation — There are a number of different text manipulations that can be done to change the
appearance of the text. These manipulations include operations like: changing font, changing color
and make text bold, but also operations like: changing the alignment of the text and the margin in-
side the cell. All text manipulations inside a cell can be done on single letters, words or the entire
text. Text settings are found in the Format menu. The following text manipulations are available in
OMNotebook:
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> Font family

> Font face (Plain, Bold, Italic, Underline)
> Font size

> Font stretch

> Font color

> Text horizontal alignment

> Text vertical alignment

> Border thickness

> Margin (outside the border)

> Padding (inside the border)

10.4.8 Insert Menu

* Insert image — Images are added to a document with the menu item Insert->Image or the key combina-
tion Ctrl+Shift+M. After an image has been selected a dialog appears, where the size of the image can
be chosen. The images actual size is the default value of the image. OMNotebook stretches the image
accordantly to the selected size. All images are saved in the same file as the rest of the document.

e Insert link — A document can contain links to other OMNotebook file or Mathematica notebook and to
add a new link a piece of text must first be selected. The selected text make up the part of the link that
the user can click on. Inserting a link is done from the menu Insert->Link or with the key combination
Ctrl+Shift+L. A dialog window, much like the one used to open documents, allows the user to choose
the file that the link refers to. All links are saved in the document with a relative file path so documents
that belong together easily can be moved from one place to another without the links failing.

10.4.9 Window Menu

¢ Change window — Each opened document has its own document window. To switch between those use
the Window menu. The window menu lists all titles of the open documents, in the same order as they
were opened. To switch to another document, simple click on the title of that document.

10.4.10 Help Menu

e About OMNotebook — Accessing the about message box for OMNotebook is done from the menu Help-
>About OMNotebook.

* About Ot — To access the message box for Qt, use the menu Help->About Qt.

e Help Text — Opening the help text (document OMNotebookHelp.onb) for OMNotebook can be done in
the same way as any OMNotebook document is opened or with the menu Help->Help Text. The menu
item can also be triggered with the key F1.

10.4.11 Additional Features

e Links — By clicking on a link, OMNotebook will open the document that is referred to in the link.

e Update link — All links are stored with relative file path. Therefore OMNotebook has functions that au-
tomatically updating links if a document is resaved in another folder. Every time a document is saved,
OMNotebook checks if the document is saved in the same folder as last time. If the folder has changed,
the links are updated.

* Evaluate whole Notebook — All the cells present in the Notebook can be evaluated in one step by press-
ing the red color evalall button in the toolbar. The cells are evaluated in the same order as they are in
the Notebook.However the latexcells cannot be evaluated by this feature.

10.4. OpenModelica Notebook Commands 125



OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

* Evaluate several cells — Several inputcells can be evaluated at the same time by selecting them in the
treeview and then pressing the key combination Shift+Enter or Shift+Return. The cells are evalu-
ated in the same order as they have been selected. If a groupcell is selected all inputcells in that
groupcell are evaluated, in the order they are located in the groupcell.

* Moving and Reordering cells in a Notebook - 1t is possible to shift cells to a new position and change the
hierarchical order of the document.This can be done by clicking the cell and press the Up and Down
arrow button in the tool bar to move either Up or Down. The cells are moved one cell above or below.It
is also possible to move a cell directly to a new position with one single click by pressing the red color
bidirectional UpDown arrow button in the toolbar. To do this the user has to place the cell cursor to
a position where the selected cells must be moved. After selecting the cell cursor position, select the
cells you want to shift and press the bidirectional UpDown arrow button. The cells are shifted in the
same order as they are selected.This is especially very useful when shifting a group cell.

e Command completion — Inputcells have command completion support, which checks if the user is typ-
ing a command (or any keyword defined in the file commands.xml) and finish the command. If the user
types the first two or three letters in a command, the command completion function fills in the rest. To
use command completion, press the key combination Ctrl+Space or Shift+Tab. The first command that
matches the letters written will then appear. Holding down Shift and pressing Tab (alternative holding
down Ctrl and pressing Space) again will display the second command that matches. Repeated request
to use command completion will loop through all commands that match the letters written. When a
command is displayed by the command completion functionality any field inside the command that
should be edited by the user is automatically selected. Some commands can have several of these fields
and by pressing the key combination Ctrl+Tab, the next field will be selected inside the command. >
Active Command completion: Ctrl+Space / Shift+Tab > Next command: Ctrl+Space / Shift+Tab >
Next field in command: Ctrl+Tab’

¢ Generated plot — When plotting a simulation result, OMC uses the program Ptplot to create a plot.
From Ptplot OMNotebook gets an image of the plot and automatically adds that image to the out-
put part of an inputcell. Like all other images in a document, the plot is saved in the document file
when the document is saved.

¢ Stylesheet -OMNotebook follows the style settings defined in stylesheet.xml and the correct style is ap-
plied to a cell when the cell is created.

* Automatic Chapter Numbering — OMNotebook automatically numbers different chapter, subchapter,
section and other styles. The user can specify which styles should have chapter numbers and which
level the style should have. This is done in the stylesheet.xml file. Every style can have a <chapter-
Level> tag that specifies the chapter level. Level O or no tag at all, means that the style should not have
any chapter numbering.

 Scrollarea — Scrolling through a document can be done by using the mouse wheel. A document can
also be scrolled by moving the cell cursor up or down.

 Syntax highlighter — The syntax highlighter runs in a separated thread which speeds up the loading of
large document that contains many Modelica code cells. The syntax highlighter only highlights when
letters are added, not when they are removed. The color settings for the different types of keywords
are stored in the file modelicacolors.xml. Besides defining the text color and background color of
keywords, whether or not the keywords should be bold or/and italic can be defined.

e Change indicator — A star (*) will appear behind the filename in the title of notebook window if the
document has been changed and needs saving. When the user closes a document that has some un-
saved change, OMNotebook asks the user if he/she wants to save the document before closing. If the
document never has been saved before, the save-as dialog appears so that a filename can be choosen
for the new document.

e Update menus — All menus are constantly updated so that only menu items that are linked to actions
that can be performed on the currently selected cell is enabled. All other menu items will be dis-
abled. When a textcell is selected the Format menu is updated so that it indicates the text settings for
the text, in the current cursor position.
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CHAPTER
ELEVEN

OPTIMIZATION WITH OPENMODELICA

The following facilities for model-based optimization are provided with OpenModelica:

* Builtin Dynamic Optimization with OpenModelica and IpOpt using dynamic optimization is the recom-
mended way of performing dynamic optimization with OpenModelica.

* Dynamic Optimization with OpenModelica and CasADi. Use this if you want to employ the = CasADi
tool for dynamic optimization.

* Classical Parameter Sweep Optimization using OMOptim. Use this if you have a static optimization
problem.

11.1 Builtin Dynamic Optimization with OpenModelica and IpOpt

Note: this is a very short preliminary decription which soon will be considerably improved.

OpenModelica provides builtin dynamic optimization of models by using the powerful symbolic machinery of the
OpenModelica compiler for more efficient and automatic solution of dynamic optimization problems.

The builtin dynamic optimization allows users to define optimal control problems (OCP) using the Modelica
language for the model and the optimization language extension called Optimica (currently partially supported) for
the optimization part of the problem. This is used to solve the underlying dynamic optimization model formulation
using collocation methods, using a single execution instead of multiple simulations as in the parameter-sweep
optimization described in section Parameter Sweep Optimization using OMOptim.

For more detailed information regarding background and methods, see [BOR+12][RBB+14]

11.2 Compiling the Modelica code

Before starting the optimization the model should be symbolically instantiated by the compiler in order to get a
single flat system of equations. The model variables should also be scalarized. The compiler frontend performs
this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are
applied. Then the complete flattened model can be used for initialization, simulation and last but not least for
model-based dynamic optimization.

The OpenModelica command optimize(ModelName) from OMShell, OMNotebook or MDT runs immediately
the optimization. The generated result file can be read in and visualized with OMEdit or within OMNotebook.

11.3 An Example

In this section, a simple optimal control problem will be solved. When formulating the optimization problems,
models are expressed in the Modelica language and optimization specifications. The optimization language spec-
ification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It
includes several constructs including a new specialized class optimization, a constraint section, startTime, final-
Time etc. See the optimal control problem for batch reactor model below.

129



OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

Create a new file named BarchReactor.mo and save it in you working directory. Notice that this model contains
both the dynamic system to be optimized and the optimization specification.

Once we have formulated the undelying optimal control problems, we can run the optimization by using OMShell,
OMNotebook, MDT, OMEdit using command line terminals similar to the options described below:

>>> setCommandLineOptions ("-g=Optimica");

Listing 11.1: BatchReactor.mo

model BatchReactor
Real x1(start =1, fixed=true, min=0, max=1);
Real x2(start =0, fixed=true, min=0, max=1);
input Real u(min=0, max=5);

equation
der (x1l) = —(u+u”2/2)*x1;
der (x2) = u*x1;

end BatchReactor;

optimization nmpcBatchReactor (objective=-x2)
extends BatchReactor;
end nmpcBatchReactor;

>>> optimize (nmpcBatchReactor, numberOfIntervals=16, stopTime=1, tolerance=1le-8)
record SimulationResult

resultFile = "«DOCHOME»/nmpcBatchReactor_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 16,
—tolerance = 1e-08, method = 'optimization', fileNamePrefix = 'nmpcBatchReactor',

—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,

— rrn
—— ’
messages = "LOG_SUCCESS | info | The initialization finished,

—successfully without homotopy method.

Optimizer Variables

State[0] :x1(start = 1, nominal = 1, min = 0, max = 1, init 1)
State[l]:x2 (start = 0, nominal = 1, min = 0, max = 1, init = 0)
Input[2]:u(start = 0, nominal = 5, min = 0, max = 5)

kA hk kA hh kA Ak Ak kA h kA hkhkhkhkhkhkhk Ak hhkhkhkhkhkhkdhkh ko hkhkhk kA hkhkhkhkhkhkhkhkhhkhk Ak rkhhkhkhkdhhkhkrhkhkkhkrhhkkhkdrhhkx*x*

This program contains Ipopt, a library for large-scale nonlinear optimization.

Ipopt is released as open source code under the Eclipse Public License (EPL).
For more information visit http://projects.coin-or.org/Ipopt

AR A AR AR A A AR A A A AR A A A A A A A A A A A A A A A AR A AR A A A A AR A AR A AR AR A A A A A AR AR A AR A AR A A AR A A A AR AR KA A XK

LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.134411515,
timeBackend = 0.00692187,
timeSimCode = 0.00137952,
timeTemplates = 0.003257663,
timeCompile = 0.349482525,
timeSimulation = 0.026305072,
timeTotal = 0.521872934

end SimulationResult;

o O

The control and state trajectories of the optimization results:
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1
Figure 11.1: Optimization results for Batch Reactor model — input variables.
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Figure 11.2: Optimization results for Batch Reactor model — state variables.
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11.4 Different Options for the Optimizer IPOPT

Table 11.1: New meanings of the usual simualtion options for Ipopt.

numberOfIntervals collocation intervals
startTime, stopTime time horizon
tolerance = le-8 e.g. le-8 solver tolerance
simflags all run/debug options

Table 11.2: New simulation options for Ipopt.

v LOG_IPOPT console output

-ipopt_hesse CONST,BFGS,NUM | hessian approximation
-ipopt_max_iter | number e.g. 10 maximal number of iteration for ipopt
externallnput.csv input guess

11.5 Dynamic Optimization with OpenModelica and CasADi

OpenModelica coupling with CasADi supports dynamic optimization of models by OpenModelica exporting
the optimization problem to CasADi which performs the optimization. In order to convey the dynamic system
model information between Modelica and CasADi, we use an XML-based model exchange format for differential-
algebraic equations (DAE). OpenModelica supports export of models written in Modelica and the Optimization
language extension using this XML format, while CasADi supports import of models represented in this format.
This allows users to define optimal control problems (OCP) using Modelica and Optimization language speci-
fications, and solve the underlying model formulation using a range of optimization methods, including direct
collocation and direct multiple shooting.

11.5.1 Compiling the Modelica code

Before exporting a model to XML, the model should be symbolically instantiated by the compiler in order to get
a single flat system of equations. The model variables should also be scalarized. The compiler frontend performs
this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are
applied. Then the complete flattened model is exported to XML code. The exported XML document can then be
imported to CasADi for model-based dynamic optimization.

The OpenModelica command translateModeIXML(ModelName) from OMShell, OMNotebook or MDT exports
the XML. The export XML command is also integrated with OMEdit. Select XML > Export XML the XML
document is generated in the current directory of omc. You can use the cd() command to see the current location.
After the command execution is complete you will see that a file ModeIName.xml has been exported.

Assuming that the model is defined in the modelName.mo, the model can also be exported to an XML code using
the following steps from the terminal window:

* Go to the path where your model file found

* Run command omc -g=Optimica —simCodeTarget=XML Model.mo

11.5.2 An example

In this section, a simple optimal control problem will be solved. When formulating the optimization problems,
models are expressed in the Modelica language and optimization specifications. The optimization language spec-
ification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It
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includes several constructs including a new specialized class optimization, a constraint section, startTime, final-
Time etc. See the optimal control problem for batch reactor model below.

Create a new file named BatchReactor.mo and save it in you working directory. Notice that this model contains
both the dynamic system to be optimized and the optimization specification.

>>> list (BatchReactor)
model BatchReactor

Real x1(start = 1, fixed = true, min = 0, max = 1);
Real x2(start = 0, fixed = true, min = 0, max = 1);
input Real u(min = 0, max = 5);

equation
der(xl) = —(u +u ~ 2 / 2) * x1;
der (x2) = u * x1;

end BatchReactor;

One we have formulated the undelying optimal control problems, we can export the XML by using OMShell,
OMNotebook, MDT, OMEdit or command line terminals which are described in Section XML Import to CasADi
via OpenModelica Python Script.

To export XML, we set the simulation target to XML:

>>> translateModelXML (BatchReactor)
"«DOCHOME»/BatchReactor.xml"

This will generate an XML file named BatchReactor.xml (Listing 11.2) that contains a symbolic representation of
the optimal control problem and can be inspected in a standard XML editor.

Listing 11.2: BatchReactor.xml

<?xml version="1.0" encoding="UTF-8"?>
<OpenModelicaModelDescription
xmlns:exp="https://svn.jmodelica.org/trunk/XML/daeExpressions.xsd"
xmlns:equ="https://svn.jmodelica.org/trunk/XML/daeEquations.xsd"
xmlns: fun="https://svn.jmodelica.org/trunk/XML/daeFunctions.xsd"
xmlns:opt="https://svn.jmodelica.org/trunk/XML/daeOptimization.xsd"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
fmiVersion="1.0"
modelName="BatchReactor"
modelIdentifier="BatchReactor"
guid="{£949381b-d8ef-427d-97b3-2b3ab7398cd7}"
generationDateAndTime="2020-01-13T13:39:17"
variableNamingConvention="structured"
numberOfContinuousStates="2"
numberOfEventIndicators="0"
>

<VendorAnnotations>
<Tool name="OpenModelica Compiler OMCompiler v1.14.1-v1.14.1.2+4g392c27e260"> </
—Tool>
</VendorAnnotations>

<ModelVariables>
<ScalarVariable name="x1" valueReference="0" variability="continuous"
—causality="internal" alias="noAlias">
<Real start="1.0" fixed="true" min="0.0" max="1.0" />
<QualifiedName>
<exp:QualifiedNamePart name="x1"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>

(continues on next page)
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(continued from previous page)

<VariableCategory>state</VariableCategory>

</ScalarVariable>
<ScalarVariable name="x2" valueReference="1" variability="continuous"
—causality="internal" alias="noAlias">
<Real start="0.0" fixed="true" min="0.0" max="1.0" />
<QualifiedName>
<exp:QualifiedNamePart name="x2"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>state</VariableCategory>
</ScalarVariable>
<ScalarVariable name="der (x1)" valueReference="2" variability="continuous"
—causality="internal" alias="noAlias">
<Real />
<QualifiedName>
<exp:QualifiedNamePart name="x1"/>
</QualifiedName>
<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>derivative</VariableCategory>
</ScalarVariable>

<ScalarVariable name="der (x2)" valueReference="3" variability="continuous"
—causality="internal" alias="noAlias">
<Real />
<QualifiedName>
<exp:QualifiedNamePart name="x2"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>derivative</VariableCategory>
</ScalarVariable>

<ScalarVariable name="u" valueReference="4" variability="continuous" |
—causality="input" alias="noAlias">
<Real min="0.0" max="5.0" />
<QualifiedName>
<exp:QualifiedNamePart name="u"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>algebraic</VariableCategory>
</ScalarVariable>
</ModelVariables>

<equ:BindingEquations>
</equ:BindingEquations>

<equ:DynamicEquations>
<equ:Equation>
<exp:Sub>

<exp:Der>

<exp:Identifier>

<exp:QualifiedNamePart name="x2"/>

</exp:Identifier>

</exp:Der>

(continues on next page)
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(continued from previous page)

<exp:Mul>
<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Mul>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Der>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Der>
<exp:Mul>
<exp:Sub>
<exp :Mul>
<exp:Realliteral>-0.5</exp:RealLiteral>
<exp:Pow>
<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
<exp:Realliteral>2.0</exp:RealLiteral>
</exp:Pow>
</exp:Mul>
<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
</exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Mul>
</exp:Sub>
</equ:Equation>
</equ:DynamicEquations>

<equ:InitialEquations>
<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
<exp:RealLiteral>1.0</exp:ReallLiteral>
</exp:Sub>
</equ:Equation>

<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
<exp:RealLiteral>0.0</exp:Realliteral>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Identifier>

(continues on next page)
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<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="SSTART"/>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>

</exp:Sub>
</equ:Equation>
<equ:Equation>

<exp:Sub>

</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="SSTART"/>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
</exp:Sub>
</equ:Equation>
</equ:InitialEquations>

<fun:Algorithm>
</fun:Algorithm>

<fun:RecordsList>
</fun:RecordsList>

<fun:FunctionsList>
</fun:FunctionsList>

<opt:Optimization>
<opt :TimePoints>
<opt:TimePoint >
</opt :TimePoint>
</opt :TimePoints>
<opt:PathConstraints>
</opt :PathConstraints>
</opt:Optimization>

</OpenModelicaModelDescription>

11.5.3 XML Import to CasADi via OpenModelica Python Script

The symbolic optimal control problem representation (or just model description) contained in BatchReactor.xml
can be imported into CasADi in the form of the SymbolicOCP class via OpenModelica python script.

The SymbolicOCP class contains symbolic representation of the optimal control problem designed to be general
and allow manipulation. For a more detailed description of this class and its functionalities, we refer to the API

documentation of CasADi.

The following step compiles the model to an XML format, imports to CasADi and solves an optimization problem
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in windows PowerShell:
1. Create a new file named BatchReactor.mo and save it in you working directory.
E.g. C:\OpenModelical.9.2\share\casadi\testmodel
1. Perform compilation and generate the XML file
a. Go to your working directory
E.g. cd C:\OpenModelical.9.2\share\casadi\testmodel
a. Go to omc path from working directory and run the following command
E.g. .\.\..\bin\omc +s -g=Optimica —simCodeTarget=XML BatchReactor.mo
3. Run defaultStart.py python script from OpenModelica optimization directory
E.g. Python.exe ..\share\casadi\scripts defaultStart.py BatchReactor.xml

The control and state trajectories of the optimization results are shown below:

Input State

— x2
— x1

11.6 Parameter Sweep Optimization using OMOptim

OMOptim is a tool for parameter sweep design optimization of Modelica models. By optimization, one should
understand a procedure which minimizes/maximizes one or more objective functions by adjusting one or more
parameters. This is done by the optimization algorithm performing a parameter swep, i.e., systematically adjusting
values of selected parameters and running a number of simulations for different parameter combinations to find a
parameter setting that gives an optimal value of the goal function.

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow optimizing all sorts of models with
following functionalities:

* One or several objectives optimized simultaneously
* One or several parameters (integer or real variables)

However, the user must be aware of the large number of simulations an optimization might require.

11.6.1 Preparing the Model

Before launching OMOptim, one must prepare the model in order to optimize it.

Parameters

An optimization parameter is picked up from all model variables. The choice of parameters can be done using the
OMOptim interface.

For all intended parameters, please note that:

* The corresponding variable is constant during all simulations. The OMOptim optimization in version
0.9 only concerns static parameters’ optimization i.e. values found for these parameters will be con-
stant during all simulation time.
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¢ The corresponding variable should play an input role in the model i.e. its modification influences
model simulation results.

Constraints

If some constraints should be respected during optimization, they must be defined in the Modelica model itself.

For instance, if mechanical stress must be less than 5 N.m2, one should write in the model:

assert (mechanicalStress < 5, "Mechanical stress too high");

If during simulation, the variable mechanicalStress exceeds 5 N.m2, the simulation will stop and be considered
as a failure.

Objectives

As parameters, objectives are picked up from model variables. Objectives’ values are considered by the optimizer
at the final time.

11.6.2 Set problem in OMOptim

Launch OMOptim

OMOptim can be launched using the executable placed in OpenModelicalnstallationDirectory/bin/ OMOp-
tim/OMOptim.exe. Alternately, choose OpenModelica > OMOptim from the start menu.

Create a new project

To create a new project, click on menu File -> New project

Then set a name to the project and save it in a dedicated folder. The created file created has a .min extension. It
will contain information regarding model, problems, and results loaded.

Load models

First, you need to load the model(s) you want to optimize. To do so, click on Add .mo button on main window or
select menu Model -> Load Mo file. ..

When selecting a model, the file will be loaded in OpenModelica which runs in the background.

While OpenModelica is loading the model, you could have a frozen interface. This is due to multi-threading
limitation but the delay should be short (few seconds).

You can load as many models as you want.
If an error occurs (indicated in log window), this might be because:
* Dependencies have not been loaded before (e.g. modelica library)
* Model use syntax incompatible with OpenModelica.
Dependencies

OMOptim should detect dependencies and load corresponding files. However, it some errors occur, please load
by yourself dependencies. You can also load Modelica library using Model->Load Modelica library.

When the model correctly loaded, you should see a window similar to Figure 11.3.
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 OMOptim m
i Display Tools  About

Project | Optimization | OptCooling | Optimization result (3) | Optimizationresul | OptCooling result | OptCodir P
Project name :  testlinearActuator

Project file C:/Documents and Settings/Sayah/Mes documents)MinesModOptf TestLinear Actuator ftestLinearfctuatonmin

IDocuments and Settings/SayahfMes documentsiMines/ModOptfModelicaTotal. mo
Loaded .ma files : C ,fDacunenls Settings/SayahfMes documentsiMinesModOptiTestLinear Actuator [Linearactuator.mo

Loading project (C:/Documents and Settings/Sayah/Mes documents,Mines/ModOpt | TestLinear Actuator ftestLinearActuator.min) ...
Loading file : C:/Documents and Settings/SayahfMes documents/iMines/ModOptfModelicaTatal. mo
Model loaded successfully™C:/Documents and Settings/SayahfMes documents/iMines/ModOpt/MadelicaTotal, ma"
Loading file : C:/Documents and Settings/SayahfMes documents/Mines/ModOptj TestLinearActuatorLinearactuator mo
Model loaded successfully"C:fDocuments and Settings/SayahfMes documents/Mines/ModOpt/ TestLinearactustor Linearactuator mo®
Loading mode! file (C: fDocuments and SettingsfSayah/Mes documents/Mines/ModOpt | TestLinearAckuator Models/LinearActuatorLinearActuatonmmo) ...
Loading mode! file (C: fDocuments and SettingsfSayah/Mes
documentsMinesModOptf TestLinearActuator/ModelsMadelica, Thermal FluidHeatFlow. Examples, SimpleCooling/testLinear Actuator.mmo) ...
Problem "Optimization™ added to project
Problem "OptCooling” added to project
T P TN s

Mo | OMC | Debug |

Figure 11.3: OMOptim window after having loaded model.
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Create a new optimization problem

Problem->Add Problem->Optimization

A dialog should appear. Select the model you want to optimize. Only Model can be selected (no Package,
Component, Block...).

A new form will be displayed. This form has two tabs. One is called Variables, the other is called Optimization.

(ogm Ene %
Fle  Models Problem Display Tools  About
Models | Problems | [ List of variables ]ou-vmmnrem |_OptCooling result. | OptCooing resuk (2) |
Nasne 1 -]
= {Madebca I | 8 ™\
+ UsersGuide Fiter: | |
+- Blocks ' ng| P .
B Constants Name ¥ | yalue | Description | [ |[OPtimized varisbles @
*+ Electrical
* lcons ossieiacri oy Eng 1 i Name v value Description Data ti
DMh Unesracusortorzos|Bunge,basa o [P——r . 0 [ Selected parameters ]
+ Media Unaartcusatortorgus | Aanga_b phi i LinearActustorspringCamperl.d o - ]
® Slunits o
+ | |3 T E— ]
+ Thermal Line 1 o
2m ur‘g 2 arActuatortongue 1 bearing phi I\ - E]
=i LinearActustor UnearfctuatorsumDaviation _0
* rSD'“;OUN\'WI. LinearActustorsteply o am ™ | Walue | Description | Datatype  ScanMinimum | Scan M
+ finedl -
+ idels T J— 0
+ inertial 1}
- springDamper2 Lineardctustortep] offuet .0 ]
+ inertia2 Linsarictustorstept height o [£] >
+ torquel T
+ stepl el a0 Optimization objectives t] [ i]
ref Linve arActubtorspringDamper? v, 0
sumDesiation = mﬂ To Name Description Direction [ . )
', Linearfictuator. sumbDeviation - Minimize o SEIQCtEd ObJeCtlves
arActusonspringDarmperZ, -
Line phirel a0 i j"' - =
Variobes | Optinization
Log F x
Loading project {C: fDocuments and Setlrl;jSayd‘u’Mes MmﬂijWTesthyﬂcm&umLmuﬂctum miny .. “|
Loading file : C:fDocuments and Settings/Sayah)! d0p i
Model aded successfully"C: fDocuments and Settrmn‘savwm doc {Mod mo”
Loading file : C:/Documents and i DDtITesthearnrr-nmn o
Model loaded successfully™C: /Documents and SeLtn;sJ’Sey&u’Mes documenits/Mines/ModOpt) TestLinearActuator /Linearactuator.mo*
Loading model file (C:/Documents and Settings/SayahjMes documents Mines/ModOpt) TestLinearAchuatar Madels LinearActuabor [Linear Actuator.mma) ...
Luadn; moddfle (i, .Dacuﬂcnts and Scttrm!'Swd‘\l'P'lm
Op TestLi delica. Thermal, FlusdHeatFlow, Examples. SimpheCoclngtestLi e ...
Problem 'Dptmzamn added o project
Problem “OptCookng™ addadbopm)ect =
Broiact lasdina soin) bt
MO | OMC | Debug

Figure 11.4: Forms for defining a new optimization problem.

List of Variables is Empty

If variables are not displayed, right click on model name in model hierarchy, and select Read variables.

Select Optimized Variables

To set optimization, we first have to define the variables the optimizer will consider as free i.e. those that it
should find best values of. To do this, select in the left list, the variables concerned. Then, add them to Optimized

variables by clicking on corresponding button (+).

For each variable, you must set minimum and maximum values it can take. This can be done in the Optimized
variables table.

Select objectives

Objectives correspond to the final values of chosen variables. To select these last, select in left list variables

concerned and click + button of Optimization objectives table.
For each objective, you must:

¢ Set minimum and maximum values it can take. If a configuration does not respect these values, this
configuration won’t be considered. You also can set minimum and maximum equals to “-* : it will
then

* Define whether objective should be minimized or maximized.
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Figure 11.5: Selecting read variables, set parameters, and selecting simulator.

This can be done in the Optimized variables table.

Select and configure algorithm

After having selected variables and objectives, you should now select and configure optimization algorithm. To
do this, click on Optimization tab.

Here, you can select optimization algorithm you want to use. In version 0.9, OMOptim offers three different
genetic algorithms. Let’s for example choose SPEA2Adapt which is an auto-adaptative genetic algorithm.

By clicking on parameters. .. button, a dialog is opened allowing defining parameters. These are:

* Population size: this is the number of configurations kept after a generation. If it is set to 50, your final
result can’t contain more than 50 different points.

* Off spring rate: this is the number of children per adult obtained after combination process. If it is set
to 3, each generation will contain 150 individual (considering population size is 50).

* Max generations: this number defines the number of generations after which optimization should stop.
In our case, each generation corresponds to 150 simulations. Note that you can still stop optimization
while it is running by clicking on stop button (which will appear once optimization is launched).
Therefore, you can set a really high number and still stop optimization when you want without losing
results obtained until there.

¢ Save frequency: during optimization, best configurations can be regularly saved. It allows to analyze
evolution of best configurations but also to restart an optimization from previously obtained results. A
Save Frequency parameter set to 3 means that after three generations, a file is automatically created
containing best configurations. These files are named iteraionl.sav, iteration2.sav and are store in
Temp directory, and moved to SolvedProblems directory when optimization is finished.

ReinitStdDev: this is a specific parameter of EAAdaptl. It defines whether standard deviation of vari-
ables should be reinitialized. It is used only if you start optimization from previously obtained con-
figurations (using Use start file option). Setting it to yes (1) will, in most of cases, lead to a spread
research of optimized configurations, forgetting parameters’ variations’ reduction obtained in previous
optimization.

Use start file

As indicated before, it is possible to pursue an optimization finished or stopped. To do this, you must enable Use
start file option and select file from which optimization should be started. This file is an iteration_.sav file created
in previous optimization. It is stored in corresponding SolvedProblems folder (iterationl0.sav corresponds to the
tenth generation of previous optimization).
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*Note that this functionality can only work with same variables and objectives*. However, minimum, maxi-
mum of variables and objectives can be changed before pursuing an optimization.

Launch

You can now launch Optimization by clicking Launch button.

Stopping Optimization

Optimization will be stopped when the generation counter will reach the generation number defined in parameters.
However, you can still stop the optimization while it is running without loosing obtained results. To do this, click
on Stop button. Note that this will not immediately stop optimization: it will first finish the current generation.

This stop function is especially useful when optimum points do not vary any more between generations. This
can be easily observed since at each generation, the optimum objectives values and corresponding parameters are
displayed in log window.

11.6.3 Results

The result tab appear when the optimization is finished. It consists of two parts: a table where variables are
displayed and a plot region.

Obtaining all Variable Values

During optimization, the values of optimized variables and objectives are memorized. The others are not. To get
these last, you must recomputed corresponding points. To achieve this, select one or several points in point’s list
region and click on recompute.

For each point, it will simulate model setting input parameters to point corresponding values. All values of this
point (including those which are not optimization parameters neither objectives).

11.6.4 Window Regions in OMOptim GUI

142 Chapter 11. Optimization with OpenModelica



OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

Model structure

log

Figure 11.6: Window regions in OMOptim GUI.
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CHAPTER
TWELVE

PARAMETER SENSITIVITIES WITH OPENMODELICA

This section describes the use of OpenModelica to compute parameter sensitivities using forward sensitivity anal-
ysis together with the Sundials/IDA solver.

Note: this is a very short preliminary description which soon will be considerably improved, since this a rather
new feature and will continuous improved.

Note: OpenModelica version 1.10 or newer is required.

12.1 Background

Parameter sensitivity analysis aims at analyzing the behavior of the corresponding model states w.r.t. model
parameters.

Formally, consider a Modelica model as a DAE system:
F(xa j:a Y,p, t) =0 l‘(to) = xo(p)
where z(t) € R™ represent state variables, :(t) € R represent state derivatives, y(t) € R* represent algebraic
variables, p € R™ model parameters.
For parameter sensitivity analysis the derivatives
ox
dp
are required which quantify, according to their mathematical definition, the impact of parameters p on states x. In
the Sundials/IDA implementation the derivatives are used to evolve the solution over the time by:
) Ox
5; =
t o Ops

12.2 An Example

This section demonstrates the usage of the sensitivities analysis in OpenModelica on an example. This module is
enabled by the following OpenModelica compiler flag:

Listing 12.1: LotkaVolterra.mo

model LotkaVolterra
Real x(start=5, fixed=true),y(start=3, fixed=true);
parameter Real mul=5,mu2=2;
parameter Real lambdal=3, lambda2=1;

equation
0 = x* (mul-lambdal*y) - der(x);
0 = —yx (mu2 -lambda2xx) - der(y);

end LotkaVolterra;
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Also for the simulation it is needed to set IDA as solver integration method and add a further simulation flag
—-idaSensitivity to calculate the parameter sensitivities during the normal simulation.

>>> simulate (LotkaVolterra, method="ida", simflags="-idaSensitivity")
record SimulationResult

resultFile = "",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'ida', fileNamePrefix = 'LotkaVolterra', options = '
', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = '—
—idaSensitivity'",

messages = "Simulation execution failed for model: LotkaVolterra
assert | debug | ##IDA## set IDASensInit failed!

n
’

timeFrontend = 0.004848107,

timeBackend = 0.008498055000000001,
timeSimCode = 0.000617557,
timeTemplates = 0.002627817,

timeCompile = 0.376351164
end SimulationResult;

Now all calculated sensitivities are stored into the results mat file under the $Sensitivities block, where all currently
every top-level parameter of the Real type is used to calculate the sensitivities w.r.t. every state.

Error: Unable to execute gnuplot directive

Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)}
[{"." W:(0123..)}] [{W:(eE) W:(0123...,0123...)}]}) | Forward: Group:({{{{{Suppress:("record") Sup-
press:(Forward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with '} "." For-
ward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with *~ ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with ° ending with ’})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting
with * ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with "
| Combine:({ {{["-"] {"0" | W:(1234...,0123..)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1D} |
Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")}} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ° ending with
’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with *} "."} Forward:
..} 1 {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with "}}} | {W:(ABCD...,ABCD...) |
quoted string, starting with * ending with *}})}}) [, Group:({ {{ W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with *} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1}}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with ’} "."} Forward: {{{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with
'} """} Forward: ..} | {W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with "} })}})]...)} Suppress:("end")} Sup-
press:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} "." Forward: ..} |
{W:(ABCD...,ABCD...) | quoted string, starting with *~ ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with > ending with *})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward:
None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")})
| {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " |
Combine:({["-"] {"0" | W:(1234...,0123..)} [{"." W:(0123..)}] [{W:(eE) W:(0123...,0123...)}1})} | Forward:
Group:({ { {{ {Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with
> ending with *} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with > ending with *} "." For-
ward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’}}} | W:(ABCD...,ABCD...)
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| quoted string, starting with * ending with *})} Dict:(Group:({ { { W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with °} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]1} [{W:(eE) W:(0123...,0123..)}1})}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ..} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
'} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with *} "."} Forward:
..} 1 {W:(ABCD...,ABCD...) | quoted string, starting with * ending with "}}} | {W:(ABCD...,ABCD...) |
quoted string, starting with * ending with *}})}}) [, Group:({ {{ W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}1} [{W:(eE) W:(0123...,0123..)}1}}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with ’} "."} Forward: {{{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with
’} """} Forward: ..} | {W:(ABCD..,ABCD...) | quoted string, starting with ° ending with *}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with "}})}})]...)} Suppress:("end")} Sup-
press:(Forward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with ’~ ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with * ending with ’})} Suppress:(";")})} | Group:({ {Suppress:("{") [Forward: None [, For-
ward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Sup-
press:(")" D} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} |
{{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with * ending with °} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with > end-
ing with *} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with * ending with *}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}})} Suppress:(")")} | "true" | "false"
| {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string,
starting with * ending with ’} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with *})} (at char 1), (line:2, col:1) Traceback (most recent call last): File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py", line 1562, in _parseNoCache loc,tokens = self.parselmpl( instring, preloc, doActions
) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3235, in parselmpl result = instring[loc] ==
self.firstQuoteChar and self.re.match(instring,loc) or None IndexError: string index out of range

During handling of the above exception, another exception occurred:

Traceback (most recent call last): File "/var/lib/jenkins/ws/OpenModelica_maintenance_v1.14/doc/UsersGuide/pource/sphinxcont
line 173, in run filename = os.path.abspath(self.options.get(’ filename’) or
omc.sendExpression("currentSimulationResult")) File "/usr/local/lib/python3.6/dist-
packages/OMPython/__init__.py", line 606, in sendExpression answer = OMTypedParser.parseString(result)
File "fusr/local/lib/python3.6/dist-packages/OMPython/OMTypedParser.py", line 120, in parseString return
omcGrammar.parseString(string)[0] File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1828, in
parseString raise exc File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1818, in parseString loc,
tokens = self._parse( instring, 0 ) File "/ust/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in
_parseNoCache loc,tokens = self.parseIlmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 3735, in parselmpl loc, resultlist = self.exprs[0]._parse( instring, loc,
doActions, callPreParse=False ) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py”, line 1562, in
_parseNoCache loc,tokens = self.parselmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 4098, in parselmpl return self.expr._parse( instring, loc, doActions, call-
PreParse=False ) File "/ust/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNo-
Cache loc,tokens = self.parselmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py", line 3917, in parselmpl raise maxException File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 3902, in parselmpl ret = e._parse( instring, loc, doActions ) File
"fusr/local/lib/python3.6/dist-packages/pyparsing.py", line 1564, in _parseNoCache raise ParseException( in-
string, len(instring), self.errmsg, self’) pyparsing.ParseException: Expected {quoted string, starting with " end-
ing with " | Combine:({["-"] {"0" | W:(1234...,0123..)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123..)}1})

12.2. An Example 147



OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

| Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted
string, starting with ° ending with *} "." Forward: {{{W:(ABCD..,ABCD...) | quoted string, start-
ing with * ending with ’} "." Forward: ..} | {W:(ABCD...,ABCD...) | quoted string, starting
with ° ending with ’}}} | W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’})}
Dict:(Group:({ { {W:(ABCD...,ABCD...) | quoted string, starting with > ending with ’} Suppress:("=")} For-
ward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)} }
[{"." W:(0123..)}1} [{W:(eE) W:(0123...,0123...)}1})} | Forward: None} | Group:({{Suppress:("{") [For-
ward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward:
None]...]} Suppress:(")")D} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"}
| "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...)
| quoted string, starting with > ending with *} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with > ending with ’} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with
> ending with *}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with "} })}}) [,
Group:({ {{ W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} Suppress:("=")} Forward:
{{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123..)}} [{"."
W:(0123..)}]} [{W:(eE) W:(0123...,0123...)}1})} | Forward: None} | Group:({{Suppress:("{") [Forward:
None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward:
Nonel]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"}
| "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...)
| quoted string, starting with * ending with ’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with ’ ending with ’} "."} Forward: ..} | {W:(ABCD...,ABCD...) | quoted string, starting with
> ending with *}}} | {W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with "} })} }]...)}
Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
7} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with > ending with ’})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward:
None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")})
| {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " |
Combine:({["-"] {"0" | W:(1234...,0123..)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}1})} | Forward:
Group:({ { { { {Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with
> ending with *} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with > ending with *} "." For-
ward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with > ending with ’}}} | W:(ABCD...,ABCD...)
| quoted string, starting with ° ending with })} Dict:(Group:({ { {W:(ABCD...,ABCD...) | quoted string,
starting with > ending with *} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({ {{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}1} [{W:(eE) W:(0123...,0123..)}1})}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ..} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
'} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with *} "."} Forward:
..} 1 {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with *}}} | {W:(ABCD...,ABCD...)
| quoted string, starting with * ending with }})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted
string, starting with > ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting
with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE)
W:(0123...,0123...)}1})} | Forward: None} | Group:({ {Suppress:("{") [Forward: None [, Forward: None]...]}
Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} |
{{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE"
Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting
with * ending with *} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending
with ’} "."} Forward: ..} | {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}}}
| {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}})}})]...)} Suppress:("end")}
Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with *~ ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with * ending with *})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [,
Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]}
Suppress:(")" )P} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"}
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| {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted
string, starting with > ending with "} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with
* ending with ’} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with > ending with "}}}
| {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with *}})} Suppress:(")")} | "true" | "false"
| {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string,
starting with > ending with *} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with * ending
with ’})} (at char 1), (line:2, col:1)

Error: Unable to execute gnuplot directive

Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)}
[{"." W:(0123..)}] [{W:(eE) W:(0123...,0123...)}]1}) | Forward: Group:({{{{{Suppress:("record") Sup-
press:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} "." Forward: ..} |
{W:(ABCD...,ABCD...) | quoted string, starting with * ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with ° ending with ’})} Dict:(Group:({{ {W:(ABCD...,ABCD...) | quoted string, starting
with * ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with "
| Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1D} |
Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")}} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with
1 "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with "} "."} Forward:
..} 1 {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with "}}} | {W:(ABCD...,ABCD...) |
quoted string, starting with * ending with "} })}}) [, Group:({ {{ W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with *} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]} [{W:(eE) W:(0123...,0123..)}1})}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with ’} "."} Forward: {{{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with
'} """} Forward: ..} | {W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with * ending with "} })}})]...)} Suppress:("end")} Sup-
press:(Forward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ..} |
{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with > ending with ’})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward:
None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")})
| {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " |
Combine:({["-"] {"0" | W:(1234...,0123..)} [{"." W:(0123..)}] [{W:(eE) W:(0123...,0123...)}1})} | Forward:
Group:({ { {{ {Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with
> ending with *} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with *} "." For-
ward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’}}} | W:(ABCD...,ABCD...)
| quoted string, starting with * ending with *})} Dict:(Group:({ { {W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1D}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with *} "."} Forward:
..} 1 {W:(ABCD...,ABCD...) | quoted string, starting with * ending with *}}} | {W:(ABCD...,ABCD...) |
quoted string, starting with * ending with *}})}}) [, Group:({ {{ W:(ABCD...,ABCD...) | quoted string, start-
ing with * ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1D}
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| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")}} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with ’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
'} "."} Forward: ..} | {W:(ABCD..,ABCD...) | quoted string, starting with ° ending with *}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with * ending with *}})}})]...)} Suppress:("end")} Sup-
press:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with '} "." For-
ward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with *}}} | W:(ABCD...,ABCD...) | quoted
string, starting with * ending with ’})} Suppress:(";")})} | Group:({ {Suppress:("{") [Forward: None [, For-
ward: None]...]} Suppress:("}")})} | Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Sup-
press:(")"M D} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} |
{{"NONE" Suppress:("(")} Suppress:(")")} } | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with > ending with *} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with > end-
ing with *} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with > ending with *}}} |
{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}})} Suppress:(")")} | "true" | "false"
| {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string,
starting with * ending with ’} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ’ end-
ing with *})} (at char 1), (line:2, col:1) Traceback (most recent call last): File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py"”, line 1562, in _parseNoCache loc,tokens = self.parseImpl( instring, preloc, doActions
) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3235, in parselmpl result = instring[loc] ==
self.firstQuoteChar and self.re.match(instring,loc) or None IndexError: string index out of range

During handling of the above exception, another exception occurred:

Traceback (most recent call last): File "/var/lib/jenkins/ws/OpenModelica_maintenance_v1.14/doc/UsersGuide/pource/sphinxcont
line 173, in run filename = os.path.abspath(self.options.get(’filename’) or
omc.sendExpression("currentSimulationResult")) File "/usr/local/lib/python3.6/dist-
packages/OMPython/__init__.py", line 606, in sendExpression answer = OMTypedParser.parseString(result)
File "/usr/local/lib/python3.6/dist-packages/OMPython/OMTypedParser.py", line 120, in parseString return
omcGrammar.parseString(string)[0] File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1828, in
parseString raise exc File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1818, in parseString loc,
tokens = self._parse( instring, 0 ) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in
_parseNoCache loc,tokens = self.parselmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 3735, in parselmpl loc, resultlist = self.exprs[0]._parse( instring, loc,
doActions, callPreParse=False ) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py”, line 1562, in
_parseNoCache loc,tokens = self.parselmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 4098, in parselmpl return self.expr._parse( instring, loc, doActions, call-
PreParse=False ) File "/usr/local/lib/python3.6/dist-packages/pyparsing.py”, line 1562, in _parseNo-
Cache loc,tokens = self.parselmpl( instring, preloc, doActions ) File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 3917, in parselmpl raise maxException File "/usr/local/lib/python3.6/dist-
packages/pyparsing.py”, line 3902, in parselmpl ret = e._parse( instring, loc, doActions ) File
"fusr/local/lib/python3.6/dist-packages/pyparsing.py", line 1564, in _parseNoCache raise ParseException( in-
string, len(instring), self.errmsg, self ) pyparsing.ParseException: Expected {quoted string, starting with " end-
ing with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...))}] [{W:(eE) W:(0123...,0123...))}1})
| Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted
string, starting with ° ending with ’} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, start-
ing with ’ ending with ’} "." Forward: ..} | {W:(ABCD..,ABCD..) | quoted string, starting
with > ending with "}}} | W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’})}
Dict:(Group:({ { {W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} Suppress:("=")} For-
ward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}}
[{"." W:(0123...)}1} [{W:(eE) W:(0123...,0123...)}1})} | Forward: None} | Group:({{Suppress:("{") [For-
ward: None [, Forward: None]...]} Suppress:("}")})} | Group:({ {Suppress:("(") [Forward: None [, Forward:
Nonel]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"}
| "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...)
| quoted string, starting with * ending with ’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with > ending with *} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with
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> ending with "}}} | {W:(ABCD...,ABCD...) | quoted string, starting with * ending with "}})}}) [,
Group:({ {{W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} Suppress:("=")} Forward:
{{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123..)}} [{"."
W:(0123..)}1} [{W:(eE) W:(0123...,0123...)}1})} | Forward: None} | Group:({{Suppress:("{") [Forward:
None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward:
Nonel]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"}
| "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...)
| quoted string, starting with * ending with ’} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string,
starting with ° ending with ’} "."} Forward: ..} | {W:(ABCD...,ABCD...) | quoted string, starting with
> ending with "}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}})} }]...)}
Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with > ending with
7} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with "}}} | W:(ABCD...,ABCD...) | quoted
string, starting with > ending with ’})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward:
None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")})
| {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " |
Combine:({["-"] {"0" | W:(1234...,0123..)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}1})} | Forward:
Group:({ { {{ {Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with
> ending with °} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with > ending with ’} "." For-
ward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with * ending with ’}}} | W:(ABCD...,ABCD...)
| quoted string, starting with ° ending with ’})} Dict:(Group:({ {{ W:(ABCD...,ABCD...) | quoted string,
starting with * ending with *} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with
" | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123..)}]1} [{W:(eE) W:(0123...,0123..)}1})}
| Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} |
Group:({ {Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME")
Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Sup-
press:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with
7} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with *} "."} Forward:
..} I {W:(ABCD...,ABCD...) | quoted string, starting with * ending with "}}} | {W:(ABCD...,ABCD...)
| quoted string, starting with * ending with ’}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted
string, starting with ’ ending with ’} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting
with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE)
W:(0123...,0123...)}1})} | Forward: None} | Group:({ { Suppress:("{") [Forward: None [, Forward: None]...]}
Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} |
{{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE"
Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting
with > ending with *} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending
with ’} "."} Forward: ..} | {W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’}}}
| {W:(ABCD...,ABCD...) | quoted string, starting with * ending with *}})}})]...)} Suppress:("end")}
Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ’ ending with ’} "." For-
ward: {{{W:(ABCD..,ABCD...) | quoted string, starting with ’ ending with ’} "." Forward: ...} |
{W:(ABCD...,ABCD...) | quoted string, starting with > ending with *}}} | W:(ABCD...,ABCD...) | quoted
string, starting with * ending with *})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [,
Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]}
Suppress:(")" )P} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"}
| {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted
string, starting with * ending with *} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with
> ending with ’} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with > ending with *}}}
| {W:(ABCD...,ABCD...) | quoted string, starting with > ending with *}})} Suppress:(")")} | "true" | "false"
| {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string,
starting with * ending with *} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with * ending
with ’})} (at char 1), (line:2, col:1)
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CHAPTER
THIRTEEN

PDEMODELICA1

PDEModelical is nonstandardised experimental Modelica language extension for 1-dimensional partial differen-
tial extensions (PDE).

It is enabled using compiler flag ——grammar=PDEModelica. Compiler flags may be set e.g. in OMEdit
(Tools->Options->Simulation->OMC Flags) or in the OpenModelica script using command

13.1 PDEModelical language elements

Let us introduce new PDEModelical language elements by an advection equation example model:

model Advection "advection equation"
parameter Real pi = Modelica.Constants.pi;

parameter DomainLineSegmentlD omega(L = 1, N = 100) "domain";
field Real u(domain = omega) "field";
initial equation
u = sin(2xpi*romega.x) "ICc";
equation
der (u) + pder(u,x) = 0 indomain omega "PDE";
u =0 indomain omega.left "BC";
u = extrapolateField(u) indomain omega.right "extrapolation";

end Advection;

Error:

[<interactive>:4:14-4:14:writable] Error: Missing token: SEMICOLON

The domain omega represents the geometrical domain where the PDE holds. The domain is defined using the
built-in record DomainLineSegment 1D. This record contains among others L — the length of the domain, N —
the number of grid points, x — the coordinate variable and the regions left, right and interior, representing
the left and right boundaries and the interior of the domain.

The field variable u is defined using a new keyword field. The domain is a mandatory attribute to specify the
domain of the field.

The indomain operator specifies where the equation containing the field variable holds. It is utilised in the initial
conditions (IC) of the fields, in the PDE and in the boundary conditions (BC). The syntax is

anEquation indomain aDomain.aRegion;

If the region is omitted, interior is the default (e.g. the PDE in the example above).

The IC of the field variable u is written using an expression containing the coordinate variable omega . x.
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The PDE contains a partial space derivative written using the pder operator. Also the second derivative is allowed
(not in this example), the syntax is e.g. pder (u, x, x) . It is not necessary to specify the domain of coordinate
in pder (to write e.g. pder (u, omega.x), even though x is a member of omega.

13.2 Limitations

BCs may be written only in terms of variables that are spatially differentiated currently.

All fields that are spatially differentiated must have either BC or extrapolation at each boundary. This extrapolation
should be done automatically by the compiler, but this has not been implemented yet. The current workaround is
the usage of the extrapolateField () operator directly in the model.

If-equations are not spported yet, if-expressions must be used instead.

13.3 Viewing results

During translation field variables are replaced with arrays. These arrays may be plotted using Array Plot or even
better using Array Parametric Plot (to plot x-coordinate versus a field).
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CHAPTER
FOURTEEN

MDT — THE OPENMODELICA DEVELOPMENT TOOLING ECLIPSE
PLUGIN

14.1 Introduction

The Modelica Development Tooling (MDT) Eclipse Plugin as part of OMDev — The OpenModelica Development
Environment integrates the OpenModelica compiler with Eclipse. MDT, together with the OpenModelica com-
piler, provides an environment for working with Modelica and MetaModelica development projects. This plugin
is primarily intended for tool developers rather than application Modelica modelers.

The following features are available:
* Browsing support for Modelica projects, packages, and classes
* Wizards for creating Modelica projects, packages, and classes
* Syntax color highlighting
* Syntax checking
* Browsing of the Modelica Standard Library or other libraries
¢ Code completion for class names and function argument lists
* Goto definition for classes, types, and functions

* Displaying type information when hovering the mouse over an identifier.

14.2 Installation

The installation of MDT is accomplished by following the below installation instructions. These instructions
assume that you have successfully downloaded and installed Eclipse (http://www.eclipse.org).

The latest installation instructions are available through the OpenModelica Trac.
1. Start Eclipse
Select Help->Software Updates->Find and Install... from the menu
Select ‘Search for new features to install” and click ‘Next’
Select ‘New Remote Site...’
Enter ‘MDT’ as name and http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT as URL and click
‘0K’
Make sure ‘MDT"’ is selected and click ‘Finish’
In the updates dialog select the ‘MDT’ feature and click ‘Next’

ok »D

Read through the license agreement, select ‘I accept...” and click ‘Next’

Click ‘Finish’ to install MDT

v »® =N
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14.3 Getting Started

14.3.1 Configuring the OpenModelica Compiler
MDT needs to be able to locate the binary of the compiler. It uses the environment variable OPENMODELICA-
HOME to do so.

If you have problems using MDT, make sure that OPENMODELICAHOME is pointing to the folder where the
OpenModelica Compiler is installed. In other words, OPENMODELICAHOME must point to the folder that
contains the Open Modelica Compiler (OMC) binary. On the Windows platform it’s called omc.exe and on Unix
platforms it’s called omc.

14.3.2 Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the Modelica perspective. To switch to
the Modelica perspective, choose the Window menu item, pick Open Perspective followed by Other... Select the
Modelica option from the dialog presented and click OK..

14.3.3 Selecting a Workspace Folder

Eclipse stores your projects in a folder called a workspace. You need to choose a workspace folder for this session,
see Figure 14.1.

14.3.4 Creating one or more Modelica Projects

To start a new project, use the New Modelica Project Wizard. It is accessible through File->New-> Modelica
Project or by right-clicking in the Modelica Projects view and selecting New->Modelica Project.

You need to disable automatic build for the project(s) (Figure 14.3).

Repeat the procedure for all the projects you need, e.g. for the exercises described in the MetaModelica users
guide: 01_experiment, 02a_expl, 02b_exp2, 03_assignment, 04a_assigntwotype, etc.

NOTE: Leave open only the projects you are working on! Close all the others!

14.3.5 Building and Running a Project

After having created a project, you eventually need to build the project (Figure 14.4).

The build options are the same as the make targets: you can build, build from scratch (clean), or run simulations
depending on how the project is setup. See Figure 14.5 for an example of how omc can be compiled (make omc
builds OMC).

14.3.6 Switching to Another Perspective

If you need, you can (temporarily) switch to another perspective, e.g. to the Java perspective for working with an
OpenModelica Java client as in Figure 14.7.

14.3.7 Creating a Package

To create a new package inside a Modelica project, select File->New->Modelica Package. Enter the desired name
of the package and a description of what it contains. Note: for the exercises we already have existing packages.

156 Chapter 14. MDT - The OpenModelica Development Tooling Eclipse Plugin



OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

& Modelica - Eclipse

File Edit Mavigate Search Project Run Window Help

New Shift+Alt+N  » |1 @& 4 ¥ !
Open File..

= | Refresh =5

Convert Line Delimiters To *

Switch Workspace r Other..
Restart

£ Import...
g Export...

Properties Alt+Enter

1 BouncingBall.mo [demo]
2 Absyn.mo [OpenModelica/OMCompiler/...]
2 MultiBall.mo [demo]

4 BouncingBall.mo [demo]

Exit

Figure 14.1: Eclipse Setup — Switching Workspace.
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Create a Modelica project

Create a Modelica project in the workspace.

Project name: | demo

l\'_?) Cancel Finish

Figure 14.2: Eclipse Setup — creating a Modelica project in the workspace.
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¢ Modelica - Eclipse

File Edit Navigate Search Project Run Window Help

Close Project

B Build Al
Build Project
Build Working Set
Cle;

Build Automatically

» M BouncingBall.mo |
» M MultiBall.mo R pEl
¥ M VanDerPol.mo
(X| .project
b = Libraries
k Qg:v OpenModelica [OpenModelics

Figure 14.3: Eclipse Setup — disable automatic build for the projects.

¢ Modelica - Eclipse

File Edit MNavigate Search Project Run Window Help

Close Project

B euild Al
Build Project

Build Working Set

b & .externalToolBuilders

[ T, | NN EAEY

Figure 14.4: Eclipse MDT — Building a project.
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Please input a value

omc

Cancel OK

Figure 14.5: Eclipse — building a project.

& console 8 L = g

X % B H@® - =
<terminated= make [Program] /usr/binfmake
B (T i ettt O
Jsusr/bin/make -f Makefile --no-print-directory -C Jhome/marsj/0OpenModelicas0MCompiler/
make[5]: Nothing to be done for 'all'.
Jusr/bins/make -T Makefile --no-print-directory -C shome/marsj/OpenModelicas0OMCompiler/
make[5]: Nothing to be done for 'all'.
susr/bin/make - Makefile Makefile.sources
make[4]: 'Makefile.sources' 1is up to date.
Jsusr/bin/make - Makefile interfaces INCLUDESOURCES=1
shomesmars]/0penModelicasbuild/binsomec +n=1 build/Absyn.stamp.mo.mos
Jusr/bins/make -T Makefile Makefile.depends INCLUDESOURCES=1
make[4]: 'Makefile.depends' 1is up to date.
susr/bins/make -T Makefile generate-files INCLUDESOURCES=1 INCLUDEDEPENDS=1
Jhomesmarsj/0penModelicasbuild/bin/omec +n=1 build/Absyn.stamp.mos
susr/bin/make - Makefile --no-print-directory install INCLUDESOURCES=1
clang -g -02 -fno-stack-protector -TPIC -I"/homesmars]j/0penModelicasbuild/includesomc/
clang -shared -Wl,-z,origin -W1, -rpath, '$0RIGIN/. . /1ib/x86_64-1linux-gnusomc' -W1, -rpat
test ! ".so0" = ".dylib" || install_name_tool -id @rpath/libOpenModelicaCompiler.dylib
clang build/_main.o -W1l,-z,origin -W1, -rpath, '$ORIGIN/../1ib/xB6_64-1linux-gnusomc' -Wl
cp -a build/OpenModelicaScriptingAPI.h /shomesmarsj/0penModelicasbuild/includesomcs/scri
cp -a buildfomc Shome/marsj/0penModelicas/builds/bins

Figure 14.6: Eclipse — building a project, resulting log.
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& Modelica - Eclipse

File Edit MNavigate Searc Run Window Help
NNy B~ EE New Window : ¥
Editor b
Hide Toolbar
GE Modelica Proj X = 0O Open Perspective 3 1+ Debug
0% v Show View v+ BB Modelica

. . [ ————
v (& demo Customize Perspective...

Save Perspective As..

BouncingBall.mo

. BouncingBall Reset Perspective...

> MultiB all.mo Close Perspective
B VanDerPol.mo Close All Perspectives

[X] project Mavigation b
> =k Libraries Preferences

b Qg = OpenModelica [OpenModelic

Figure 14.7: Eclipse — Switching to another perspective — e.g. the Java Perspective.

14.3.8 Creating a Class

To create a new Modelica class, select where in the hierarchy that you want to add your new class and select
File->New->Modelica Class. When creating a Modelica class you can add different restrictions on what the class
can contain. These can for example be model, connector, block, record, or function. When you have selected
your desired class type, you can select modifiers that add code blocks to the generated code. ‘Include initial code
block’ will for example add the line ‘initial equation’ to the class.

14.3.9 Syntax Checking

Whenever a build command is given to the MDT environment, modified and saved Modelica (.mo) files are
checked for syntactical errors. Any errors that are found are added to the Problems view and also marked in the
source code editor. Errors are marked in the editor as a red circle with a white cross, a squiggly red line under the
problematic construct, and as a red marker in the right-hand side of the editor. If you want to reach the problem,
you can either click the item in the Problems view or select the red box in the right-hand side of the editor.

14.3.10 Automatic Indentation Support

MDT currently has support for automatic indentation. When typing the Return (Enter) key, the next line is indented
correctly. You can also correct indentation of the current line or a range selection using CTRL+I or “Correct
Indentation” action on the toolbar or in the Edit menu.

14.3.11 Code Completion

MDT supports Code Completion in two variants. The first variant, code completion when typing a dot after a class
(package) name, shows alternatives in a menu. Besides the alternatives, Modelica documentation from comments
is shown if is available. This makes the selection easyer.
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New Modelica Package

Modelica Package -

Create a new Modelica package.

Source folder: | PPC970 | | Browse...
Name: Core

Description: |This package contains the core stuff

[ ] is encapsulated package

Finish || Cancel

Figure 14.8: Creating a new Modelica package.
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New Modelica Class

Modelica Class

Create a new Modelica class.

Source folder: | PPCO70/Core | | Browse...
Name: ALU
Type: block hd |

Modifiers: include initial equation block
[ ] is partial class

[l

Finish || Cancel

Figure 14.9: Creating a new Modelica class.
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Modelica - ALU.mo - Eclipse SDK
File Edit Mavigate Search Project S5WT Hierarchy Run Window Help

| ea~ E X BN 7 | % Modelica|  »

| % =~

“ = o - -
%’ Modeli... 2 B ALU.me =
¥ 2 PPCO70 block ALU “lm

=
& Core equation

M ALU.mo .

M package.mo D inital equation
.project

end ALU; ;
[» =i System Library al |r]u
¥ —*l - =9 )
Console [£i Problems 2 = B
2 errors, 0 warnings, 0 infos
Description Resource |In Folder Location

(X unexpected token  ALU.mo PPCO970/Core  line 5
@ unexpected token  ALU.mo PPCO970/Core  line 5

L] NE3EN | 1+

Figure 14.10: Syntax checking.

= Modelica - DCEngine.mo - Eclipse SDK
File Edit Refactor Mavigate Search Run Projeck  Window Help

IB-Held | Q- |+ [eoe-a -

3 T
(v Modelica Projects 53 = 0| vl *oCEngine.ma &2
El{ﬁ EngineSimulation “model DCEngine
#- M| DCEngine.ma import Hudelica.l
o -projeck equation
i Blocks
[=1-m Standard Library gc ot
: ' onstants
ElEE Edelhcaks end DCEngine: 8 Electrical
-3 Bloc
#f3 Constants £ 1c0ns
i+ Electrical £ Math
- H Ieons B3 Mechanics
= H3 Math £ sIunits
Ce [ oacos B Thermal
- asin
- atan
#- - atan2
[~ baselcani

Figure 14.11: Code completion when typing a dot.
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The second variant is useful when typing a call to a function. It shows the function signature (formal param-
eter names and types) in a popup when typing the parenthesis after the function name, here the signature Real
sin(SI.Angle u) of the sin function:

= Modelica - DCEngine.mo - Eclipse SDK
File Edit Refactor Mavigate Search Fun Project  Windomw  Help

L={_|}'|_|3_|[; nt %" ‘C,:l;' ’E:Zl{::"

(M Madelica Projects 52 =0 *DCEngine. mo o
- Iﬁ EngineSimulation model DCEngine
+ DCEngine. mo import Modelica.Math.*;
=] .project output Feal x:
—|--=, Standard Library equation
= £ Modelica Real sin{51Angle U} |
+- £ Blocks % o= gimf
+- 3 Constants
+-H3 Electrical -
end DCEngine;
+-f4 Icons d

Figure 14.12: Code completion at a function call when typing left parenthesis.

14.3.12 Code Assistance on Identifiers when Hovering

When hovering with the mouse over an identifier a popup with information about the identifier is displayed. If the
text is too long, the user can press F2 to focus the popup dialog and scroll up and down to examine all the text. As
one can see the information in the popup dialog is syntax-highlighted.

1
B &'Java | [ Modelica

M BouncingBall.mo 1] px] = "
g

1- model MultiBall
2 BouncingBall balls[3];
3 en ST

model BouncingBall "A simple bouncing ball"
parameter Real e B.7 "coefficient of restitution";
parameter Real g 9.81 "gravity acceleration";
Real h{start = 1) "height of ball";
Real v "velocity of ball";
Boolean Tlying(start = true) "Crue, if ball is fTlying";
Boolean impact;
Real v_new;
Integer foo;
equation
impact = h == 0.08;

Press F2 to focus,

Figure 14.13: Displaying information for identifiers on hovering.

14.3.13 Go to Definition Support

Besides hovering information the user can press CTRL+click to go to the definition of the identifier. When
pressing CTRL the identifier will be presented as a link and when pressing mouse click the editor will go to the
definition of the identifier.
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14.3.14 Code Assistance on Writing Records

When writing records, the same functionality as for function calls is used. This is useful especially in MetaMod-
elica when writing cases in match constructs.

= &’ Java | B Modelica|

*Absyn.mo = O

end FuncT; -
6462 algorithm

6463 outArgs := match outArgs

6464 case FUNCTIONARGS()

6465 algorithm

6466 outArgs.args := list(inFunc{arg, inArg) for arg in outArgs.args);

5467 then

6468 outArgs;
6469 FOR_ITER_FARGI(ExXp exp, ReductionlterType iterType, Forlterators iterators)
6470 case FOR_ITER_FARG(
6471 algorithm

6472 outArgs.exp := inFunc(outArgs.exp, inArg);

6473 outArgs.iterators := list(traverseExpShallowlterator(it, inArg, inFunc
6474 for it in outArgs.iterators);

6475 then

G6ATE outArgs;

G478 end match;
6479 end traverseExpShallowFunchArgs;

Figure 14.14: Code assistance when writing cases with records in MetaModelica.

14.3.15 Using the MDT Console for Plotting
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¢ Modelica - Eclipse

File Edit MNavi
Oy E v A - N R L W = ! Correct Indentation | Build project

B  &'Java | @ Modelica)
[ Modelica Projects = g BouncingBall. mo = g

1= model BouncingBall

2 parameter Real e=0.7 "coefficient of restitution";
parameter Real g=9.81 "gravity acceleration";

Real h(start=1) "height of ball";

Real v "wvelocity of ball";

Boolean flying(start=true) "true, 1f ball is flying";
Boolean impact;

Real v_new;

Integer foo;

2% ¥
> (M demo

equation
impact = h <= 8.8;
foo = if impact then 1 else 2;
der(v) = if flying then -g else @;
der(h) = v;
when {h <= 0.6 and v <= ©.8, impact} then
v_new = if edge(impact) then -e*pre(v) else 0;
flying = v_new > 0;
reinit(v, v_new);
end when;
5= Outline 2 v = 0
mmed DrimedinaDal1 .

An outline is not available.

[*! Problems & conscle 2 [JlBookmarks sgP

I
No consoles to display at this time. 1 Java Stack Trace Console
m2 2 Maven Console
B3 cvs
4 New Console View

[
DT Console

Figure 14.15: Activate the MDT Console.
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[

File Edit

[Ff Modelica Projects =

=3
¥ (& demo
» [ BouncingBall.mo
» [M VanDerPol.mo
|¥] project
b = Libraries

5= Outline =

B W ¥ w X
v BouncingBall

° e

o flying

o foo

g

@ h

@ impact

o v

© v_new

Run  Window Help

& & iava | BB Modelica |

[M| BouncingBall.mo 52

1= model BouncingBall

2 parameter Real e=0.7 "coefficient of restitution";
parameter Real g=9.81 "gravity acceleration";
Real h(start=1) "height of ball";

Real v "velocity of ball";

oo W

= 0

3

3] Boolean flying(start=true) "true, if ball is flying";
7 Boolean impact; ¢ OMPlot - OpenModelica
8 Real v_new; - -
] Integer foo; File Options
10 Zoom | Pan || AutoScale | Fitin View
equation
12 impact = h <= ©8.0; __
13 Too = 1T impact then 1 else 2;
der(v) = if flying then -g else 0; 1
5 der(h) = v; 08 35
0.6 5
17 when {h <= 0.0 and v <= 0.0,impact} then 0.4 4
18 v_new = if edge(impact) then -e*pre(v) else € p 3 \ /
flying = v_new > 0; V=
20 reinit{wv, v_new);
21 end when; 1] 0.5 1 15 2 25 3
22 time
D7 smel DoomecdinaDa11 .
|2 Problems B console __|].|E‘.:--:-I<m-arl<3 Progress IE™ =~ (| (]
OpenModelica Console
omc> simulate(BouncingBall, stopTime=3.8)
record SimulationResult
resultFile = "/tmp/BouncingBall_res.mat",
simulationOptions = "startTime = 0.8, stopTime = 3.8, numberOfIntervals = 500, toler
messages = "',

timeFrontend = @.010819273,
timeBackend = 0.801918553,
time5imCode = 0.011189793,
timeTemplates = 0.Q007479943,
timeCompile = 1.035183591,
timeSimulation = @.813518222,
timeTotal = 1.080146115

end SimulationResult;

omc> plot(h)

Figure 14.16: Simulation from MDT Console.
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CHAPTER
FIFTEEN

MDT DEBUGGER FOR ALGORITHMIC MODELICA

The algorithmic code debugger, used for the algorithmic subset of the Modelica language as well as the Meta-
Modelica language is described in Section The Eclipse-based Debugger for Algorithmic Modelica. Using this
debugger replaces debugging of algorithmic code by primitive means such as print statements or asserts which
is complex, time-consuming and error- prone. The usual debugging functionality found in debuggers for proce-
dural or traditional object-oriented languages is supported, such as setting and removing breakpoints, stepping,
inspecting variables, etc. The debugger is integrated with Eclipse.

15.1 The Eclipse-based Debugger for Algorithmic Modelica

The debugging framework for the algorithmic subset of Modelica and MetaModelica is based on the Eclipse
environment and is implemented as a set of plugins which are available from Modelica Development Tooling
(MDT) environment. Some of the debugger functionality is presented below. In the right part a variable value is
explored. In the top-left part the stack trace is presented. In the middle-left part the execution point is presented.

The debugger provides the following general functionalities:
* Adding/Removing breakpoints.
» Step Over — moves to the next line, skipping the function calls.
* Step In — takes the user into the function call.

¢ Step Return — complete the execution of the function and takes the user back to the point from where
the function is called.

* Suspend — interrupts the running program.

15.1.1 Starting the Modelica Debugging Perspective

To be able to run in debug mode, one has to go through the following steps:
* create a mos file
* setting the debug configuration
* setting breakpoints
* running the debug configuration

All these steps are presented below using images.

Create mos file

In order to debug Modelica code we need to load the Modelica files into the OpenModelica Compiler. For this we
can write a small script file like this:
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& Debug - trunk/Compiler/FrontEnd /Inst.mo - Eclipse SDK (=] 3]
File Edit Mavigate Search Project Run Window Help
J - (=] ‘ o1 J -0 -G - J [ I J - - L b J Correct Indentation | Build project it ﬁDEhug >
%5 Debug 23 [ 7] | 2 TR | i = = O [t Variables 52 %o Ereakpomts} k5 | = =0
% moT coB [Modelica Developement Tooling (MOT) GDE] 2| _Name | Dedared Type | Value <
EJ@ MOT @ cache record<Env.Cache.CACHE>  record<Env.Cache.CACHE
o Main Thread (stepping) @ e record<5CodeRestriction.R... record=<5Code.Restriction.
= instClassdef2 at Inst.mo: 3434 ¥ pre record<Prefix.Prefic NOPRE> | record <Prefix.Prefix NOPR
= instClassdef at Inst.mo:3075 E @ eqgs list<record<5Code.Equatio... <2 items>
= instClassIn_ dispatch at Inst.mo:2140 B @ [1] record«<5Code.Equation.EQ...  record<5Code.Equation.E
= instClassIn at Inst.mo: 1813 = % eEquation record<5Code.EEquation.E... | record<5Code.EEquation.t
= instClass at Inst.mo: 1233 = & expleft record < Absyn Exp.CREF> record < Absyn.Bxp. CREF=
= instProgram at Inst.mo: 1055 1 E % compenentRe record<Absyn.Component...  record<Absyn.Componen
= instProgram at Inst.mo: 1085 # name String "
= instantiate at Inst.mo:227 @ subscripts list<Any> <0 item>
= instantizte at Main.mo:693 LI E % expRight record<Absyn.Exp.CALL> record = Absyn.Exp. CALL>
- @ function.  record<Absyn.Component... record<Absyn.Componen
Instmo &2 Interactive.mo W QuotedFunction.mo a4 = @ functionArgs record<Absyn.FunctionArg... record<Absyn.FunctionAr
normaldlgorithmLst = alg, initialBlgorithml | @ _mmme"‘t Option<Any> NONEQ
re,vis, , ,inst dims,impl,callscope,graph,csecs, instSingl ¥ % info record<AbsynInfoINFO> | record<Absyn.nfoINFO>
equation - - B & [2] record<SCode.Equation.EQ... record<S5Code.Equation.El
false = Util.getStatefulBoolean (stopInst); 1 = % eEquation record<5Code.EEquation.E.. | record<5Code.EEquation.
UnitParserExt.checkpoint () ; @ expleft record<Absyn.Exp.CREF> | record<Absyn.Exp.CREF> _|
//Debug.craceln (" Instclassdef for: " +& PrefixUtil.print @ expRight recc!rd‘cAbsyn‘E(p.CALLb record<Absyn.Bxp . CALL>
ci statel = ClassInf.trans(ci state, ClassInf.NEWDEE()): @ comment Option<Any> NONEQ
els = extractConstantPlusDeps (els,instSingleCref, {},class H @ info record<Absyn.Info INFO > record < Absyn.Info INFO=>
@ fileName String "Abs.mo"
/ split elements % lineNumberSt Integer 12
(cdefelts, extendsclasselts, extendselts, compelts) = splitE @ columnNumk Integer 3
@ lineNumberEr Integer 12
extendselts = SCodeUtil.addRedeclareAsElementsToExtends (e @ columnNumt Integer 17
- E @ buildTimes  record<Absyn.TimeStamp.... record<Absyn. TimeStamp
4] | 3 ¥ lastBuildTi Real 0
~ @ lastEditTin Real 0
£ s y =
B Console 5 \ﬁ,TasksW [2¢ Pmb‘qu G Execu‘table;] = ¥ els list<record<SCode.Element... <2 items>
MDT GDB [Modelica Developement Tooling (MOT) GDB] C:\OpenModelica\trunk\testsuite \bootstrapping'main.exe || = < ci_state record<ClassInf. State,MOD... record«<ClassInf.State.MOL
] [ B gH| &&=t B - 13 - El % path record<Absyn.PathIDENT>  record<Absyn.PathIDENT
;l @ name String "Abs"
@ csets record<Connect. Sets. SETS> | record<Connect.Sets.SETS
= @ initalg list<Any> <0 item= =
K . [ - | R =
e

Ll ‘ Writable

Insert

|3494:27

| OpenModelica C....8.0 is Online J

Figure 15.1: Debugging functionality.

function HelloWorld
input Real r;
output Real o;

algorithm
o 2 % r;

end HelloWorld;

>>> getCommandLineOptions ({"-d=rml, noevalfunc","-g=MetaModelica"})

{true, true}

>>> setCFlags (getCFlags ()
true

>>> HelloWorld (120.0)

+ " 7g")

So lets say that we want to debug HelloWorld.mo. For that we must load it into the compiler using the script file.
Put all the Modelica files there in the script file to be loaded. We should also initiate the debugger by calling the
starting function, in the above code HelloWorld (120.0);

Setting the debug configuration

While the Modelica perspective is activated the user should click on the bug icon on the toolbar and select Debug
in order to access the dialog for building debug configurations.

To create the debug configuration, right click on the classification Modelica Development Tooling (MDT) GDB
and select New as in figure below. Then give a name to the configuration, select the debugging executable to
be executed and give it command line parameters. There are several tabs in which the user can select additional
debug configuration settings like the environment in which the executable should be run.

Note that we require Gnu Debugger (GDB) for debugging session. We must specify the GDB location, also we
must pass our script file as an argument to OMC.
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& Modelica - Eclipse SDK

File Edit Mavigate Search Project Run FieldAssist Window Help

[ el -0 -Q- |3 |2 [a-]|® @/ -% -

7% 1 10_petrel
7% 209_pamtrans
27 308 _pamded
i
A 207
B-{Z .externaTools -;:e' =t
[ [ Functions.mo (40 5 U5_agvanced
- Main.ma 7% 6 04b_modassigntwotype
- Types.mo | 2% 7 04a_assigntwotype
project 7% 8 03_assignment
@ Bipcions -".”re.stll_expenment
€ Functions.h e
S Functions.g | L 028-S5PL
Functions.srz Debug As »
@ Main.c
Organize Favorites...
Main.o
Main.srz
- [E] README. txt
W PR S NI Z
1] |
He =
o= Qutline &3 O
An outline is not available. problems | & Console 2 Boohﬂarks|Progress|
<terminated > OMDey-MINGW [Program] C:\OMDev'\toolsimsysbinimake. exe
compiling/linking in debug mode with LIBRMI=rml_g and RMIZR( —Zdebug
finclude”/plain -oc Main.o Main.c
= -Zdebug
Figure 15.2: Accessing the debug configuration dialog.
- HelloWorld /Script.mos - Eclipse SDK : 18l x|
File Edit Mavigate Search Project Run  WWindow Help
JFS’ v | ot J%‘ -0 - - J/@ v J 13 8= J Correct Indentation | Build project [ %% Debug ®

[ Modelica Projects &2 = E]( HelloWorld.mo w =3
—1r

B = Debug Configurations
7 00_sim : .
TT 01 ex Create, manage, and run configurations

LI 02a_e  RunorDebug a MetaMedelica program

Loz e
T 03 sy1
- 3 -+,
LT 04_as: nj ® ‘ =R 2 | Mew_configuration
g g::_a: I type filter text Main . B SourcE) = Cnmmnn} " Enuirnnmenﬂ
_m
! C/C++ Application
g 06_ad % CffE++ Az;dw to Application Program: | :\OpenModelicarunkbuild pinfomc. exe Workspace... | File System...
07 oM

708 pai | ~[E] Cfc++Postmortem Debugger Work directory: | C:\Users\adeas31workspaceMOT \HelloWorld Warkspace... | File System...
EToopa | [l CIC++ Remote Application GDBpath: | S{env_var:OMDEV} frools\mingw \pin\gb. oxe Workspace... | Fie System...
T 10_pal DSF PDA Application
7 11 pe 4@ Eclipse Application )
2 Hellow [T ] GDB Hardware Debugging J= Debug C source files

- Java Applet

3 Java Application Arguments:

- Ju Uit SCRIPT.mos|

fﬁ JUnit Plug-in Test

- Launch Group

-7 Modelica Developement Tooling (MDT)
B+ Modelica Developement Tooling (MDT) GDB

&% MOT Debugger Test _ILI
77 New_configuration

He 77 Standard Modelica Test
4| - @ 0SGi Framework
— 4% push Down Automata
= Qutline & ;
o E’ Remote Java Application
{28 Snapshot Album
Apply. | Revert
Filter matched 21 of 21 items
@ Debug I Close |
J :4} | ‘Writable Insert | 11:1 | OpenModelica C....8.0 is Online J

Figure 15.3: Creating the Debug Configuration.
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Setting/Deleting Breakpoints

The Eclipse interface allows to add/remove breakpoints. At the moment only line number based breakpoints are
supported. Other alternative to set the breakpoints is; function breakpoints.

& Modelica - Mainumo - Eclipse SDK = gj_xj
Fle Edt MNavigate Search Project Run FeldAssst Window Hebp

Ci= @ om | B-0-Q- |8 |4 |28 |@ . - D =+ | Comectindentaton [ | 1 Modslen -
= =0T e

= g T backage

e - e
Double click on the
ruler to set/delete
breakpoints
4 £
o ™ PP B Coeioceica Compie 1438 00e | ; (s e rn oo

Figure 15.4: Setting/deleting breakpoints.

Starting the debugging session and enabling the debug perspective

15.1.2 The Debugging Perspective

The debug view primarily consists of two main views:
 Stack Frames View
* Variables View

The stack frame view, shown in the figure below, shows a list of frames that indicates how the flow had moved
from one function to another or from one file to another. This allows backtracing of the code. It is very much
possible to select the previous frame in the stack and inspect the values of the variables in that frame. However,
it is not possible to select any of the previous frame and start debugging from there. Each frame is shown as
<function_name at file_name:line_number>.

The Variables view shows the list of variables at a certain point in the program, containing four colums:
¢ Name - the variable name.
* Declared Type — the Modelica type of the variable.
¢ Value — the variable value.
e Actual Type — the mapped C type.

By preserving the stack frames and variables it is possible to keep track of the variables values. If the value of
any variable is changed while stepping then that variable will be highlighted yellow (the standard Eclipse way of
showing the change).
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Figure 15.5: Starting the debugging session.
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Figure 15.6: Eclipse will ask if the user wants to switch to the debugging perspective.
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Figure 15.7: The debugging perspective.
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Figure 15.8: Switching between perspectives.
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MODELICA PERFORMANCE ANALYZER

A common problem when simulating models in an equation-based language like Modelica is that the model may
contain non-linear equation systems. These are solved in each time-step by extrapolating an initial guess and
running a non-linear system solver. If the simulation takes too long to simulate, it is useful to run the performance
analysis tool. The tool has around 5~25% overhead, which is very low compared to instruction-level profilers
(30x-100x overhead). Due to being based on a single simulation run, the report may contain spikes in the charts.

When running a simulation for performance analysis, execution times of user-defined functions as well as linear,
non-linear and mixed equation systems are recorded.

To start a simulation in this mode, turn on profiling with the following command line flag >>>
setCommandLineOptions("—profiling=all")

The generated report is in HTML format (with images in the SVG format), stored in a file modelname_prof.html,
but the XML database and measured times that generated the report and graphs are also available if you want to
customize the report for comparison with other tools.

Below we use the performance profiler on the simple model A:

model ProfilingTest
function £
input Real r;

output Real o = sin(r);

end £f;

String s = "abc";

Real x = f(x) "This is x";

Real y(start=1);

Real zl1 = cos(z2);

Real z2 = sin(zl);
equation

der (y) = time;

end ProfilingTest;

We simulate as usual, after setting the profiling flag:

>>> setCommandLineOptions ("--profiling=blocks+html")
true

>>> simulate (ProfilingTest)

record SimulationResult

resultFile = "«DOCHOME»/ProfilingTest_res.mat",
simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'ProfilingTest', options =
—''", outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",
messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]

(continues on next page)
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(continued from previous page)

Warning: empty y range [1:1], adjusting to [0.99:1.01]

stdout | info | Time measurements are stored in ProfilingTest_prof.
—html (human-readable) and ProfilingTest_prof.xml (for XSL transforms or more
—~details)

"
’

timeFrontend = 0.009441601000000001,
timeBackend = 0.010803655,
timeSimCode = 0.001010736,
timeTemplates = 0.002625661,
timeCompile = 0.392829277,
timeSimulation = 0.07145498799999994,
timeTotal = 0.4882679409999999

end SimulationResult;

"Warning: There are nonlinear iteration variables with default zero start
—attribute found in NLSJacO. For more information set —-d=initialization. In_,
—OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call
—setCommandLineOptions ("-d=initialization").

Warning: The initial conditions are not fully specified. For more information set -
—d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook_,

—call setCommandLineOptions ("-d=initialization").
n

16.1 Profiling information for ProfilingTest

16.1.1 Information

All times are measured using a real-time wall clock. This means context switching produces bad worst-case
execution times (max times) for blocks. If you want better results, use a CPU-time clock or run the command
using real-time priviliges (avoiding context switches).

Note that for blocks where the individual execution time is close to the accuracy of the real-time clock, the
maximum measured time may deviate a lot from the average.

For more details, see ProfilingTest_prof.xml.

16.1.2 Settings

Name Value

Integration method | dassl

Output format mat

Output name ProfilingTest_res.mat
Output size 24.0kB

Profiling data ProfilingTest_prof.data
Profiling size 0B
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16.1.3 Summary

Task Time Fraction
Pre-Initialization 0.000217 | 2.04%
Initialization 0.000258 | 2.43%
Event-handling 0.000000 | 0.00%
Creating output file 0.000852 | 8.02%
Linearization NaN%
Time steps 0.007837 | 73.76%
Overhead 0.000331 | 3.12%
Unknown NaN NaN%
Total simulation time | 0.010625 | 100.00%

16.1.4 Global Steps

Steps | Total Fractio | Average Time Max Time | Deviati
Time n on
.| 499 0.00783 7 | 73.76% | 0.00001 5705410 | 0.00029 17.64x
IGraph thumbna il 8216433 2787
999|
16.1.5 Measured Function Calls
Name Callg Time Frac- | Max De-
tio Time viati
n on
Profil 506 | 0.00013 | 1.31% | 0.00000 | 14.99
IGraph thumbna il functio n funOllGraph .roﬁ v X
X X ingTest .f 8696 4383
thumbna il count functio n fun0|
16.1.6 Measured Blocks
Name Calls Time Frac- Max Deviati
tio Time on
n
¢ #eq0 | 7 0.00013 1.31% | 0.00014 6.09
IGraph thumbna il eqOIll Graph thumbna >¢ <red 8691 0 0491 X
il count eqOl T
¢ #eql | 2 0.00000 0.09% 0.00001 1.06
IGraph thumbna il eql2llGraph 2>‘< 4 9840 v 0140 x
thumbna il count eq12I
¢ <#teq2 | 504 | 0.00106 10.05% | 0.00001 7.82
(Graph  thumbna il eq20iGraph | o .~ 7724 ’| s6ga X
thumbna il count eq20I -
¢ <#eq2 | 504 | 0.00159 15.00% | 0.00002 6.35
IGraph thumbna il eq22llGraph 75 4 3393 7 3250 X
thumbna il count eq22| -
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Equations
Name | Variables
eq0
eql
eq2 s
eq3
eq4 2
eqs
eqo6 S <#var0>‘__
eq7 ¢ <#var0>‘__
eq8 C <fvarO>‘__
eq9 ¢ <#var0>‘__
eql0 zd
eqll
eql2 X
eql3 der(y)
eql4 2
eql5
eql6 ¢ <ftvarO>‘
eql7 S <#var0>‘__
eql8 ¢ <ftvarO>‘__
eql9 S <#var0>‘__
€q20 zl
eq2l
eq22 X
eq23
Variables
Name | Comment
y
der(y)
X This is x
zl
2
s

This report was generated by OpenModelica on 2020-01-13 13:39:20.

16.2 Genenerated JSON for the Example

Listing 16.1: ProfilingTest_prof.json

{

"name":"ProfilingTest",
"prefix":"ProfilingTest",
"date":"2020-01-13 13:39:20",
"method":"dass1l",

"outputFormat":"mat",
"outputFilename":"ProfilingTest_res.mat",

(continues on next page)
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(continued from previous page)

"outputFilesize":24581,

"overheadTime":0.000368515,

"preinitTime":0.00021665,

"initTime":0.00025833,

"eventTime": 0,

"outputTime":0.000852387,

"jacobianTime":0.000127558,

"totalTime":0.0106255,

"totalStepsTime":9.71202e-06,

"totalTimeProfileBlocks":0.00280965,

"numStep":499,

"maxTime":0.000292787024,

"functions": [
{"name":"ProfilingTest.f", "ncall":506, "time":0.000138696, "maxTime":0.000004383}
]I

"profileBlocks": [

{"id":0, "ncall":7,"time":0.000138691, "maxTime":0.000140491},
{"id":12,"ncall":2, "time":0.000009840, "maxTime" :0.000010140},

{"id":20, "ncall":504, "time":0.001067724, "maxTime":0.000018683},

{"id":22, "ncall":504, "time":0.001593393, "maxTime":0.000023250}

1
}

16.3 Using the Profiler from OMEdit

When running a simulation from OMEdit, it is possible to enable profiling information, which can be combined
with the transformations browser.

General = Output | Simulation Flags

Model Setup File (Optional): | Browse... | N
Initialization Method (Optional): | =
Optimization Method (Optional): | =
Equation System Initialization File (Optional): | | Browse... | |:
Equation System Initialization Time (Optional): |
Clock (Optional): | =
Linear Solver (Optional): | =
Non Linear Solver (Optional): | - | T
Linearization Time (Optional): ET;;S
Output Variables (Optional): blocks+html
Profiling (enable performance measurements)
[] CPUTime
& Enable all warnings

[] save simulation settings inside model [ﬁi_irm.llag J | Cancel |

Figure 16.1: Setting up the profiler from OMEdit.

When profiling the DoublePendulum example from MSL, the following output in Figure 16.2 is a typical result.
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This information clearly shows which system takes longest to simulate (a linear system, where most of the time
overhead probably comes from initializing LAPACK over and over).

[Equations Browser | [Defines
Index Type  Equation Executions Max time | Time Fraction = ||~ |Variable =
876 regular linear, size 2 4602 0.000199 0.0582 86.2% i damper.a_rel

836 regular (assignment) revolute2.R_rel.T[2,2] = cos(revolute2.phi) 1534 8.25e-05  0.000491 0.728% revolute2.frame_b.f[2]
-837 regular (assignment) revolute2.R_rel.T[2,1] =-sin{revolute2.phi) 1534 7.29e-05 0.000422 0.625%

841 regular (assignment) boxBody1.frame_...[2,1] =-sin(damper.phi_rel) 1534 7.1e-05 0.000395 0.585%

840 regular (assignment) boxBody1.frame_...T[2,2] = cos(damper.phi_rel) 1534 7.08e-05 0.000361 0.535%

839 regular (assignment) revolute2.R_rel.T[1,1] = cos(revolute2.phi) 1534 7.33e-05  0.000303 0.449%

842 regular (assignment) boxBody1.frame_b.R.T[1,2] = sin(damper.phi_rel) 1534 7.45e-05  0.000303 0.449%

838 regular (assignment) revolute2.R_rel.T[1,2] = sin(revolute2.phi) 1534 7.11e-05  0.0003 0.444%

849 regular (assignment) boxBody1.frame_...T[1,1] = cos(damper.phi_rel) 1534 7.29e-05 0.000286 0.424%

827 regular (assignment) revolute1.tau = (-damper.d) * revolutel.w 1534 6.84e-05  0.000274 0.406%

Figure 16.2: Profiling results of the Modelica standard library DoublePendulum example, sorted by execution

time.
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CHAPTER
SEVENTEEN

SIMULATION IN WEB BROWSER

OpenModelica can simulate in a web browser on a client computer by model code being compiled to efficient
Javacript code.

For more information, see https://github.com/tshort/openmodelica-javascript

Below used on the MSL MultiBody RobotR3.fullRobot example model.

=

2 it tshet githubaoy md e imdpad i Thodelica D = B &
BsEaf0&aYing %

-8 - #® - Page~ Safety~ Tools= @ - 8 H @3

OpenModelica simulation example

Modelica Mechanics MulliBody Examples. Systerns. RobotR3 fullRobot

Smulalion Meizhed.  Time: 0040

Mode]
S0 B, S 16
— ——
CHapun ilesrvals S
_—l=
ok [l A} —
§ ——
E -t ——
1 ¥ _,—I
J
J
—
Comments
Thes similation moded & from a od MM MR A ANt K Samiialing Eeaancal heamal, S macnanca
Syshoms. Of flidk wats useddl o compile this moded o C Then F wials e foocompile e C oo o JavaScripl

o mons indoemation on compiing Openiodelica bo tavaSorpt, see her

The usér mlerace was ceaed in mdped. Ses Mo Mechancs. Mullilody, Examgs ol 5 for the
ke O for IS e
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& hipe/shon.githubuo/ mdpad,/ mdpad MmiTModalica D=Bd

S AN&Ying

Wr B - = = Page= Safety~ Toals~ @ - 8 N

OpenModelica simulation example
Maodelica Mechanics MultiBody. Examples. Systems, RobotR 3. fullRobot

Simulaton finshed e D040

Model Resuls
Figt variabi
Shop e 5o eeChankcs riw w
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1
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182 Chapter 17. Simulation in Web Browser



CHAPTER
EIGHTEEN

INTEROPERABILITY — C AND PYTHON

Below is information and examples about the OpenModelica external C interfaces, as well as examples of Python
interoperability.

18.1 Calling External C functions

The following is a small example (ExternalLibraries.mo) to show the use of external C functions:

model Externallibraries

function ExternalFuncl
input Real x;
output Real y;
external y=ExternalFuncl_ext (x) annotation (Library="ExternalFuncl.o",
—LibraryDirectory="modelica://ExternallLibraries", Include="#include \
—"ExternalFuncl.h\"");
end ExternalFuncl;

function ExternalFunc2
input Real x;
output Real y;
external "C" annotation(Library="ExternalFunc2", LibraryDirectory="modelica://
—Externallibraries");
end ExternalFunc2;

Real x(start=1.0, fixed=true), y(start=2.0, fixed=true);
equation

der (x) =—ExternalFuncl (x);

der (y) =—ExternalFunc2 (y) ;
end Externallibraries;

These C (.c) files and header files (.h) are needed (note that the headers are not needed since OpenModelica will
generate the correct definition if it is not present; using the headers it is possible to write C-code directly in the
Modelica source code or declare non-standard calling conventions):

Listing 18.1: ExternalFuncl.c

double ExternalFuncl_ext (double x)
{

double res;

res = x+t2.0%x*x%;

return res;

Listing 18.2: ExternalFuncl.h

double ExternalFuncl_ext (double) ;
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Listing 18.3: ExternalFunc2.c

double ExternalFunc?2 (double x)
{
double res;
res = (x-1.0)*(x+2.0);
return res;

The following script file ExternalLibraries.mos will perform everything that is needed, provided you have gcc
installed in your path:

>>> gystem(getCompiler () + " -c -o ExternalFuncl.o ExternalFuncl.c")
0

>>> system(getCompiler () + " —-c -o ExternalFunc2.o ExternalFunc2.c")
0

>>> system("ar rcs libExternalFunc2.a ExternalFunc2.o")

0

>>> simulate (Externallibraries)
record SimulationResult

resultFile = "«DOCHOME»/ExternallLibraries_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Externallibraries',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
—= ""I

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.004897738,
timeBackend = 0.002133243,
timeSimCode .000590226,
timeTemplates = 0.002927883,
timeCompile = 0.368211797,
timeSimulation = 0.015881873,
timeTotal = 0.394750172

end SimulationResult;

And plot the results:

1.8 | y ]

16 N

T
|

1.4

1.2 T

Figure 18.1: Plot generated by OpenModelica+gnuplot
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18.2 Calling external Python Code from a Modelica model

The following calls external Python code through a very simplistic external function (no data is retrieved from the
Python code). By making it a dynamically linked library, you might get the code to work without changing the
linker settings.

function pyRunString

input String s;
external "C" annotation (Include="
#include <Python.h>

void pyRunString(const char *str)
{
Py_SetProgramName (\"pyRunString\"); /+ optional but recommended x/
Py_Initialize();
PyRun_SimpleString(str);
Py_Finalize();
}
")

end pyRunString;

model CallExternalPython
algorithm
pyRunString ("
print 'Python says: simulation time',"+String(time)+"
")

end CallExternalPython;

>>> system("python-config --cflags > pycflags")

0

>>> system("python-config --ldflags > pyldflags")

0

>>> pycflags := stringReplace (readFile ("pycflags™),"\n","");
>>> pyldflags := stringReplace (readFile ("pyldflags™),"\n","");
>>> setCFlags (getCFlags () tpycflags)

true

>>> getLinkerFlags (getLinkerFlags () +pyldflags)

true

>>> simulate (CallExternalPython, stopTime=2)
record SimulationResult

resultFile = "«DOCHOME»/CallExternalPython_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 2.0, numberOfIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'CallExternalPython',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
= 1

messages = "Python says: simulation time 0
Python says: simulation time 0
LOG_SUCCESS | info | The initialization finished successfully without,

—homotopy method.
Python says: simulation time 2
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.003732967,
timeBackend = 0.010305286,
timeSimCode = 0.000623617,
timeTemplates = 0.002325372,
timeCompile = 0.425577665,
timeSimulation = 0.03500151,
timeTotal = 0.477735432
end SimulationResult;
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18.3 Calling OpenModelica from Python Code

This section describes a simple-minded approach to calling Python code from OpenModelica. For a description
of Python scripting with OpenModelica, see OMPython — OpenModelica Python Interface.

The interaction with Python can be perfomed in four different ways whereas one is illustrated below. Assume that
we have the following Modelica code:

Listing 18.4: CalledbyPython.mo

model CalledbyPython
Real x(start=1.0), y(start=2.0);
=2

parameter Real b .0;
equation
der (x) = -bxy;

der (y) = x;
end CalledbyPython;

In the following Python (.py) files the above Modelica model is simulated via the OpenModelica scripting inter-
face:

Listing 18.5: PythonCaller.py

#!/usr/bin/python

import sys,os

global newb = 0.5
execfile('CreateMosFile.py")

os.popen (r"omc CalledbyPython.mos") .read()
execfile ('RetrResult.py')

Listing 18.6: CreateMosFile.py

#!/usr/bin/python

mos_file = open('CalledbyPython.mos', 'w', 1)

mos_file.write('loadFile ("CalledbyPython.mo");\n")

mos_file.write ('setComponentModifierValue (CalledbyPython,b, $Code (="+str (newb)+"));
%\n' )

mos_file.write('simulate (CalledbyPython, stopTime=10);\n")

mos_file.close()

Listing 18.7: RetrResult.py

#!/usr/bin/python

def zeros(n): #
vec = [0.0]
for i in range(int(n)-1): vec = vec + [0.0]

return vec
res_file = open("CalledbyPython_res.plt",'r',1)

line = res_file.readline ()
size = int (res_file.readline() .split('=")[1])
time = zeros(size)
y = zeros(size)
while line != ['DataSet: time\\n']:
line = res_file.readline() .split (', ") [0:1]
for j in range(int (size)):
time[j]l=float (res\_file.readline() .split (', ") [0])
while line != ['DataSet: y\\n']:
line=res_file.readline () .split (', ") [0:1]

for j in range (int (size)):
yv[jl=float (res\_file.readline () .split (', ") [1])
res_file.close()
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A second option of simulating the above Modelica model is to use the command buildModel instead of the simulate
command and setting the parameter value in the initial parameter file, CalledbyPython_init.txt instead of using the
command setComponentModifierValue. Then the file CalledbyPython.exe is just executed.

The third option is to use the Corba interface for invoking the compiler and then just use the scripting interface to
send commands to the compiler via this interface.

The fourth variant is to use external function calls to directly communicate with the executing simulation process.

18.3. Calling OpenModelica from Python Code 187
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CHAPTER
NINETEEN

OPENMODELICA PYTHON INTERFACE AND PYSIMULATOR

This chapter describes the OpenModelica Python integration facilities.
¢ OMPython — the OpenModelica Python scripting interface, see OMPython — OpenModelica Python Inter-

face.
* EnhancedOMPython - Enhanced OMPython scripting interface, see Enhanced OMPython Features.

* PySimulator — a Python package that provides simulation and post processing/analysis tools integrated with
OpenModelica, see PySimulator.

19.1 OMPython — OpenModelica Python Interface

OMPython — OpenModelica Python API is a free, open source, highly portable Python based interactive ses-
sion handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica
modeling, compilation and simulation environment based on the latest OpenModelica library standard available.
OMPython is architectured to combine both the solving strategy and model building. So domain experts (people
writing the models) and computational engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm de-
velopment and research. OMPython is not a standalone package, it depends upon the OpenModelica installation.

OMPython is implemented in Python and depends either on the OmniORB and OmniORBpy - high performance
CORBA ORBs for Python or ZeroMQ - high performance asynchronous messaging library and it supports the
Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMPython follow the instructions at https://github.com/OpenModelica/OMPython

19.1.1 Features of OMPython

OMPython provides user friendly features like:

* Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation,
simulation, plotting, etc.

* Interface to the latest OpenModelica API calls.
* Optimized parser results that give control over every element of the output.
» Helper functions to allow manipulation on Nested dictionaries.

 Easy access to the library and testing of OpenModelica commands.

19.1.2 Test Commands

OMPython provides two classes for communicating with OpenModelica i.e., OMCSession and OMCSes-
sionZMQ. Both classes have the same interface, the only difference is that OMCSession uses omniORB and
OMCSessionZMQ uses ZeroMQ. All the examples listed down uses OMCSessionZMQ but if you want to test
OMCSession simply replace OMCSessionZMQ with OMCSession. We recommend to use OMCSessionZMQ.
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To test the command outputs, simply create an OMCSessionZMQ object by importing from the OMPython library
within Python interepreter. The module allows you to interactively send commands to the OMC server and display
their output.

To get started, create an OMCSessionZMQ object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ ()

>>> omc.sendExpression ("getVersion()")
OMCompiler v1.14.1-v1.14.1.2+9g392c27e260
>>> omc.sendExpression("cd()")

«DOCHOME»

>>> omc.sendExpression ("loadModel (Modelica)")

True

>>> omc.sendExpression ("loadFile (getInstallationDirectoryPath() + \"/share/doc/omc/
—testmodels/BouncingBall.mo\")")

True

>>> omc.sendExpression("instantiateModel (BouncingBall)")
class BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g 9.81 "gravity acceleration";
Real h(start 1.0, fixed = true) "height of ball";
Real v(fixed = true) "velocity of ball";
Boolean flying(start = true, fixed = true) "true, if ball is flying";
Boolean impact;

Real v_new(fixed = true);
Integer foo;
equation
impact = h <= 0.0;
foo = if impact then 1 else 2;

der(v) = if flying then -g else 0.0;

der (h) = v;

when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then (-e) x pre(v) else 0.0;
flying = v_new > 0.0;
reinit (v, v_new);

end when;

end BouncingBall;

We get the name and other properties of a class:

>>> omc.sendExpression ("getClassNames () ")

('BouncingBall', 'ModelicaServices', 'Complex', 'Modelica')
>>> omc.sendExpression("isPartial (BouncingBall) ")

False

>>> omc.sendExpression ("isPackage (BouncingBall) ™)

False

>>> omc.sendExpression ("isModel (BouncingBall)")

True

>>> omc.sendExpression ("checkModel (BouncingBall)")

Check of BouncingBall completed successfully.

Class BouncingBall has 6 equation(s) and 6 variable(s).

1 of these are trivial equation(s).

>>> omc.sendExpression("getClassRestriction (BouncingBall)")

model
>>> omc.sendExpression("getClassInformation (BouncingBall) ™)
('model', '', False, False, False, '/var/lib/Jjenkins/ws/OpenModelica_maintenance_

—vl.14/build/share/doc/omc/testmodels/BouncingBall.mo', False, 1, 1, 23, 17, (),
—~False, False, '', '', False, '")

>>> omc.sendExpression ("getConnectionCount (BouncingBall)")

0

>>> omc.sendExpression ("getInheritanceCount (BouncingBall)")

(continues on next page)
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(continued from previous page)

0

>>> omc.sendExpression ("getComponentModifierValue (BouncingBall,e)")

0.7

>>> omc.sendExpression ("checkSettings ()")

{'OPENMODELICAHOME': '«OPENMODELICAHOME»', 'OPENMODELICALIBRARY':

— '"«OPENMODELICAHOME»/lib/omlibrary', 'OMC_PATH': '«OPENMODELICAHOME»/bin/omc',
—'"SYSTEM_PATH': '/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/sbin:/bin"',

— 'OMDEV_PATH': '', 'OMC_FOUND': True, 'MODELICAUSERCFLAGS': '', 'WORKING_DIRECTORY
—': '"«DOCHOME»', 'CREATE_FILE_WORKS': True, 'REMOVE_FILE_WORKS': True, '0OS':
—'linux', 'SYSTEM_INFO': 'Linux alc8526ca4b4 4.15.0-47-generic #50-Ubuntu SMP Wed,,
—Mar 13 10:44:52 UTC 2019 x86_64 x86_64 x86_64 GNU/Linux\n', 'RTLIBS': ' -Wl,--no-
—as-needed -Wl,--disable-new-dtags -lOpenModelicaRuntimeC -llapack -1lblas -1lm -
—~lomcgc —-lpthread -rdynamic', 'C_COMPILER': 'clang', 'C_COMPILER_VERSION': 'clang,,
—version 6.0.0-lubuntu2 (tags/RELEASE_600/final)\nTarget: x86_64-pc—-linux-—
—gnu\nThread model: posix\nInstalledDir: /usr/bin\n', 'C_COMPILER_RESPONDING':

—True, 'HAVE_CORBA': True, 'CONFIGURE_CMDLINE': "Configured 2020-01-13 13:26:33
—using arguments: '—-disable-option-checking' '—--prefix=/var/lib/jenkinsl/ws/
—OpenModelica_maintenance_v1l.14/build' 'CC=clang' 'CXX=clang++' 'FC=gfortran'
—'CFLAGS=-0s' '—--with-cppruntime' '—--without-omc' '—--without-omlibrary' '—--with-
—omniORB' '—--enable-modelica3d' '—--without-hwloc' '—-with-ombuilddir=/var/lib/
—jenkinsl/ws/OpenModelica_maintenance_vl1.14/build' '--cache-file=/dev/null' '—-
—srcdir=.""}

The common combination of a simulation followed by getting a value and doing a plot:

>>> omc.sendExpression("simulate (BouncingBall, stopTime=3.0)")
{'resultFile': '«DOCHOME»/BouncingBall_ res.mat', 'simulationOptions': "startTime =

—0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1le-06, method = 'dassl
— ', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat',

[

—variableFilter = '.x', cflags = , simflags = '"'", 'messages': 'LOG_SUCCESS

— | info | The initialization finished successfully without homotopy method.
—\nLOG_SUCCESS | info | The simulation finished successfully.\n"',
—'timeFrontend': 0.271908215, 'timeBackend': 0.00320043, 'timeSimCode': 0.
—00100791, 'timeTemplates': 0.002042255, 'timeCompile': 0.375256418,
—'timeSimulation': 0.017207876, 'timeTotal': 0.67075475}

>>> omc.sendExpression("val(h , 2.0)")

0.04239430772884106

[

Import As Library

To use the module from within another python program, simply import OMCSessionZMQ from within the using
program.

For example:

# test.py
from OMPython import OMCSessionZMQ
omc = OMCSessionZMOQ ()
cmds = [
'loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo") ',
"simulate (BouncingBall)",
"plot (h)"
1
for cmd in cmds:

answer = omc.sendExpression (cmd)
print ("\n{}:\n{}".format (cmd, answer))

19.1.3 Implementation
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Client Implementation

The OpenModelica Python API Interface — OMPython, attempts to mimic the OMShell’s style of operations.
OMPython is designed to,

e Initialize the CORBA/ZeroMQ communication.

¢ Send commands to the OMC server via the CORBA/ZeroMQ interface.

* Receive the string results.

¢ Use the Parser module to format the results.

* Return or display the results.

19.2 Enhanced OMPython Features

Some more improvements are added to OMPython functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models
using python objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> from OMPython import OMCSessionzZMQ

>>> omc = OMCSessionZMQ ()

>>> model_path=omc.sendExpression ("getInstallationDirectoryPath()") + "/share/doc/
—omc/testmodels/"

>>> from OMPython import ModelicaSystem

>>> mod=ModelicaSystem(model_path + "BouncingBall.mo", "BouncingBall")

The object constructor requires a minimum of 2 input arguments which are strings, and may need a third string
input argument.

* The first input argument must be a string with the file name of the Modelica code, with Modelica file
extension ".mo". If the Modelica file is not in the current directory of Python, then the file path must also
be included.

* The second input argument must be a string with the name of the Modelica model including the namespace
if the model is wrapped within a Modelica package.

* The third input argument is used to specify the list of dependent libraries or dependent Modelica files e.g.,

>>> mod=ModelicaSystem(model_path + "BouncingBall.mo", "BouncingBall", ["Modelica"])

* By default ModelicaSystem uses OMCSessionZMQ but if you want to use OMCSession then pass the
argument useCorba=True to the constructor.

19.2.1 BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional
simulationflags needs to be set using sendExpression()

>>> mod.buildModel ()

19.2.2 Standard get methods

* getQuantities()
 getContinuous()
« getlnputs()
 getOutputs()
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 getParameters()
 getSimulationOptions()
* getSolutions()

Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)
getParameters().

* getXXX() without input argument, returns a dictionary with names as keys and values as values.
o getXXX(S), where S is a string of names.
o getXXX(["S1","S2"]) where S1 and S1 are list of string elements

19.2.3 Usage of getMethods

>>> mod.getQuantities() // method-1, list of all variables from xml file
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value':
—~'1.0"'", 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {
—~'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9',
—'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getQuantities ("height") // method-2, to query information about single_
—quantity

[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value':
—'1.0"'", 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getQuantities (["c","radius"]) // method-3, to query information about list,
—of quantity

[{'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9',
—'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable
—': None, 'Name': 'radius', 'Variability': 'parameter', 'Value': '0.1', 'alias':
—'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getContinuous () // method-1, list of continuous variable

{'velocity': -1.825929609047952, 'der(velocity)': -9.8100000000000005, 'der (height)
—': -1.825929609047952, 'height': 0.65907039052943617}

>>> mod.getContinuous (["velocity","height"]) // method-2, get specific variable
—value information
(-1.825929609047952, 0.65907039052943617)

>>> mod.getInputs ()
{}

>>> mod.getOutputs ()
{}

>>> mod.getParameters () // method-1
{'c': 0.9, 'radius': 0.1}

>>> mod.getParameters (["c", "radius"]) // method-2

[0.9, 0.1]

>>> mod.getSimulationOptions () // method-1

{'stepSize': 0.002, 'stopTime': 1.0, 'tolerance': l1le-06, 'startTime': 0.0, 'solver
—': 'dassl'}
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>>> mod.getSimulationOptions (["stepSize","tolerance"]) // method-2
[0.002, 1le-06]

The getSolution method can be used in two different ways.
1) using default result filename
2) use the result filenames provided by user

This provides a way to compare simulation results and perform regression testing

>>> mod.getSolutions () // method-1 returns list of simulation variables for which,
—results are available
["time', 'height', 'velocity', 'der (height)', 'der (velocity)', 'c', 'radius']

>>> mod.getSolutions (["time", "height"]) // return list of numpy arrays

>>> mod.getSolutions (resultfile="c:/tmpbouncingBall.mat") // method-2 returns list,
—of simulation variables for which results are available , the resulfile location,
—~is provided by user

>>> mod.getSolutions (["time", "height"], resultfile="c:/tmpbouncingBall.mat") //
—return list of array

19.2.4 Standard set methods

* setlnputs()
* setParameters()
* setSimulationOptions()
Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.
e setXXX("Name=value") string of keyword assignments

e setXXX(["Namel=valuel","Name2=value2","Name3=value3"]) list of string of keyword assignments

19.2.5 Usage of setMethods

’>>> mod.setInputs (["cAi=1","Ti=2"]) // method-2
’>>> mod.setParameters ("radius=14") // method-1 setting parameter value
>>> mod.setParameters (["radius=14","c=0.5"]) // method-2 setting parameter value,

—using second option

’>>> mod.setSimulationOptions (["stopTime=2.0", "tolerance=1e-08"]) // method-2

19.2.6 Simulation

An example of how to get parameter names and change the value of parameters using set methods and finally
simulate the "BouncingBall.mo" model is given below.

>>> mod.getParameters ()
{'c': 0.9, 'radius': 0.1}
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>>> mod.setParameters (["radius=14","c=0.5"]) //setting parameter value

To check whether new values are updated to model , we can again query the getParameters().

>>> mod.getParameters ()
{'c'": 0.5, 'radius': 14}

And then finally we can simulate the model using, The simulate() API can be used in two methods
1) without any arguments

2) resultfile names provided by user (only filename is allowed and not the location)

>>> mod.simulate() // method-1 default result file name will be used
>>> mod.simulate (resultfile="tmpbouncingBall.mat") // method-2 resultfile name_
—provided by users

19.2.7 Linearization

The following methods are proposed for linearization.
¢ linearize()
¢ getLinearizationOptions()
¢ setLinearizationOptions()
¢ getLinearInputs()
* getLinearOutputs()

* getLinearStates()

19.2.8 Usage of Linearization methods

>>> mod.getLinearizationOptions () // method-1
{'simflags': ' ', 'stepSize': 0.002, 'stopTime': 1.0, 'startTime': 0.0,
— '"numberOfIntervals': 500.0, 'tolerance': 1e-08}
>>> mod.getLinearizationOptions ("startTime","stopTime") // method-2
[0.0, 1.0]
’>>> mod.setLinearizationOptions (["stopTime=2.0","tolerance=1e-06"])
’>>> mod.linearize() //returns a tuple of 2D numpy arrays (matrices) A, B, C and D.
>>> mod.getLinearInputs() //returns a list of strings of names of inputs used

—when forming matrices.

>>> mod.getLinearOutputs () //returns a list of strings of names of outputs used
—when forming matrices

>>> mod.getLinearStates () // returns a list of strings of names of states used,,
—when forming matrices.
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19.3 PySimulator

PySimulator provides a graphical user interface for performing analyses and simulating different model types
(currently Functional Mockup Units and Modelica Models are supported), plotting result variables and applying
simulation result analysis tools like Fast Fourier Transform.

Read more about the PySimulator at https://github.com/PySimulator/PySimulator.
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CHAPTER
TWENTY

OMMATLAB — OPENMODELICA MATLAB INTERFACE

OMMatlab — the OpenModelica Matlab API is a free, open source, highly portable Matlab-based interactive
session handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica
modeling, compilation and simulation environment based on the latest OpenModelica library standard available.
OMMatlab is architectured to combine both the solving strategy and model building. So domain experts (people
writing the models) and computational engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm
development and research. OMMatlab is not a standalone package, it depends upon the OpenModelica installation.

OMMatlab is implemented in Matlab and depends on ZeroMQ - high performance asynchronous messaging li-
brary and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica
1.9.2.

To install OMMatlab follow the instructions at https://github.com/OpenModelica/OMMatlab

20.1 Features of OMMatlab

The OMMatlab package contains the following features:
* Import the OMMatlab package in Matlab
* Connect with the OpenModelica compiler through zmq sockets

* Able to interact with the OpenModelica compiler through the available API

All the API calls are communicated with the help of the sendExpression method implemented in a Matlab
pacakge

* The results are returned as strings

20.2 Test Commands

To get started, create a OMMatlab session object:

>>> import OMMatlab.

>>> omc= OMMatlab ()

>>> omc.sendExpression ("getVersion()")
'vl.13.0-dev-531-gde26b558a (64-bit)"

>>> omc.sendExpression ("loadModel (Modelica)")
'true'

>>> omc.sendExpression("model a Real s; equation s=sin(10xtime); end a;")
l{a}l

>>> omc.sendExpression("simulate(a)")

>>> omc.sendExpression("plot (s)")

'true'
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20.2.1 Advanced OMMatlab Features

OMMatlab package has advanced functionality for querying more information about the models and simulate
them. A list of new user friendly API functionality allows user to extract information about models using matlab
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> import OMMatlab. x
>>> omc= OMMatlab ()
>>> omc.ModelicaSystem("BouncingBall.mo", "BouncingBall")

The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which
is optional .

e The first input argument must be a string with the file name of the Modelica code, with Modelica file
extension ".mo". If the Modelica file is not in the current directory, then the file path must also be included.

* The second input argument must be a string with the name of the Modelica model including the namespace
if the model is wrapped within a Modelica package.

* The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica
files The argument can be passed as a string or array of strings e.g.,

>>> omc.ModelicaSystem("BouncingBall.mo", "BouncingBall", ["Modelica",
—"SystemDynamics", "dcmotor.mo"])

20.3 WorkDirectory

For each Matlab session a temporary work directory is created and the results are published in that working
directory, Inorder to get the workdirectory the users can use the following API

>>> omc.getWorkDirectory ()
'C:/Users/arupab4/AppData/Local/Temp/tp7dd6e48e5_5de6_4f66_b3d6_90bcelfeld58"
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20.4 BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional
simulationflags needs to be set using sendExpression()

’>>> buildModel (mod)

20.5 Standard get methods

* getQuantities()
¢ showQuantities()
* getContinuous()
* getlnputs()
 getOutputs()

 getParameters()

* getSimulationOptions()

* getSolutions()

Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)

getParameters().

e getXXX() without input argument, returns a dictionary with names as keys and values as values.

* getXXX(S), where S is a string of names.

o getXXX(["S1","S2"]) where S1 and S1 are array of string elements

20.6 Usage of getMethods

>>> omc.getQuantities()

// method-1,

list of all variables from xml file

causality

o o ———— o o o
——————— o o +

| name | changeable description variability |
—alias | aliasVariable | wvalue |

o o B e s +
——————— o o +

| 'h' | 'true' 'height of ball' 'continuous' |
—'noAlias' | "' [ '1.0" |

Fom———————— Fom ettt +
e — o o +

| v | 'true' 'velocity of ball' 'continuous' |
—'noAlias' | "' [ |

o o ———— B +
——————— o +——— +

| 'der(h)'" | 'false' 'der (height of ball)' 'continuous' |
—'noAlias' | "' [ |

o o Bt +
L o o +

| 'der(v)' | 'false' 'der (velocity of ball)' 'continuous' |
—'noAlias' | "' [ |

fom— o ettt +
R —— o o +

20.4. BuildModel
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>>> omc.getQuantities ("h") // method-2, to query information about single quantity
fom e ——— o —— o fom fom +———=
G ———— Fom Fo— +

| name | changeable | description | variability | causality I
—alias | aliasVariable | value |

fom———————— Fom oo Fom Fom -
m—————— e o +

| 'h' | 'true' | 'height of ball' | 'continuous' | 'internal'
—'noAlias"' | '' [ '"1.0" |

fom e ——— o o fom +———
S fom o +

>>> omc.getQuantities (["h","v"]) // method-3, to query information about list of

—quantity
fom e ——— o o fom e fom +———=
m————— e o +
| name | changeable | description | variability | causality I
—alias | aliasVariable | value |
fo————— o o o ——— fomm +———=
m—————— fom o +
| 'h' | 'true' | 'height of ball' | 'continuous' | 'internal'
—'noAlias"' | '' [ '1.0" |
fom o —— o o fom +———
e ——— fom o +
| v | 'true' | 'velocity of ball' | 'continuous' | 'internal'
—'noAlias' | "' [ |
fom o ——— R fom fom +———=
—————— o o= +
>>> omc.getContinuous () // method-1, returns struct of continuous variable
struct with fields:

h : '1.0"

A4 HE

der_h_: "'

der_v_: "!
>>> omc.getContinuous (["h","v"]) // method-2, returns string array
"1.0" "

>>> omc.getInputs ()
struct with no fields

>>> omc.getOutputs ()
struct with no fields

>>> omc.getParameters () // method-1
struct with fields:
e: '0.7"'

g: '9.810000000000001"

>>> omc.getParameters (["c", "radius"]) // method-2
"0.7" "9.810000000000001™

>>> omc.getSimulationOptions () // method-1
struct with fields:
startTime: '0'
stopTime: '1'
stepSize: '0.002"
tolerance: 'le-006"

(continues on next page)
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(continued from previous page)

solver: 'dassl'

>>> omc.getSimulationOptions (["stepSize","tolerance"]) // method-2
"0.002", "le-006"

The getSolution method can be used in two different ways.
1) using default result filename
2) use the result filenames provided by user

This provides a way to compare simulation results and perform regression testing

>>> omc.getSolutions () // method-1 returns string arrays of simulation variables,,
—for which results are available, the default result filename is taken

"time", "height", ""velocity", "der (height)", "der (velocity)", "c", "radius"

>>> omc.getSolutions (["time","h"]) // return list of cell arrays

1x2 cell array

{1x506 double} {1x506 double}

>>> omc.getSolutions ([],"c:/tmpbouncingBall.mat") // method-2 returns string,

—arrays of simulation variables for which results are available , the resulfile
—location is provided by user
"time", "height", "velocity", "der (height)", "der(velocity)", "c", "radius"

>>> omc.getSolutions (["time","h"],"c:/tmpbouncingBall.mat") // return list of cell
—arrays

1x2 cell array

{1x506 double} {1x506 double}

20.7 Standard set methods

* setInputs()
¢ setParameters()
* setSimulationOptions()
Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.
* setXXX("Name=value") string of keyword assignments

o setXXX(["Namel=valuel","Name2=value2","Name3=value3"]) array of string of keyword assignments

20.8 Usage of setMethods

’>>> omc.setInputs ("cAi=1") // method-1

’>>> omc.setInputs (["cAi=1","Ti=2"]) // method-2

’>>> omc.setParameters ("e=14") // method-1

>>> omc.setParameters (["e=14","g=10.8"]) // method-2 setting parameter value using,

—array of string
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’>>> omc.setSimulationOptions (["stopTime=2.0", " "tolerance=1e-08"])

20.9 Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the
"BouncingBall.mo" model is given below .

>>> omc.getParameters ()
struct with fields:
e: '0.7"
g: '9.810000000000001"

>>> omc.setParameters (["e=0.9","g=9.83"])

To check whether new values are updated to model , we can again query the getParameters().

>>> omc.getParameters ()
struct with fields:

e: "0.9"

g: "9.83"

Similary we can also use setlnputs() to set a value for the inputs during various time interval can also be done
using the following.

>>> omc.setInputs ("cAi=1")

And then finally we can simulate the model using, The simulate() API can be used in two methods
1) without any arguments

2) resultfile names provided by user (only filename is allowed and not the location)

>>> omc.simulate() // method-1 default result file name will be used
>>> omc.simulate ("tmpbouncingBall.mat") // method-2 resultfile name provided by,
—users

20.10 Linearization

The following methods are available for linearization of a modelica model
¢ linearize()
¢ getLinearizationOptions()
¢ setLinearizationOptions()
* getLinearInputs()
* getLinearOutputs()
* getLinearStates()

20.11 Usage of Linearization methods

’>>> omc.getLinearizationOptions () // method-1
>>> omc.getLinearizationOptions (["startTime", "stopTime"]) // method-2
"0.0"’ "l.O"
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’>>> omc.setLinearizationOptions (["stopTime=2.0", "tolerance=1e-08"])
’>>> omc.linearize() //returns a list 2D arrays (matrices) A, B, C and D.
>>> omc.getLinearInputs() //returns a list of strings of names of inputs used

—when forming matrices.

>>> omc.getLinearOutputs () //returns a list of strings of names of outputs used
—when forming matrices.

>>> omc.getLinearStates () // returns a list of strings of names of states used,
—when forming matrices.
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OMJULIA — OPENMODELICA JULIA SCRIPTING

OMlJulia — the OpenModelica Julia APl is a free, open source, highly portable Julia based interactive session han-
dler for Julia scripting of OpenModelica API functionality. It provides the modeler with components for creating
a complete Julia-Modelica modeling, compilation and simulation environment based on the latest OpenModelica
implementation and Modelica library standard available. OMJulia is architectured to combine both the solving
strategy and model building. Thus, domain experts (people writing the models) and computational engineers (peo-
ple writing the solver code) can work on one unified tool that is industrially viable for optimization of Modelica
models, while offering a flexible platform for algorithm development and research. OMlJulia is not a standalone
package, it depends upon the OpenModelica installation.

OMlulia is implemented in Julia and depends on ZeroMQ - high performance asynchronous messaging library
and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMJulia follow the instructions at https://github.com/OpenModelica/OMJulia.jl

21.1 Features of OMJulia

The OMlJulia package contains the following features:

* Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation,
simulation, plotting, etc.

* Connect with the OpenModelica compiler through zmq sockets
» Able to interact with the OpenModelica compiler through the available API
 Easy access to the Modelica Standard library.

* All the API calls are communicated with the help of the sendExpression method implemented in a Julia
module

* The results are returned as strings

21.2 Test Commands

To get started, create an OMJulia session object:

>>> using OMJulia
>>> omc= OMJulia.OMCSession ()
>>> sendExpression (omc, "loadModel (Modelica) ")
true
>>> sendExpression (omc, "model a Real s; equation s=sin(10xtime); end a;")
l-element Array{Symbol,1}:
ra
>>> sendExpression (omc, "simulate (a)")
>>> sendExpression (omc, "plot (s)")
true
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21.2.1 Advanced OMJulia Features

OMlJulia package has advanced functionality for querying more information about the models and simulate them.
A list of new user friendly API functionality allows user to extract information about models using julia objects.
A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> using OMJulia
>>> mod = OMJulia.OMCSession ()
>>> ModelicaSystem(mod, "BouncingBall.mo", "BouncingBall")

The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which
is optional .

e The first input argument must be a string with the file name of the Modelica code, with Modelica file
extension ".mo". If the Modelica file is not in the current directory, then the file path must also be included.

* The second input argument must be a string with the name of the Modelica model including the namespace
if the model is wrapped within a Modelica package.

* The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica
files The argument can be passed as a string or array of strings e.g.,

>>> ModelicaSystem (mod, "BouncingBall.mo", "BouncingBall", ["Modelica",
—"SystemDynamics", "dcmotor.mo"])

21.3 WorkDirectory

For each OMJulia session a temporary work directory is created and the results are published in that working
directory, Inorder to get the workdirectory the users can use the following API

>>> getWorkDirectory (mod)
"C:/Users/arupab4/AppData/Local/Temp/jl_5pbewl"
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21.4 BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional
simulationflags needs to be set using sendExpression()

’>>> buildModel (mod)

21.5 Standard get methods

* getQuantities()

¢ showQuantities()

¢ getContinuous()

o getlnputs()
 getOutputs()

» getParameters()

¢ getSimulationOptions()
* getSolutions()

Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)
getParameters().

o getXXX() without input argument, returns a dictionary with names as keys and values as values.
e getXXX(S), where S is a string of names.
o getXXX(["S1","S2"]) where S1 and S1 are array of string elements

21.6 Usage of getMethods

>>> getQuantities (mod) // method-1, list of all variables from xml file

[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
—~"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}, {
—"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
—"alias": "noAlias", "Changeable": "true", "Description": None}]

>>> getQuantities (mod, "height") // method-2, to query information about single_
—quantity

[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
—"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}]

>>> getQuantities (mod, ["c","radius"]) // method-3, to query information about list,
—of quantity

[{"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
—"alias": "noAlias", "Changeable": "true", "Description": None}, {"aliasvariable
—": None, "Name": "radius", "Variability": "parameter", "Value": "0.1", "alias":
—"noAlias", "Changeable": "true", "Description": None}]

>>> getContinuous (mod) // method-1, list of continuous variable
{"velocity": "-1.825929609047952", "der (velocity)": "-9.8100000000000005",
—"der (height)": "-1.825929609047952", "height": "0.65907039052943617"}

>>> getContinuous (mod, ["velocity","height"]) // method-2, get specific variable
—value information

["-1.825929609047952", "0.65907039052943617"]
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>>> getInputs (mod)
{}

>>> getOutputs (mod)
{}

>>> getParameters (mod) // method-1
{"C": "0.9", Hradius": "0.1"}

>>> getParameters (mod, ["c", "radius"]) // method-2
[||0‘9", "O.l"]

>>> getSimulationOptions (mod) // method-1

{"stepSize": "0.002", "stopTime": "1.0", "tolerance": "le-06", "startTime": "0.0",
—"solver": "dassl"}
>>> getSimulationOptions (mod, ["stepSize","tolerance"]) // method-2

["0.002", "le-06"]

The getSolution method can be used in two different ways.
1) using default result filename
2) use the result filenames provided by user

This provides a way to compare simulation results and perform regression testing

>>> getSolutions (mod) // method-1 returns list of simulation variables for which,,
—results are available
["time", "height", ""velocity", "der (height)", "der (velocity)", "c", "radius"]

>>> getSolutions (mod, ["time", "height"]) // return list of array

>>> getSolutions (mod, resultfile="c:/tmpbouncingBall.mat") // method-2 returns list_
—of simulation variables for which results are available , the resulfile location,
—is provided by user

["time", "height", ""velocity", "der (height)", "der (velocity)", "c", "radius"]

>>> getSolutions (mod, ["time","h"], resultfile="c:/tmpbouncingBall.mat") // return
—list of array

>>> showQuantities (mod) // same as getQuantities () but returns the results in the
—form table

21.7 Standard set methods

* setlnputs()
* setParameters()
¢ setSimulationOptions()
Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.
e setXXX("Name=value") string of keyword assignments

* setXXX(["Namel=valuel","Name2=value2","Name3=value3"]) array of string of keyword assignments
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21.8 Usage of setMethods

’>>> setInputs (mod, "cAi=1") // method-1

’>>> setInputs (mod, ["cAi=1","Ti=2"]) // method-2

’>>> setParameters (mod, "radius=14") // method-1

>>> setParameters (mod, ["radius=14","c=0.5"]) // method-2 setting parameter value,
—using array of string

’>>> setSimulationOptions (mod, ["stopTime=2.0", "tolerance=1e-08"])

21.9 Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the
"BouncingBall.mo" model is given below .

>>> getParameters (mod)
{llcll: "O.9ll, llradiusll: "O.l"}

>>> gsetParameters (mod, ["radius=14","c=0.5"1])

To check whether new values are updated to model , we can again query the getParameters().

>>> getParameters (mod)
{"cll: "O‘5H’ "radiusﬂ: "14"}

Similary we can also use setlnputs() to set a value for the inputs during various time interval can also be done
using the following.

>>> setInputs (mod, "cAi=1")

And then finally we can simulate the model using, The simulate() API can be used in two methods
1) without any arguments

2) resultfile names provided by user (only filename is allowed and not the location)

>>> simulate (mod) // method-1 default result file name will be used
>>> simulate (mod, resultfile="tmpbouncingBall.mat") // method-2 resultfile name,,
—provided by users

21.10 Linearization

The following methods are available for linearization of a modelica model
¢ linearize()
* getLinearizationOptions()
* setLinearizationOptions()
* getLinearInputs()
* getLinearOutputs()
* getLinearStates()
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21.11 Usage of Linearization methods

>>> getLinearizationOptions (mod) // method-1

{"stepSize": "0.002", "stopTime": "1.0", "startTime": "0.0", "numberOfIntervals":
—"500.0", "tolerance": "le-08"}

>>> getLinearizationOptions (mod, ["startTime", "stopTime"]) // method-2

[llO‘O", "1.0"]

’>>> setLinearizationOptions (mod, ["stopTime=2.0","tolerance=1e-06"])

’>>> linearize (mod) //returns a list 2D arrays (matrices) A, B, C and D.

>>> getLinearInputs (mod) //returns a list of strings of names of inputs used when_
—forming matrices.

>>> getLinearOutputs (mod) //returns a list of strings of names of outputs used
—when forming matrices.

>>> getLinearStates (mod) // returns a list of strings of names of states used when_
—forming matrices.

21.12 Sensitivity Analysis

A Method for computing numeric sensitivity of modelica model is available .
* (resl,res2) = sensitivity(argl,arg2,arg3)
The constructor requires a minimum of 3 input arguments .
* argl: Array of strings of Modelica Parameter names
e arg2: Array of strings of Modelica Variable names
 arg3: Array of float Excitations of parameters; defaults to scalar le-2
The results contains the following .
¢ resl: Vector of Sensitivity names.

* res2: Array of sensitivies: vector of elements per parameter, each element containing time series per vari-
able.

21.13 Usage

’>>> (Sn, Sa) = sensitivity(mod, ["UA","EdR"], ["T","cA"],[le-2,1e-4])

With the above list of API calls implemented, the users can have more control over the result types, returned as
Julia data structures.
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CHAPTER
TWENTYTWO

JUPYTER-OPENMODELICA

An OpenModelica Kernel for Jupyter Notebook. All commands are interpreted by OMPython which communi-
cates with OpenModelica Compiler and the results are presented to user.

The project is available at https://github.com/OpenModelica/jupyter-openmodelica.

Follow the Readme file to install and start running modelica models directly in Jupyter Notebook
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CHAPTER
TWENTYTHREE

SCRIPTING API

The following are short summaries of OpenModelica scripting commands. These commands are useful for loading
and saving classes, reading and storing data, plotting of results, and various other tasks.

The arguments passed to a scripting function should follow syntactic and typing rules for Modelica and for the
scripting function in question. In the following tables we briefly indicate the types or character of the formal
parameters to the functions by the following notation:

* String typed argument, e.g. "hello", "myfile.mo".

» TypeName - class, package or function name, e.g. MyClass, Modelica.Math.
* VariableName — variable name, e.g. v1, v2, varsl [2] .x, etc.

* Integer or Real typed argument, e.g. 35, 3.14, xintvariable.

* options — optional parameters with named formal parameter passing.

23.1 OpenModelica Scripting Commands

The following are brief descriptions of the scripting commands available in the OpenModelica environment. All
commands are shown in alphabetical order:

23.1.1 interactiveDumpAbsynToJL

function interactiveDumpAbsynToJL
output String res;
end interactiveDumpAbsynToJL;

23.1.2 relocateFunctions

function relocateFunctions
input String fileName;
input String names[:, 2];
output Boolean success;
end relocateFunctions;

23.1.3 todulia

function toJulia
output String res;
end toJulia;
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23.1.4 GC_expand_hp

function GC_expand_ hp
input Integer size;
output Boolean success;
end GC_expand_hp;

23.1.5 GC_gcollect_and_unmap
23.1.6 GC_get_prof_stats

function GC_get_prof stats
output GC_PROFSTATS gcStats;
end GC_get_prof_ stats;

23.1.7 GC_set_max_heap_size

function GC_set_max heap_size
input Integer size;
output Boolean success;

end GC_set_max heap_size;

23.1.8 addClassAnnotation

function addClassAnnotation
input TypeName class_;
input ExpressionOrModification annotate;
output Boolean bool;

end addClassAnnotation;

23.1.9 addInitialState

function addInitialState
input TypeName cl;
input String state;
input ExpressionOrModification annotate;
output Boolean bool;
end addInitialState;

23.1.10 addTransition

function addTransition
input TypeName cl;
input String from;
input String to;
input String condition;
input Boolean immediate = true;
input Boolean reset = true;
input Boolean synchronize = false;
input Integer priority = 1;
input ExpressionOrModification annotate;
output Boolean bool;
end addTransition;
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23.1.11 alarm

impure function alarm

input Integer seconds;

output Integer previousSeconds;
end alarm;

23.1.12 appendEnvironmentVar

Appends a variable to the environment variables list.

function appendEnvironmentVar

input String var;

input String value;

output String result "returns \"error\" if the variable could not be appended";
end appendEnvironmentVar;

23.1.13 basename

function basename
input String path;
output String basename;
end basename;

23.1.14 buildEncryptedPackage

function buildEncryptedPackage
input TypeName className "the class that should encrypted";
input Boolean encrypt = true;
output Boolean success;

end buildEncryptedPackage;

23.1.15 buildLabel

builds Lable.

function buildLabel
input TypeName className "the class that should be built";

input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Integer numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le-6 "tolerance used by the integration method. <default>
—= le-6";

input String method = "dassl" "integration method used for simulation. <default>
—= dassl";

input String fileNamePrefix = "" "fileNamePrefix. <default> = \"\"";

input String options = "" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "" "cflags. <default> = \"\"";

(continues on next page)

23.1. OpenModelica Scripting Commands 215




OpenModelica User’s Guide, Release v1.14.1-2-g392¢27e260

(continued from previous page)

input String simflags = "" "simflags. <default> = \"\"";
output String[2] buildModelResults;
end buildLabel;

23.1.16 buildModel

builds a modelica model by generating c¢ code and build it.

It does not run the code!

The only required argument is the className, while all others have some default
—values.

simulate (className, [startTime], [stopTime], [numberOfIntervals], [tolerance],
— [method], [fileNamePrefix], [options], [outputFormat], [variableFilter],
—[cflags], [simflags])

Example command:

simulate (A);

function buildModel
input TypeName className "the class that should be built";

input Real startTime = "<default>" "the start time of the simulation. <default>_
—= 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le—-6 "tolerance used by the integration method. <default>
= le-6";

input String method = "<default>" "integration method used for simulation.
—~<default> = dassl";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output String[2] buildModelResults;
end buildModel;

23.1.17 buildModelFMU

translates a modelica model into a Functional Mockup Unit.

The only required argument is the className, while all others have some default
—values.

Example command:

buildModelFMU (className, version="2.0");

function buildModelFMU
input TypeName className "the class that should translated";

input String version = "2.0" "FMU version, 1.0 or 2.0.";

input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation),
—me_cs (both model exchange and co-simulation)";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \

—"className\"";

input String platforms[:] = {"static"} "The list of platforms to generate code_
—for. \"dynamic\"=current platform, dynamically link the runtime. \"static\
—"=current platform, statically link everything. Else, use a host triple, e.g. \
—"x86_64-1inux—gnu\" or \"x86_64-w64-mingw32\"";

(continues on next page)
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(continued from previous page)

input Boolean includeResources = false "include Modelica based resources via,,
—~loadResource or not";

output String generatedFileName "Returns the full path of the generated FMU.";
end buildModelFMU;

23.1.18 buildOpenTURNSInterface

generates wrapper code for OpenTURNS

function buildOpenTURNSInterface
input TypeName className;
input String pythonTemplateFile;
input Boolean showFlatModelica = false;
output String outPythonScript;
end buildOpenTURNSInterface;

23.1.19 cd

change directory to the given path (which may be either relative or absolute)
returns the new working directory on success or a message on failure

if the given path is the empty string, the function simply returns the current
—working directory.

function cd

input String newWorkingDirectory = "";
output String workingDirectory;
end cd;

23.1.20 checkAllModelsRecursive

Checks all models recursively and returns number of variables and equations.

function checkAllModelsRecursive
input TypeName className;
input Boolean checkProtected = false "Checks also protected classes if true";
output String result;

end checkAllModelsRecursive;

23.1.21 checkCodeGraph

Checks if the given taskgraph has the same structure as the graph described in the |
—codefile.

function checkCodeGraph
input String graphfile;
input String codefile;
output String[:] result;
end checkCodeGraph;
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23.1.22 checkinterfaceOfPackages

function checkInterfaceOfPackages
input TypeName cl;
input String dependencyMatrix[:, :];
output Boolean success;

end checkInterfaceOfPackages;

23.1.23 checkModel

Checks a model and returns number of variables and equations.

function checkModel
input TypeName className;
output String result;
end checkModel;

23.1.24 checkSettings

Display some diagnostics.

function checkSettings
output CheckSettingsResult result;
end checkSettings;

23.1.25 checkTaskGraph

Checks if the given taskgraph has the same structure as the reference taskgraph,_
—~and if all attributes are set correctly.

function checkTaskGraph
input String filename;
input String reffilename;
output String[:] result;
end checkTaskGraph;

23.1.26 classAnnotationExists

Check if annotation exists

function classAnnotationExists
input TypeName className;
input TypeName annotationName;
output Boolean exists;

end classAnnotationExists;

23.1.27 clear

Clears everything: symboltable and variables.
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function clear
output Boolean success;
end clear;

23.1.28 clearCommandLineOptions

Resets all command-line flags to their default values.

function clearCommandLineOptions
output Boolean success;
end clearCommandLineOptions;

23.1.29 clearDebugFlags

Resets all debug flags to their default values.

function clearDebugFlags
output Boolean success;
end clearDebugFlags;

23.1.30 clearMessages

Clears the error buffer.

function clearMessages
output Boolean success;
end clearMessages;

23.1.31 clearProgram

Clears loaded .

function clearProgram
output Boolean success;
end clearProgram;

23.1.32 clearVariables

Clear all user defined variables.

function clearVariables
output Boolean success;
end clearVariables;

23.1.33 closeSimulationResultFile

23.1. OpenModelica Scripting Commands
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Closes the current simulation result file.

Only needed by Windows. Windows cannot handle reading and writing to the same file

—from different processes.

To allow OMEdit to make successful simulation again on the same file we must close_

—the file after reading the Simulation Result Variables.
Even OMEdit only use this API for Windows.

function closeSimulationResultFile
output Boolean success;
end closeSimulationResultFile;

23.1.34 codeToString

function codeToString
input $Code className;
output String string;
end codeToString;

23.1.35 compareFiles

impure function compareFiles
input String filel;
input String file2;
output Boolean isEqual;
end compareFiles;

23.1.36 compareFilesAndMove

impure function compareFilesAndMove
input String newFile;
input String oldFile;
output Boolean success;

end compareFilesAndMove;

23.1.37 compareSimulationResults

compares simulation results.

function compareSimulationResults
input String filename;
input String reffilename;
input String logfilename;
input Real relTol = 0.01;
input Real absTol = 0.0001;
input String[:] vars = £ill("", 0);
output String[:] result;
end compareSimulationResults;

23.1.38 convertUnits
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function convertUnits
input String sl;
input String s2;
output Boolean unitsCompatible;
output Real scaleFactor;
output Real offset;
end convertUnits;

23.1.39 copy

copies the source file to the destination file. Returns true if the file has been
—copied.

function copy
input String source;
input String destination;
output Boolean success;
end copy;

23.1.40 copyClass

Copies a class within the same level

function copyClass
input TypeName className "the class that should be copied";
input String newClassName "the name for new class";
input TypeName withIn = $Code (TopLevel) "the with in path for new class";
output Boolean result;
end copyClass;

23.1.41 countMessages

function countMessages
output Integer numMessages;
output Integer numErrors;
output Integer numWarnings;
end countMessages;

23.1.42 deleteFile

Deletes a file with the given name.

function deleteFile
input String fileName;
output Boolean success;
end deleteFile;

23.1.43 deletelnitialState
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function deleteInitialState
input TypeName cl;
input String state;
output Boolean bool;

end deleteInitialState;

23.1.44 deleteTransition

function deleteTransition
input TypeName cl;
input String from;
input String to;
input String condition;
input Boolean immediate;
input Boolean reset;
input Boolean synchronize;
input Integer priority;
output Boolean bool;

end deleteTransition;

23.1.45 deltaSimulationResults

calculates the sum of absolute errors.

function deltaSimulationResults
input String filename;
input String reffilename;

input String method "method to compute then error. choose lnorm, 2norm, maxerr";

input String[:] vars = £ill("", 0);
output Real result;
end deltaSimulationResults;

23.1.46 diffModelicaFileListings

Creates diffs of two strings corresponding to Modelica files

function diffModelicaFilelListings
input String before, after;
input DiffFormat diffFormat = DiffFormat.color;
output String result;

end diffModelicaFileListings;

23.1.47 diffSimulationResults

compares simulation results.

function diffSimulationResults

input String actualFile;

input String expectedFile;

input String diffPrefix;

input Real relTol = le-3 "y tolerance";

input Real relTolDiffMinMax = le-4 "y tolerance based on
—the maximum and minimum of the signal";

the difference between_

(continues on next page)
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(continued from previous page)

input Real rangeDelta = 0.002 "x tolerance";
input String[:] vars = £ill("", 0);
input Boolean keepEqualResults = false;
output Boolean success;
output String[:] failVars;

end diffSimulationResults;

23.1.48 diffSimulationResultsHtml

function diffSimulationResultsHtml

input String var;

input String actualFile;

input String expectedFile;

input Real relTol = le-3 "y tolerance";

input Real relTolDiffMinMax = le-4 "y tolerance based on the difference between_
—the maximum and minimum of the signal";

input Real rangeDelta = 0.002 "x tolerance";

output String html;
end diffSimulationResultsHtml;

23.1.49 directoryExists

function directoryExists
input String dirName;
output Boolean exists;
end directoryExists;

23.1.50 dirname

function dirname
input String path;
output String dirname;
end dirname;

23.1.51 disableNewlnstantiation

function disableNewInstantiation
output Boolean success;
end disableNewInstantiation;

23.1.52 dumpXMLDAE

Outputs the DAE system corresponding to a specific model.

function dumpXMLDAE
input TypeName className;
input String translationlevel = "flat" "flat, optimiser, backEnd, or stateSpace";
input Boolean addOriginalIncidenceMatrix = false;
input Boolean addSolvingInfo = false;
input Boolean addMathMLCode = false;
input Boolean dumpResiduals = false;

(continues on next page)
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input String fileNamePrefix = "<default>" "this is the className in string form_
—by default";
input String rewriteRulesFile = "" "the file from where the rewiteRules are read,

— default is empty which means no rewrite rules";
output Boolean success "if the function succeeded true/false";
output String xmlfileName "the Xml file";

end dumpXMLDAE;

23.1.53 echo

echo (false) disables Interactive output, echo(true) enables it again.

function echo
input Boolean setEcho;
output Boolean newEcho;
end echo;

23.1.54 enableNewlnstantiation

function enableNewInstantiation
output Boolean success;
end enableNewInstantiation;

23.1.55 escapeXML

function escapeXML
input String inStr;
output String outStr;
end escapeXML;

23.1.56 exit

function exit
input Integer status;
end exit;

23.1.57 exportToFigaro

function exportToFigaro
input TypeName path;
input String directory = cd{();
input String database;
input String mode;
input String options;
input String processor;
output Boolean success;
end exportToFigaro;
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23.1.58 extendsFrom

returns true if the given class extends from the given base class

function extendsFrom
input TypeName className;
input TypeName baseClassName;
output Boolean res;

end extendsFrom;

23.1.59 filterSimulationResults

function filterSimulationResults
input String inFile;
input String outFile;
input String[:] vars;
input Integer numberOfIntervals = 0 "0=Do not resample";
input Boolean removeDescription = false;
output Boolean success;
end filterSimulationResults;

23.1.60 generateCode

The input is a function name for which C-code is generated and compiled into a dll/
—SO

function generateCode
input TypeName className;
output Boolean success;
end generateCode;

23.1.61 generateEntryPoint

function generateEntryPoint

input String fileName;

input TypeName entryPoint;

input String url = "https://trac.openmodelica.org/OpenModelica/newticket";
end generateEntryPoint;

23.1.62 generateHeader

function generateHeader
input String fileName;
output Boolean success;
end generateHeader;

23.1.63 generatedJuliaHeader

function generateJuliaHeader
input String fileName;
output Boolean success;
end generateJuliaHeader;
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23.1.64 generateScriptingAPI

function generateScriptingAPI
input TypeName cl;
input String name;
output Boolean success;
output String moFile;
output String gtFile;
output String gtHeader;

end generateScriptingAPI;

23.1.65 generateSeparateCode

function generateSeparateCode

input TypeName className;

input Boolean cleanCache = false "If true, the cache is reset between each,
—generated package. This conserves memory at the cost of speed.";

output Boolean success;
end generateSeparateCode;

23.1.66 generateSeparateCodeDependencies

function generateSeparateCodeDependencies
input String stampSuffix = ".c" "Suffix to add to dependencies (often .c.stamp)";
output String[:] dependencies;

end generateSeparateCodeDependencies;

23.1.67 generateSeparateCodeDependenciesMakefile

function generateSeparateCodeDependenciesMakefile
input String filename "The file to write the makefile to";
input String directory = "" "The relative path of the generated files";
input String suffix = ".c" "Often .stamp since we do not update all the files";
output Boolean success;
end generateSeparateCodeDependenciesMakefile;

23.1.68 generateVerificationScenarios

function generateVerificationScenarios
input TypeName path;
output Boolean success;

end generateVerificationScenarios;

23.1.69 getAlgorithmCount

Counts the number of Algorithm sections in a class.

function getAlgorithmCount
input TypeName class_;
output Integer count;
end getAlgorithmCount;
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23.1.70 getAlgorithmltemsCount

Counts the number of Algorithm items in a class.

function getAlgorithmItemsCount
input TypeName class_;
output Integer count;

end getAlgorithmItemsCount;

23.1.71 getAliSubtypeOf

Returns the list of all classes that extend from class_ given a parentClass where

—the lookup for class_ should start

function getAllSubtypeOf
input TypeName parentClass = $Code (AllLoadedClasses);
input TypeName class_;
input Boolean qualified = false;
input Boolean includePartial = false;
input Boolean sort = false;
output TypeName classNames[:];
end getAllSubtypeOf;

23.1.72 getAnnotationCount

Counts the number of Annotation sections in a class.

function getAnnotationCount
input TypeName class_;
output Integer count;

end getAnnotationCount;

23.1.73 getAnnotationModifierValue

function getAnnotationModifierValue
input TypeName name;
input String vendorannotation;
input String modifiername;
output String modifiernamevalue;
end getAnnotationModifierValue;

23.1.74 getAnnotationNamedModifiers

function getAnnotationNamedModifiers
input TypeName name;
input String vendorannotation;
output String[:] modifiernamelist;
end getAnnotationNamedModifiers;
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23.1.75 getAnnotationVersion

Returns the current annotation version.

function getAnnotationVersion
output String annotationVersion;
end getAnnotationVersion;

23.1.76 getAstAsCorbaString

Print the whole AST on the CORBA format for records, e.g.
record Absyn.PROGRAM

classes = ...,
within_ = ...,
globalBuildTimes =

end Absyn.PROGRAM;

function getAstAsCorbaString

input String fileName = "<interactive>";

output String result "returns the string if fileName is interactive; else it
—returns ok or error depending on if writing the file succeeded";
end getAstAsCorbaString;

23.1.77 getAvailableIndexReductionMethods

function getAvailableIndexReductionMethods
output String[:] allChoices;
output String[:] allComments;

end getAvailableIndexReductionMethods;

23.1.78 getAvailableLibraries

function getAvailablelibraries
output String[:] libraries;
end getAvailablelibraries;

23.1.79 getAvailableMatchingAlgorithms

function getAvailableMatchingAlgorithms
output String[:] allChoices;
output String[:] allComments;

end getAvailableMatchingAlgorithms;

23.1.80 getAvailableTearingMethods

function getAvailableTearingMethods
output String[:] allChoices;
output String[:] allComments;

end getAvailableTearingMethods;
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23.1.81 getBooleanClassAnnotation

Check if annotation exists and returns its wvalue

function getBooleanClassAnnotation
input TypeName className;
input TypeName annotationName;
output Boolean value;

end getBooleanClassAnnotation;

23.1.82 getBuiltinType

function getBuiltinType
input TypeName cl;
output String name;
end getBuiltinType;

23.1.83 getCFlags

CEFLAGS

function getCFlags
output String outString;
end getCFlags;

23.1.84 getCXXCompiler

CXX

function getCXXCompiler
output String compiler;
end getCXXCompiler;

23.1.85 getClassComment

Returns the class comment.

function getClassComment
input TypeName cl;
output String comment;
end getClassComment;

23.1.86 getClassinformation

function getClassInformation
input TypeName cl;
output String restriction, comment;
output Boolean partialPrefix, finalPrefix, encapsulatedPrefix;
output String fileName;
output Boolean fileReadOnly;

(continues on next page)
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(continued from previous page)

output Integer lineNumberStart, columnNumberStart, lineNumberEnd,
—columnNumberEnd;

output String dimensions([:];

output Boolean isProtectedClass;

output Boolean isDocumentationClass;

output String version;

output String preferredView;

output Boolean state;

output String access;
end getClassInformation;

23.1.87 getClassNames

Returns the list of class names defined in the class.

function getClassNames
input TypeName class_ = $Code (AllLoadedClasses);
input Boolean recursive = false;
input Boolean qualified = false;
input Boolean sort = false;
input Boolean builtin = false "List also builtin classes if true";
input Boolean showProtected = false "List also protected classes if true";
input Boolean includeConstants = false "List also constants in the class if true
="
output TypeName classNames|[:];
end getClassNames;

23.1.88 getClassRestriction

function getClassRestriction
input TypeName cl;
output String restriction;
end getClassRestriction;

23.1.89 getClassesinModelicaPath

MathCore-specific or not? Who knows!

function getClassesInModelicaPath
output String classesInModelicaPath;
end getClassesInModelicaPath;

23.1.90 getCommandLineOptions

Returns all command line options who have non-default values as a list of
strings. The format of the strings is '--flag=value --flag2=value2'.

function getCommandLineOptions
output String[:] flags;
end getCommandLineOptions;
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23.1.91 getCompileCommand

function getCompileCommand
output String compileCommand;
end getCompileCommand;

23.1.92 getCompiler

CcC

function getCompiler
output String compiler;
end getCompiler;

23.1.93 getComponentModifierNames

function getComponentModifierNames
input TypeName class_;
input String componentName;
output String[:] modifiers;

end getComponentModifierNames;

23.1.94 getComponentModifierValue

function getComponentModifierValue
input TypeName class_;
input TypeName modifier;
output String value;

end getComponentModifierValue;

23.1.95 getComponentModifierValues

function getComponentModifierValues
input TypeName class_;
input TypeName modifier;
output String value;

end getComponentModifierValues;

23.1.96 getComponentsTest

function getComponentsTest
input TypeName name;
output Component[:] components;
record Component
String className;
// when building record the constructor. Records are allowed to contain only,
—components of basic types, arrays of basic types or other records.
String name;
String comment;
Boolean isProtected;
Boolean isFinal;
Boolean isFlow;

(continues on next page)
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(continued from previous page)

Boolean isStream;
Boolean isReplaceable;

String variability "'constant', 'parameter', 'discrete', ''";
String innerOuter "'inner', 'outer', ''";

String inputOutput "'input', 'output', ''";

String dimensions|[:];

end Component;
end getComponentsTest;

23.1.97 getConfigFlagValidOptions

Returns the list of valid options for a string config flag, and the description_
—strings for these options if available

function getConfigFlagValidOptions
input String flag;
output String validOptions([:];
output String mainDescription;
output String descriptions([:];
end getConfigFlagValidOptions;

23.1.98 getConnectionCount

Counts the number of connect equation in a class.

function getConnectionCount
input TypeName className;
output Integer count;

end getConnectionCount;

23.1.99 getDefaultOpenCLDevice

Returns the id for the default OpenCL device to be used.

function getDefaultOpenCLDevice
output Integer defdevid;
end getDefaultOpenCLDevice;

23.1.100 getDerivedClassModifierNames

Returns the derived class modifier names.

Example command:

type Resistance = Real (final quantity="Resistance",final unit="Ohn");
getDerivedClassModifierNames (Resistance) => {"quantity","unit"}

function getDerivedClassModifierNames
input TypeName className;
output String[:] modifierNames;

end getDerivedClassModifierNames;
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23.1.101 getDerivedClassModifierValue

Returns the derived class modifier value.

Example command:

type Resistance = Real (final quantity="Resistance",final unit="Ohm");
getDerivedClassModifierValue (Resistance, unit); => " = "Ohm""
getDerivedClassModifierValue (Resistance, quantity); => " = "Resistance""

function getDerivedClassModifierValue
input TypeName className;
input TypeName modifierName;
output String modifierValue;

end getDerivedClassModifierValue;

23.1.102 getDerivedUnits

function getDerivedUnits

input String baseUnit;

output String[:] derivedUnits;
end getDerivedUnits;

23.1.103 getDocumentationAnnotation

Returns the documentaiton annotation defined in the class.

function getDocumentationAnnotation

input TypeName cl;

output String out[3] "{info,revision,infoHeader} TODO: Should be changed to have_
—2 outputs instead of an array of 2 Strings...";
end getDocumentationAnnotation;

23.1.104 getEnvironmentVar

Returns the value of the environment variable.

function getEnvironmentVar

input String var;

output String value "returns empty string on failure";
end getEnvironmentVar;

23.1.105 getEquationCount

Counts the number of Equation sections in a class.

function getEquationCount
input TypeName class_;
output Integer count;
end getEquationCount;
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23.1.106 getEquationltemsCount

Counts the number of Equation items in a class.

function getEquationItemsCount
input TypeName class_;
output Integer count;

end getEquationItemsCount;

23.1.107 getErrorString

Returns the current error message. [file.mo:n:n-n:n:b] Error: message

impure function getErrorString
input Boolean warningsAsErrors = false;
output String errorString;

end getErrorString;

23.1.108 getimportCount

Counts the number of Import sections in a class.

function getImportCount
input TypeName class_;
output Integer count;
end getImportCount;

23.1.109 getindexReductionMethod

function getIndexReductionMethod
output String selected;
end getIndexReductionMethod;

23.1.110 getinheritedClasses

function getInheritedClasses

input TypeName name;

output TypeName inheritedClasses|[:];
end getInheritedClasses;

23.1.111 getinitialAlgorithmCount

Counts the number of Initial Algorithm sections in a class.

function getInitialAlgorithmCount
input TypeName class_;
output Integer count;

end getInitialAlgorithmCount;
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23.1.112 getlinitialAlgorithmltemsCount

Counts the number of Initial Algorithm items in a class.

function getInitialAlgorithmItemsCount
input TypeName class_;
output Integer count;

end getInitialAlgorithmItemsCount;

23.1.113 getinitialEquationCount

Counts the number of Initial Equation sections in a class.

function getInitialEquationCount
input TypeName class_;
output Integer count;

end getInitialEquationCount;

23.1.114 getinitialEquationltemsCount

Counts the number of Initial Equation items in a class.

function getInitialEquationItemsCount
input TypeName class_;
output Integer count;

end getInitialEquationItemsCount;

23.1.115 getlinitialStates

function getInitialStates

input TypeName cl;

output String[:, :] initialStates;
end getInitialStates;

23.1.116 getlinstallationDirectoryPath

This returns OPENMODELICAHOME if it is set; on some platforms the default path is_
—returned if it is not set.

function getInstallationDirectoryPath
output String installationDirectoryPath;
end getInstallationDirectoryPath;

23.1.117 getinstantiatedParametersAndValues

function getInstantiatedParametersAndValues
input TypeName cls;
output String[:] values;

end getInstantiatedParametersAndValues;
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23.1.118 getLanguageStandard

Returns the current Modelica Language Standard in use.

function getLanguageStandard
output String outVersion;
end getLanguageStandard;

23.1.119 getLinker

function getLinker
output String linker;
end getLinker;

23.1.120 getLinkerFlags

function getLinkerFlags
output String linkerFlags;
end getLinkerFlags;

23.1.121 getLoadedLibraries

function getLoadedLibraries
output String[:, 2] libraries;
end getLoadedLibraries;

23.1.122 getMatchingAlgorithm

function getMatchingAlgorithm
output String selected;
end getMatchingAlgorithm;

23.1.123 getMemorySize

function getMemorySize
output Real memory (unit = "MiB");
end getMemorySize;

23.1.124 getMessagesString

see getErrorString/()

function getMessagesString
output String messagesString;
end getMessagesString;
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23.1.125 getModelicaPath

Get the Modelica Library Path.

function getModelicaPath
output String modelicaPath;
end getModelicaPath;

23.1.126 getNoSimplify

Returns true if noSimplify flag is set.

function getNoSimplify
output Boolean noSimplify;
end getNoSimplify;

23.1.127 getNthAlgorithm

Returns the Nth Algorithm section.

function getNthAlgorithm
input TypeName class_;
input Integer index;
output String result;
end getNthAlgorithm;

23.1.128 getNthAlgorithmitem

Returns the Nth Algorithm Item.

function getNthAlgorithmItem
input TypeName class_;
input Integer index;
output String result;

end getNthAlgorithmItem;

23.1.129 getNthAnnotationString

Returns the Nth Annotation section as string.

function getNthAnnotationString
input TypeName class_;
input Integer index;
output String result;

end getNthAnnotationString;

23.1.130 getNthConnection

Returns the Nth connection.
Example command:
getNthConnection (A) => {"from", "to", "comment"}
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function getNthConnection
input TypeName className;
input Integer index;
output String[:] result;
end getNthConnection;

23.1.131 getNthEquation

Returns the Nth Equation section.

function getNthEquation
input TypeName class_;
input Integer index;
output String result;
end getNthEquation;

23.1.132 getNthEquationitem

Returns the Nth Equation Item.

function getNthEquationItem
input TypeName class_;
input Integer index;
output String result;

end getNthEquationItem;

23.1.133 getNthimport

Returns the Nth Import as string.

function getNthImport

input TypeName class_;

input Integer index;

output String out[3] "{\"Path\",\"Id\",\"Kind\"}";
end getNthImport;

23.1.134 getNthlinitialAlgorithm

Returns the Nth Initial Algorithm section.

function getNthInitialAlgorithm
input TypeName class_;
input Integer index;
output String result;

end getNthInitialAlgorithm;

23.1.135 getNthlinitialAlgorithmltem

Returns the Nth Initial Algorithm Item.
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function getNthInitialAlgorithmItem
input TypeName class_;
input Integer index;
output String result;

end getNthInitialAlgorithmItem;

23.1.136 getNthinitialEquation

Returns the Nth Initial Equation section.

function getNthInitialEquation
input TypeName class_;
input Integer index;
output String result;

end getNthInitialEquation;

23.1.137 getNthinitialEquationitem

Returns the Nth Initial Equation Item.

function getNthInitialEquationItem
input TypeName class_;
input Integer index;
output String result;

end getNthInitialEquationItem;

23.1.138 getOrderConnections

Returns true if orderConnections flag is set.

function getOrderConnections
output Boolean orderConnections;
end getOrderConnections;

23.1.139 getPackages

Returns the list of packages defined in the class.

function getPackages
input TypeName class_ = $Code(AllLoadedClasses);
output TypeName classNames|[:];

end getPackages;

23.1.140 getParameterNames

function getParameterNames
input TypeName class_;
output String[:] parameters;
end getParameterNames;
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23.1.141 getParameterValue

function getParameterValue
input TypeName class_;
input String parameterName;
output String parameterValue;
end getParameterValue;

23.1.142 getSettings

function getSettings
output String settings;
end getSettings;

23.1.143 getShowAnnotations

function getShowAnnotations
output Boolean show;
end getShowAnnotations;

23.1.144 getSimulationOptions

function getSimulationOptions

input TypeName name;

input Real defaultStartTime = 0.0;

input Real defaultStopTime = 1.0;

input Real defaultTolerance = le-6;

input Integer defaultNumberOfIntervals = 500 "May be overridden by defining
—defaultInterval instead";

input Real defaultInterval = 0.0 "If = 0.0, then numberOflIntervals is used to
—calculate the step size";

output Real startTime;

output Real stopTime;

output Real tolerance;

output Integer numberOfIntervals;

output Real interval;
end getSimulationOptions;

23.1.145 getSourceFile

Returns the filename of the class.

function getSourceFile

input TypeName class_;

output String filename "empty on failure";
end getSourceFile;

23.1.146 getTearingMethod

function getTearingMethod
output String selected;
end getTearingMethod;
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23.1.147 getTempDirectoryPath

Returns the current user temporary directory location.

function getTempDirectoryPath
output String tempDirectoryPath;
end getTempDirectoryPath;

23.1.148 getTimeStamp

function getTimeStamp

input TypeName cl;

output Real timeStamp;

output String timeStampAsString;
end getTimeStamp;

23.1.149 getTransitions

function getTransitions

input TypeName cl;

output String[:, :] transitions;
end getTransitions;

23.1.150 getUsedClassNames

Returns the list of class names used in the total program defined by the class.

function getUsedClassNames
input TypeName className;
output TypeName classNames][:];
end getUsedClassNames;

23.1.151 getUses

function getUses
input TypeName pack;
output String[:, :] uses;
end getUses;

23.1.152 getVectorizationLimit

function getVectorizationLimit
output Integer vectorizationLimit;
end getVectorizationLimit;

23.1.153 getVersion

Returns the version of the Modelica compiler.
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function getVersion
input TypeName cl = $Code (OpenModelica);
output String version;

end getVersion;

23.1.154 help

display the OpenModelica help text.

function help

input String topic = "topics";
output String helpText;
end help;

23.1.155 iconv

The iconv () function converts one multibyte characters from one character
set to another.
See man (3) iconv for more information.

function iconv
input String string;
input String from;
input String to = "UTF-8";
output String result;
end iconv;

23.1.156 importFMU

Imports the Functional Mockup Unit
Example command:
importFMU ("A.fmu");

function importFMU

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned,
—otherwise only the file name.";

input Boolean debuglogging = false "When true the FMU's debug output is printed.
— 7

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output,
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMU;

23.1.157 importFMUModelDescription
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Imports modelDescription.xml
Example command:
importFMUModelDescription ("A.xml");

function importFMUModelDescription

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3; loglevel_info=4;loglevel_verbose=5; loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned,
—otherwise only the file name.";

input Boolean debuglogging = false "When true the FMU's debug output is printed.
=g

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output,
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMUModelDescription;

23.1.158 inferBindings

function inferBindings
input TypeName path;
output Boolean success;
end inferBindings;

23.1.159 instantiateModel

Instantiates the class and returns the flat Modelica code.

function instantiateModel
input TypeName className;
output String result;
end instantiateModel;

23.1.160 isBlock

function isBlock
input TypeName cl;
output Boolean b;
end isBlock;

23.1.161 isClass

function isClass
input TypeName cl;
output Boolean b;
end isClass;
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23.1.162 isConnector

function isConnector
input TypeName cl;
output Boolean bj;
end isConnector;

23.1.163 isEnumeration

function isEnumeration
input TypeName cl;
output Boolean bj;
end isEnumeration;

23.1.164 isExperiment

function isExperiment
input TypeName name;
output Boolean res;
end isExperiment;

23.1.165 isFunction

function isFunction
input TypeName cl;
output Boolean bj;
end isFunction;

23.1.166 isModel

function isModel
input TypeName cl;
output Boolean bj;
end isModel;

23.1.167 isOperator

function isOperator
input TypeName cl;
output Boolean bj;
end isOperator;

23.1.168 isOperatorFunction

function isOperatorFunction
input TypeName cl;
output Boolean b;

end isOperatorFunction;
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23.1.169 isOperatorRecord

function isOperatorRecord
input TypeName cl;
output Boolean bj;

end isOperatorRecord;

23.1.170 isOptimization

function isOptimization
input TypeName cl;
output Boolean b;

end isOptimization;

23.1.171 isPackage

function isPackage
input TypeName cl;
output Boolean b;
end isPackage;

23.1.172 isPartial

function isPartial
input TypeName cl;
output Boolean b;
end isPartial;

23.1.173 isProtectedClass

function isProtectedClass
input TypeName cl;
input String c2;
output Boolean b;

end isProtectedClass;

23.1.174 isRecord

function isRecord
input TypeName cl;
output Boolean b;
end isRecord;

23.1.175 isShortDefinition

returns true if the definition is a short class definition

function isShortDefinition
input TypeName class_;
output Boolean isShortCls;
end isShortDefinition;
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23.1.176 isType

function isType
input TypeName cl;
output Boolean bj;
end isType;

23.1.177 linearize

creates a model with symbolic linearization matrixes

function linearize
input TypeName className "the class that should simulated";

input Real startTime = "<default>" "the start time of the simulation. <default>_
—= 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.

—~<default> = 500";
input Real stepSize = 0.002 "step size that is used for the result file.
—<default> = 0.002";

input Real tolerance = le-6 "tolerance used by the integration method. <default>_
—= le-06";

input String method = "<default>" "integration method used for simulation.
—~<default> = dassl";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input Boolean storeInTemp = false "storeInTemp. <default> = false";

input Boolean noClean = false "noClean. <default> = false";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output String linearizationResult;
end linearize;

23.1.178 list

Lists the contents of the given class, or all loaded classes.

function list
input TypeName class_ = $Code (AllLoadedClasses) ;
input Boolean interfaceOnly = false;
input Boolean shortOnly = false "only short class definitions";
input ExportKind exportKind = ExportKind.Absyn;
output String contents;
end list;

23.1.179 listFile

Lists the contents of the file given by the class.
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function listFile
input TypeName class_;
input Boolean nestedClasses = true;
output String contents;

end listFile;

23.1.180 listVariables

Lists the names of the active variables in the scripting environment.

function listVariables
output TypeName variables([:];
end listVariables;

23.1.181 loadEncryptedPackage

function loadEncryptedPackage

input String fileName;

input String workdir = "<default>" "The output directory for imported encrypted,
—files. <default> will put the files to current working directory.";

output Boolean success;
end loadEncryptedPackage;

23.1.182 loadFile

load file (*.mo) and merge it with the loaded AST.

function loadFile
input String fileName;
input String encoding = "UTF-8";
input Boolean uses = true;
output Boolean success;

end loadFile;

23.1.183 loadFilelnteractive

function loadFileInteractive
input String filename;
input String encoding = "UTE-8";
output TypeName names|[:];

end loadFileInteractive;

23.1.184 loadFilelnteractiveQualified

function loadFilelInteractiveQualified
input String filename;
input String encoding = "UTEF-8";
output TypeName names|[:];

end loadFilelInteractiveQualified;
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23.1.185 loadFiles

load files (*.mo) and merges them with the loaded AST.

function loadFiles

input String[:] fileNames;
input String encoding = "UTE-8";
input Integer numThreads = OpenModelica.Scripting.numProcessors();

output Boolean success;
end loadFiles;

23.1.186 loadModel

Loads the Modelica Standard Library.

function loadModel

input TypeName className;

input String[:] priorityVersion = {"default"};

input Boolean notify = false "Give a notification of the libraries and versions,_
—that were loaded";

input String languageStandard = "" "Override the set language standard. Parse_
—with the given setting, but do not change it permanently.";

input Boolean requireExactVersion = false "If the version is required to be
—exact, 1f there is a uses Modelica (version=\"3.2\"), Modelica 3.2.1 will not,
—match it.";

output Boolean success;
end loadModel;

23.1.187 loadModelica3D

function loadModelica3D
input String version = "3.2.1";
output Boolean status;

end loadModelica3D;

23.1.188 loadOMSimulator

loads the OMSimulator DLL from default path

function loadOMSimulator
output Integer status;
end loadOMSimulator;

23.1.189 loadString

Parses the data and merges the resulting AST with ithe

loaded AST.

If a filename is given, it is used to provide error-messages as if the string

was read in binary format from a file with the same name.

The file is converted to UTF-8 from the given character set.

When merge is true the classes cNew in the file will be merged with the already,,
—~loaded classes cOld in the following way:

1. get all the inner class definitions from cOld that were loaded from a different
—~file than itself

(continues on next page)
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(continued from previous page)

2. append all elements from step 1 to class cNew public list
NOTE: Encoding 1is deprecated as *ALL* strings are now UTF-8 encoded.

function loadString
input String data;

input String filename = "<interactive>";
input String encoding = "UTE-8";
input Boolean merge = false "if merge is true the parsed AST is merged with the_

—existing AST, default to false which means that is replaced, not merged";
output Boolean success;
end loadString;

23.1.190 mkdir

create directory of given path (which may be either relative or absolute)
returns true if directory was created or already exists.

function mkdir
input String newDirectory;
output Boolean success;
end mkdir;

23.1.191 moveClass

Moves a class up or down depending on the given offset, where a positive
offset moves the class down and a negative offset up. The offset is truncated
if the resulting index is outside the class list. It retains the visibility of
the class by adding public/protected sections when needed, and merges sections
of the same type if the class is moved from a section it was alone in. Returns
true if the move was successful, otherwise false.

function moveClass
input TypeName className "the class that should be moved";
input Integer offset "Offset in the class list.";
output Boolean result;

end moveClass;

23.1.192 moveClassToBottom

Moves a class to the bottom of its enclosing class. Returns true if the move
was successful, otherwise false.

function moveClassToBottom
input TypeName className;
output Boolean result;
end moveClassToBottom;

23.1.193 moveClassToTop

Moves a class to the top of its enclosing class. Returns true if the move
was successful, otherwise false.
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function moveClassToTop
input TypeName className;
output Boolean result;
end moveClassToTop;

23.1.